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Introduction 
Welcome to the RealFlight Generation 4 R/C Flight Simulator 
(also known as RealFlight G4, or simply G4). 

ealFlight G4 is, without question, the most advanced R/C aircraft simulation 
available.  RealFlight G4 is so technologically advanced and so realistic, you’ll 
find it hard to believe that it’s only a simulation.  The culmination of many 
years of development and design, G4 offers advancements that will serve to 

fine-tune the flying skills of even the most seasoned R/C veteran.  If you’re an entry-
level R/C-er, RealFlight G4 is the ideal way to learn to fly, practice maneuvers, feel the 
effects of design modifications, or just have an incredible amount of fun. 

RealFlight G4 includes over 80 models that look and fly like the real thing, plus a 
multitude of flying sites—each with their own unique ‘feel’ and distinctive 
characteristics.  In addition, G4 offers its users the most powerful and flexible aircraft 
and flying site editors ever unveiled to the modeling community, allowing modelers to 
experiment with a virtually unlimited number of parameters.  G4 enables you to 
change the look and feel of a flying site with nothing more than a few keystrokes, the 
click of the mouse and a little imagination.  The integrated AccuModel™ aircraft editor 
makes modifying aircraft just as easy. 

RealFlight G4 also offers a wide array of tools to help you understand how to use the 
program and how to improve your R/C piloting skills.  This extensive manual file 
explains every feature and option as well as how to use them.  Our Virtual Flight 
Instruction feature, Heli Hover Trainer, Airplane Hover Trainer, Takeoff and Landing 
Trainer and Heli Orientation Trainer provide on-the-fly learning opportunities, and our 
trained and dedicated Product Support staff is ready to provide help when you need it.  
No other R/C simulator goes further to enrich your R/C experience. 

The following section briefly outlines some of the exciting features in RealFlight G4.  
We strongly suggest that you peruse this manual in its entirety before running the 
software.  Subsequent chapters will describe all RealFlight features in complete detail. 
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Finally, we’d like to express our gratitude to you for purchasing RealFlight G4.  We 
think you will be enormously pleased with G4.  Have fun flying! 

RealFlight G4 Feature Highlights 
This section briefly outlines some of the new features included in RealFlight G4 with 
the USB InterLink Elite Controller.  RealFlight G4 and the multi-patented InterLink 
Elite Controller incorporate a significant number of enhancements and improvements 
over previous RealFlight systems. 

USB InterLink Elite Controller 
The InterLink Elite Controller by Futaba is a revolutionary device that offers you: 

• A high quality USB compatible plug and play controller for RealFlight G4. 

• A built-in interface for (optionally) using your own R/C transmitter to control 
RealFlight G4. 

• QuickSelect™ Buttons—take control of RealFlight’s menus and options from 
the InterLink Elite without touching the keyboard or mouse. 

• The InterLink Elite Controller is fully hot swappable—you can connect and 
disconnect the InterLink or your own transmitter without rebooting your 
computer (or even shutting down RealFlight). 

• High-speed response to control inputs. 

• Digitally precise inputs with digital trims for unmatched control precision. 

• MultiMode™ split screen capability allows you to use the InterLink Elite as a 
controller and an interface simultaneously. 

• A keyboard-free push button reset of the simulation. 

• Hand-launch gliders and other aircraft that do not incorporate landing gear. 
 

Menu-Driven Interface 
RealFlight G4 utilizes a drop-down menu-driven interface system.  Created for ease of 
use and maximum flexibility, the menu system provides an interface familiar to even a 
casual computer user. 

Additional Features 

• RealPhysics 3D™ - One of the most ambitious models of flight in the world, 
RealPhysics 3D is untouched in its ability to re-create the lifelike characteristics 
of model flying.  RealFlight G4’s physics engine has been tried and approved 
by world-class competition pilots like Todd Bennett, John Glezellis, Pete 
Niotis, Frank Noll, and Jason Shulman.  Furthermore, aircraft in G4 behave 
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with real-world predictability because they are carefully modeled using 
advanced methods and extensive real-world data.  If it happens at the field or 
in the air, it’s re-created with exacting detail in G4! 

• Float Fly- RealFlight G4 offers a number of flying sites with water along with 
a variety of float fly aircraft.  Practice your takeoffs and landings on water and 
admire the view at the same time. 

• InterLink Elite QuickSelect-With RealFlight G4’s InterLink Elite, you’re 
able to make quick changes such as selecting a different aircraft or airport 
without touching the keyboard or mouse.  

• Variable Pitch Prop-Take 3D flight to 4D with the variable pitch prop.  
Select the popular FlatOuts™ Extra 300S with V-Pitch and try amazing 
maneuvers you didn’t think were possible with an airplane—like flying 
backwards. 

• Hovering Training Aids- Learn to torque roll or hover a heli with 
RealFlight’s Heli and Airplane Hover Trainer.  For more excitement, try the 
Heli Orientation Trainer.  Both are great training aids for anyone new to radio 
control. 

• Takeoff and Landing Training Aids-The RealFlight G4 simulator is a great 
way for new pilots to learn the art of R/C flying.  And the best places to start 
are training aids designed to teach you the basics of Takeoffs and Landings. 

• Night Flying- Just because the sun is down doesn’t mean that you can’t fly.  
The same is true with RealFlight night flying.  Pick a nighttime airport and 
watch as your aircraft lights up the sky. 

• PhotoFields™- G4 also includes ultra-realistic PhotoField airports.  Using 
incredible high resolution digital images, RealFlight PhotoField airports are as 
real as it gets.  And the Import feature allows you to use your own panoramic 
photos to create new flying sites. 

• “Full Coverage” collision detection- Instead of using sensors at only a few 
points, “Full Coverage” blankets the entire aircraft with points ensuring that 
every part of an aircraft will not only register a strike but will react 
authentically.  Contact can result in damage ranging from minor handling 
problems to spectacular crashes complete with realistic sound effects. 

• TruFlo Wind Dynamics™- RealFlight G4 introduces modelers to R/C’s 
most realistic wind model.  The five components of TruFlo Wind Dynamics 
work together to create the single most accurate wind field in any simulation.  
Wind impacts every facet of your flight, just as it would at the local field. 

• AccuModel™ Aircraft Editor- G4’s new aircraft editor is the most powerful 
and most flexible editor ever introduced in an R/C simulator.  AccuModel 
allows you to change virtually every aspect of your model with ease—it places 
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over 1,500 airfoils at your disposal, a multitude of propellers, and much, much 
more!  AccuModel brings up a wire-frame model for easy reference and 
highlights the editing area.  Make a change and it’s immediately reflected on-
screen, ready for review and revision. 

• Sierra Nevada’s Flying Sites and over 5,000 square miles to explore- 
RealFlight’s TrueLife Terrain™ goes beyond the limitations of traditional 
simulator flight.  Created and mapped from satellite imagery, G4’s landscape 
looks as “right” and richly varied as the view from your front door.  Digital 
elevation data brings it all into accurate perspective. 

• A living, breathing environment- Everything in G4’s 3D world is as realistic 
as possible, complete with depth and details that transcend the traditional 
“billboard” look of other simulators.  You’ll see leaves and branches that dance 
in a passing breeze and clouds that roll by with the prevailing winds. 

• FlexiField™ flying site editor- Takes you beyond 2D scenes into a 3D 
environment rich in new objects and editing options.  Customize an existing 
field with new foliage, different objects or both -- or create a new field with 
nothing more than a mouse, imagination and a few simple keystrokes. 

• InterLink™ Elite Controller- G4’s InterLink Elite controller functions as a 
controller, as an interface, or both.  Its push-button is capable of resetting the 
aircraft or hand-launching a sailplane. 

• Fly Split Screen- G4’s MultiMode™ option allows two modelers to fly 
simultaneously on one PC.  It’s perfect for practicing formation flight, a game 
of tag or personalized flight instruction. 

• Uses VirtualRevolution™ sound technology-- Doppler-correct stereo sounds 
heighten the realistic effect with true sound recordings of 2-stroke, 4-stroke, 
turbine, electric, ducted fan and gasoline engines.  As the aircraft crosses the 
field, the engine sound follows, just like its R/C counterpart.   

• RotoSonics™ technology-- recreating distinctive engine/blade sounds with 
startling accuracy.  Sounds so lifelike, you’ll swear you are at the field! 

• VFI (Virtual Flight Instruction) -- VFI gives you personal flight lessons 
from R/C’s leading experts.  Using VFI, you can select a maneuver (loop, roll, 
etc.) from an extensive list of options.  VFI then demonstrates the maneuver 
on-screen, performed by an expert.  While you watch, the voice of the 
pilot/instructor will explain how to perform the maneuver. 

• AFR (Advanced Flight Recorder) -- This feature allows the pilot to not only 
view prerecorded maneuvers, but also to record maneuvers of his/her own as 
well.  G4 even allows you to record your own audio for personalized flight 
instruction.  Much like a VCR, this feature also allows you to  pause, speed up, 
slow down, and loop the performance.  You can also play multiple recordings 
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at the same time.  The pilot has the option to activate the digitized transmitter 
display so that he/she can view the radio input while flying. 

• NavGuides™- Using the NavGuides, you can display a variety of heads-up 
on-screen informational displays.  Options range from altitude and airspeed to 
aircraft heading and engine RPM.  This feature improves your ability to “see” 
what is going on in your virtual world. 

• Viewport- You can open up a picture-in-picture display and treat it as an 
independent “window on the world”. You can individually adjust each the 
viewport’s vantage point, zoom level, and direction of view. 

• Multiplayer-You can fly with up to seven additional RealFlight G4 owners in 
competitions, or just for the thrill of flying with one another.  This feature can 
also be used to learn new maneuvers from pilots across the street or around 
the world. 

• Events- Compete solo, or fly with up to seven additional RealFlight G4 
owners in a variety of Events such as:  Limbo, Spot Landing, Free Style, Auto 
rotation and Pylon Racing. 

• Launcher- RealFlight G4’s Launcher allows for easy one-click access to 
program upgrades, online registration, and technical support. 

• Animated control surfaces and retracts—Control surfaces, retracts, 
propellers, and rotor blades move for added realism. 

• Aircraft exhaust/smoke-You can control the color, density, ‘hang time’, and 
other parameters related to airplane and helicopter smoke and exhaust. 

• Streamers- Add streamers to any aircraft, to any location, in any color.  Watch 
as they corkscrew behind the airplane during a roll, or react to the wind and 
the propwash. 

• Flight Failures- RealFlight can simulate many common flight failures (radio 
interference, stuck servos, engine failures, etc.).  Use this feature to prepare for 
emergencies at the field. 

• Fully editable aircraft paint/decal schemes- Create customize trim 
schemes for your aircraft.  (To design your own paint scheme, you must use a 
third-party program that edits TGA files.) 

• Extensive Help materials- RealFlight G4 features extensive online tool tips 
and diagrams, a detailed manual and technical support to enhance your 
enjoyment of the program. 
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How to read this manual
RealFlight G4 is a menu driven simulator which allows you to make quick changes 
without having to reload the simulator each time.  This manual will break out each 
main menu to its own chapter.  This allows you to quickly find information on features 
and functions by the related menus. 

Along with this manual, a large RealFlight community is available online to help and 
discuss with each RealFlight fan.  This online support, in the form of a forum, can be 
found at: 

http://www.knifeedge.com/forums/ 
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Before You Begin 
 
To get the most out of  RealFlight G4, it helps to understand how to get the most 
out of  your computer first. 

ealFlight Generation 4 is designed to work on a large variety of computer 
hardware.  Similar to a car, if you want to go faster, you need a bigger engine.  
The same holds true with RealFlight. You’ll be able to enjoy the simulator on 
most modern computers, but having the most up to date hardware for your 

computer will greatly increase your enjoyment. 

 

System Requirements 
 
You will find the suggested system requirements for the RealFlight G4 R/C Flight 
Simulator listed below.  The minimum system requirements below are the bare 
minimum PC configuration for installing RealFlight G4.  Meeting the minimum 
requirements will allow you to enjoy G4.  However, in order to take complete 
advantage of the many features and functions offered by G4, you should have a 
computer at, or near, the specifications as specified in the optimum system 
requirements. 

Minimum Recommended System- 
- Some graphical features may be disabled 

- Aerodynamic Calculations will still be high-quality 

Windows* 98SE, ME, 2000, XP or Vista™ 

Intel Pentium 1.0GHz or equivalent 

512 MB RAM 

Chapter 
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3 GB Hard Drive Space 

3D Accelerated Video with: 

- 32 MB Dedicated Video Memory 

- Full DirectX 9 compliant (Pixel Shader 1.4 support) 

 
 
Optimal System 
- For best graphical performance 

Dual Core 2.4GHz CPU 

2 GB RAM 

3D Accelerated Video with: 

- 256 MB dedicated video memory 

- Pixel Shader 2.0 support 

 
Multiplayer Requirements 

• 56.6 Kbps (or faster) modem or LAN connection 
 
 

Video and Sound Cards 
 
In order to achieve optimum performance and the best flying experience in RealFlight, 
there are two important components of your computer that deserve special attention:  
the video and sound cards. 

RealFlight G4 has undergone countless hours of compatibility testing and evaluation.  
As such, this software will adequately function with a variety of video cards—ranging 
from yesterday’s favorites to tomorrow’s hits. 

While RealFlight works well on a wide variety of hardware configurations, it offers 
many features and functions that are designed to take particular advantage of the latest 
video technology.  If you have an older computer, or a newer computer with a lower-
end video card, you may want to consider purchasing a new video card to take 
advantage of these features and functions.  This moderately priced upgrade can vastly 
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enhance your enjoyment of RealFlight.  Aside from increasing your satisfaction with 
G4, a new video card will also work with many other games or simulators, improving 
their performance as well. 

For a list of the video cards that have been tested by our staff, please visit: 

http://www.gpsoftware.com/ 

While not as important as the video card, upgrading your sound card may also improve 
your satisfaction with RealFlight.  This is especially true if your computer uses an on-
board sound card (a sound card affixed to the motherboard). 

 

Getting the Most out of RealFlight 
 
We think you’ll agree that RealFlight offers the finest set of instructions and practice 
tools of any R/C simulator suited for both beginners and experienced pilots.  Great 
Planes and Knife Edge Software are committed to the continual improvement of our 
products.  When using the software, you should keep two things in mind. 

First, similar to other pursuits, what you get out of RealFlight depends upon what you 
put in.  Mastering radio control requires a great deal of patience and practice.  If you 
crash an aircraft in the simulation, take it very seriously.  Crashing an actual R/C 
aircraft can cost you a lot of time and money.  Try to examine what you did incorrectly, 
using the experience to avoid making the same mistake again. 

Secondly, while the simulator is quite realistic and will assist you in learning many of the 
skills necessary to become a proficient pilot, there is no substitute for actual flying time 
at the field.  A simulation can be a wonderful practice tool.  However, no simulator, no 
matter how realistic, can completely replace a qualified, experienced, human flight 
instructor.  If you are new to R/C, you should never attempt to fly a real aircraft 
without the supervision of a qualified instructor, no matter how accomplished you are 
on the simulator. 
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Getting Started 
A brief  overview and assistance to help start you on your R/C adventure. 

his chapter covers the installation procedure for RealFlight  
G4, describes the basics of running the program, and introduces you to some 
of RealFlight’s frequently used features. 

The first section, Installing RealFlight G4, offers a step-by-step approach to the 
installation procedure for both the program software and the controller. 

The second section, Exploring RealFlight G4, offers a brief tour of the RealFlight G4 
program.  You'll learn how to perform some basic functions, such as selecting the 
aircraft you wish to fly, performing simple edits to the flying field, manipulating 
viewports, and using RealFlight’s Virtual Flight Instruction feature. 

This chapter only touches briefly on some of RealFlight G4’s features.  We strongly 
suggest that you also read the subsequent chapters, which describe the various features 
in comprehensive detail. 

 

Installing RealFlight G4 
 
The RealFlight G4 InterLink Elite controller has several different modes of operation.  
By itself, it serves as a realistic ‘stand alone’ controller or joystick.  Alternatively, it has a 
built-in interface that lets you use your own R/C transmitter to control RealFlight G4.  
The final mode of operation combines the InterLink Elite’s ability to serve as a 
controller and an interface simultaneously. 

Chapter 
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The USB InterLink Elite Controller- 
To install RealFlight G4 using the InterLink Elite controller, follow the instructions in 
this chapter. 

Regardless of whether you plan to use the InterLink Elite controller by itself, or with 
your own R/C radio to control RealFlight, follow the instructions on Program 
Installation in the next section. 

Program Installation- 
RealFlight Generation 4 features a simple, one-step installation process.  There are, 
however, further steps that must be followed prior to running the program for the first 
time.  This section will explain how to install the RealFlight G4 software and hardware.  
Upon completion of this section, you should be able to fly the aircraft on your PC. 

The InterLink Elite’s built-in transmitter interface also allows you to use your own R/C 
transmitter to control RealFlight G4 should you opt to do so.  To activate the interface 
adapter, you will first need to follow the instructions in the section below.  This section, 
will explain the methodology of using the transmitter interface option in the InterLink 
Elite controller. 

Update Drivers- 
Before you begin installation, we strongly suggest that you update the drivers 
for both the sound and video cards on your PC.  A driver is a software 
program that your computer uses to control hardware devices.  Each card has 
its own respective driver.  Most problems with installing and using RealFlight, 
as well as many other programs that use DirectX, arise from using outdated 
video and/or sound card drivers. 

If you are not sure how to update your drivers, you can find instructions in 
article Q01-1038, Locating and installing drivers, at 
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http://www.gpsoftware.com/kb/q01-1038.htm.  This support article will take 
you through the process step-by-step, and has links to driver download sites 
for most manufacturers. 

Installing the Software- 
After you have completed installation of the new video and sound card drivers, 
you are now ready to install RealFlight G4. 

1. Before installing the software, make sure to close any applications that 
you are running.  This includes virus scanning software and other 
similar applications. 

2. Insert Disc 1 (One) into the appropriate CD-ROM drive. 

3. If Auto-Play is active, setup will begin automatically when the CD-
ROM drive is closed.  Simply click the Install button when prompted.  
If Auto-Play is not active, click Start on the task bar.  Next, click Run.  
In the dialog box that appears, type ‘d:\setup’ (assuming that ‘d’ is 
your CD-ROM drive) and click OK. 

Follow the on-screen instructions to complete the setup procedure.  When 
prompted, remove Disc 1 (One) and insert Disc 2 (Two).  Following the on-
screen prompt, remove Disc 2 (Two) and insert Disc 3 (Three).  Following 
the on-screen prompt once again, remove Disc 3 (Three) and insert Disc 4 
(Four).  Upon completion of the installation, click OK. 

Installing or Updating DirectX- 
1. RealFlight will ask if you wish to install DirectX 9 on your PC.  It is 

important that your PC utilizes DirectX 9.0c or later.  Click OK to 
proceed to the DirectX License Agreement. 

2. Click "I accept the license agreement" to install DirectX 9.0c.  
Alternatively, if you do not wish to update DirectX at this time, click 
Cancel. 

3. If you have opted to accept the license agreement, click Next to 
proceed with the installation.  DirectX will install the necessary files to 
update your PC. 

4. When prompted, click Finish.  Your PC will power down and then 
restart once again. 

Connect the InterLink Elite Controller- 
The InterLink Elite controller uses the USB (Universal Serial Bus) port, so 
there is little to do in the way of setup. 
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1. With the software installation procedure complete, firmly plug the 
InterLink Elite controller into one of the unused USB ports on the 
PC.  Because the controller is hot swappable, you do not have to shut 
the PC down to plug the controller in. 

 

2. Shortly after plugging in the InterLink Elite controller, a dialog box 
should appear on the screen indicating that Windows has located a 
new device and will then automatically install the necessary drivers.   

Note: It is possible that Windows will need to install the appropriate files for 
the InterLink Elite controller to function properly.  Please have your Windows 
CD-ROM available in case it is required. 

Starting RealFlight Generation 4- 
1. Double-click the RealFlight G4 Launcher located on your desktop. 

2. Type in your name, software serial number and the InterLink Elite 
controller serial number in the appropriate location.  Please be sure 
to enter the numbers exactly as they appear.  Failure to enter the serial 
numbers correctly will not allow you to proceed to the next step.  If 
the serial numbers are entered properly, the OK button will become 
active.   
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3. Click OK.  The RealFlight G4 Launcher will appear.  Click Run 
RealFlight.  RealFlight G4 will start with a default aircraft and default 
flying site. 

Note: The procedure above will allow you to pilot the RealFlight aircraft using 
the InterLink Elite controller.  The InterLink Elite controller may also be used 
as an interface unit, allowing you to pilot the aircraft with your actual R/C 
transmitter.  For information on how to do so, please refer to the section 
entitled Using Your Own R/C Radio which follows. 

 

Using Your Own R/C Radio 
 
Follow these instructions if you intend to use your own R/C transmitter to control 
RealFlight G4.  If you do not want to use your own transmitter, skip this section. 
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Connecting Your Transmitter- 
You can use your R/C transmitter to control RealFlight G4 by connecting it to the 
InterLink Elite controller, ‘buddy box’ style (see diagrams).  RealFlight G4 includes 
several adapter cables used to make the connection to many popular R/C transmitters. 

 

Locate the cable input port on the rear of the InterLink Elite Controller.  Plug one end 
of the included connector cable into this port.  Next, plug the other end of the adapter 
cable into the buddy box port (a.k.a. trainer jack) of your transmitter.  The procedure 
for doing so depends on your transmitter: 

• If your transmitter’s buddy box port directly accepts the 1/8” stereo plug, insert 
this end directly into the radio.  This works for most JR® radios. 

• If your transmitter’s buddy box port requires the micro (square) connector, use the 
squared adapter cord included with the simulator. 
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• Some radios (e.g., Airtronics®, Hitec® and older Futaba® transmitters) require the 
purchase of an optional adapter cable.  This adapter cable is available wherever you 
purchased your copy of RealFlight G4.   

Setup- 
After you have connected your transmitter to the InterLink Elite controller, you will 
need to perform a brief setup procedure before utilizing it with the simulation. 

1. First, make sure that the transmitter is in FM or PPM mode rather than PCM 
mode.  Refer to the manual for your transmitter if you are unsure how to do 
this. 

2. If the transmitter did not power up when the interface cord was plugged into 
it, turn the power switch on at this time. 

3. Next, click the Controller menu and then highlight the Select Controller… 
menu item.  After a brief delay an option for the InterLink Elite Transmitter x 
channel should appear.  Choose the InterLink Elite Transmitter X Channel 
option. 

 

Exploring RealFlight G4 
 
Now that you have completed the installation of RealFlight G4, it’s time to begin 
exploring the program.  The following sections will take you on a quick tour of 
RealFlight G4’s most popular features, such as selecting an aircraft, choosing alternate 
flying locations, customizing the flying sites, and using the training aids instruction.  
Along the way, we will show you where to go for help and how to obtain additional 
information. 

Even if you are familiar with previous versions of the RealFlight software, you should 
read this section thoroughly.  The features described here are either new or have been 
completely revised for G4. 

Start the Program- 
1. Close all open applications.  This includes virus scanning software and other 

similar programs. 

2. Double-click the RealFlight G4 Launcher located on your desktop. 

3. To start the simulation, click the Run RealFlight button. 

The program will start using the pre-set defaults—including pilot perspective, flying 
location, and aircraft. 



 

 18 

The Main RealFlight Display- 
RealFlight G4 is a menu-driven program.  As seen in the picture below, a menu bar 
appears across the top of the RealFlight screen.  The menus contain additional menu 
items and pull-down lists for the related options of the respective menu.  These menus 
allow access to the command and control functions for the RealFlight G4 simulation. 

Navigating the Menus- 
To access the various menu items, simply highlight and click the mouse on the 
menu that you would like to view.  For example, clicking on the Aircraft menu 
activates the sub-menu items for that menu. 

 

The top-level menus found in G4 are as follows: 

• Simulation 

• Aircraft 

• Controller 

• Events 

• Multiplayer 
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• Recordings  

• Training 

• View 

• Window 

• Help 

This manual includes a separate chapter for each menu title.  Later chapters 
describe in detail all of the menu items, sub-menus and options. 

Please note that it is also possible to access many of the features and functions 
of RealFlight Generation 4 using hot keys.  Pressing the H key on the 
keyboard activates the Keyboard Commands dialog, which summarizes the 
available hot keys. 

Aircraft Selection- 
When you start G4 for the first time, you will be piloting an Extra 300L.  This is the 
default aircraft for RealFlight G4. 

To select a different aircraft, click the Aircraft menu title in the main menu bar.  Next, 
click the Select Aircraft… menu item found in the drop-down menu.  This activates 
the Select Aircraft dialog (as shown below), which displays a list of available aircraft. 
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Each aircraft available in G4 is listed along the left-hand side.  The icon next to each 
name differs depending on whether the model is an airplane or a helicopter.  To select 
an aircraft from the list, click on the desired aircraft.  The selected model will now 
appear in the ReadySelect™ preview box.  Additionally, an aircraft description and 
information data will appear in the aircraft information pane, which appears just below 
the ReadySelect™ preview window. 

When you are satisfied with your selection, click OK to return to the simulator using 
the new aircraft selection. 

Complete information pertaining to the Select Aircraft… menu item is available in 
chapter 6 of this manual, The Aircraft Menu. 

Alternatively, you may use the InterLink Elite controller to change aircraft selections.  
Simply press the Menu/Select button located on the front of the InterLink Elite 
controller.  This will bring forth the QuickSelect tabs on the left side of the computer 
screen and the aircraft selection tab, represented as an airplane icon, should be the 
highlighted tab.  Press the Menu/Select button once again to bring up the Aircraft 
Selection dialog box.  Move the Data Lever, found on the lower right side of the 
InterLink Elite controller, up or down to view the available aircraft.  The [+] (plus) 
indicates that there is another expansion level (selection) available to you, press the 
Menu/Select button to access the items located within this folder. 



 

 21 

To select an aircraft, simply highlight the name and press the Menu/Select button.  
You will return to the simulation using the newly selected aircraft. 

If you wish to exit the Aircraft Selection screen without making any changes, simply 
press the Reset button on the InterLink Elite. 

Aircraft Most Recently Used List (MRU)- 
If you have selected alternative aircraft previously, you will note that these aircraft 
appear on a list in the Aircraft menu, as shown below.  This list is at the very bottom of 
the menu.  This list is commonly referred to as a Most Recently Used, or MRU list.  It 
is limited to the eight most recently used aircraft.  If you wish to fly one of the aircraft 
from this list, simply click on the name of the aircraft in the MRU list. 

 
 
Airport Selection- 
Changing flying sites uses a process similar to the process used to select an aircraft.  To 
select a new flying location, click the Simulation menu located in the header.  Next, 
click the Select Airport… menu item found in the drop-down menu.  This opens the 
Select Airport dialog, which lists the available flying locations.  Select either the 
Archipelago, PhotoFields, or Sierra Nevada location. 
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Each scene is preceded by a [+] (plus) and an icon.  The [+] (plus) indicates that 
another expansion level (selection) is available to you.  To access the complete list of 
airports for a particular scene, either click the [+] (plus) or double-click on the desired 
airport.  For example, clicking the [+] (plus) on the PhotoFields folder reveals all of the 
PhotoFields flying sites available to you. 

To select an airport from the list, click on the desired airport.  The selected airport will 
now appear in the preview box.  Additionally, an airport description will appear in the 
information pane, which appears just below the preview window. 

When you are satisfied with your selection, click OK to return to the simulator using 
the new airport selection.  Navigating the Airport Selection menu using the 
QuickSelect feature is almost identical to the process mentioned above for selecting an 
alternative aircraft.  Only this time, you will select the airport selection menu, which is 
represented by a runway icon.  With the QuickSelect tabs visible on the computer 
screen, move the Data Lever down one time.  This should highlight the runway icon.  
Press the Menu/Select button to bring forth the available flying sites.  Using the same 
method, as described previously for aircraft, select the new airport and press the 
Menu/Select button to return to the simulation using this new flying site. 

Airport Most Recently Used List (MRU)- 
If you have previously selected an alternative flying location, it will appear on a list in 
the Simulation menu.  This list is at the very bottom of the menu and is commonly 
referred to as a Most Recently Used, or MRU list.  It is limited to the eight most 
recently selected locations.  If you wish to fly at one of these locations simply click on 
the respective location in the MRU list to load it into the simulation. 
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QuickSelect Tabs- 
RealFlight G4 offers a revolutionary methodology in which to access many features 
and functions quickly and easily without ever touching the keyboard or mouse.  There 
are seven main areas of access available through the QuickSelect tabs.  They are as 
follows: Airplane Selection, Flying Site Selection, NavGuides, On-Screen Radio, 
Binocular view, Viewports and Variometer. 

To access any of the QuickSelect tabs, press the Menu/Select button on the 
InterLink Elite controller.  This will bring forth the available options on the left side of 
the computer screen.  Move the Data Lever up or down to cycle through the 
QuickSelect tabs. The highlighted tab is the item that is active.  To access the active tab, 
press the Menu/Select button.  
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For additional information on how to use the QuickSelect tabs, please refer to the 
information contained in the section entitled QuickSelect- on page 35. 

Some Common Tasks- 
• The easiest method of resetting your aircraft to its original takeoff position is to 

press the reset button located on the front of the InterLink Elite controller.  
Alternatively, you can reset the aircraft by pressing the space bar on the keyboard, 
or by selecting the Reset Position menu item, which is located in the Aircraft 
menu. 

• If your aircraft is equipped with smoke, the two-position switch located on the 
right side of your InterLink Elite controller will generally be utilized to activate this 
feature. 

• To magnify the view or zoom in on an aircraft, press the [+] (plus) key on the 
number pad of the keyboard.  Alternatively, you may use menu commands to 
zoom in.  To do so, click on the View menu and then click on the Zoom In menu 
item.  Each time the [+] (plus) key or the Zoom In menu item are pressed or 
selected, the view will increase incrementally. 

• To reduce the magnification, or zoom out of the current view press the [–] 
(minus) key on the number pad of the keyboard.  Alternatively, you may use 
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menu commands to zoom out.  To do so, click on the View menu and then click 
on the Zoom Out menu item.  Every time you press [-] (minus) key or select and 
press the Zoom Out menu item, the view will decrease incrementally. 

• To reset the view to the default magnification, press the Backspace on the 
keyboard. 

Creating a Viewport- 
RealFlight allows you to create an additional picture-in-picture viewport.  Once you 
create a new viewport, you may resize or reposition it by dragging with the mouse.  
You can also fully adjust all of the viewport’s properties independently of the main 
window.  The viewports may be utilized for a variety of applications, such as changing 
the viewing perspective of your simulation. 

To create a new viewport, click the Window menu title followed by the Create New 
View menu item.  Alternatively, you may also press the ‘4’ key on the keyboard to 
create an additional viewport. 

 

To change the vantage point within the viewport, press the ‘C’ key on the keyboard.  
The ‘C’ toggles through the various camera modes; the first of which is the cockpit or 
pilot’s perspective.  The second is chase view, and the last mode is the fixed viewpoint, 
or what you would see if you were standing at the side of the runway.  Please note:  
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depending upon the flying site selected, some of these viewing options may not be 
applicable. 

The Window chapter of this manual contains a thorough explanation of the viewports 
and the viewport options. 

Using Gadgets- 
The RealFlight G4 software includes several gadgets that may be displayed in the main 
window when running the software.  A gadget is an on-screen display that provides 
helpful information or allows you to access to a variety of RealFlight features and 
functions. 

For example, the NavGuides gadget displays continuously updated information 
relating to your aircraft’s altitude, airspeed, directional heading, and other flight 
parameters.  To display the NavGuides gadget, click the Window menu title followed 
by the Gadgets menu item.  Next, select the NavGuides gadget located in the drop-
down menu.  You may also access the NavGuides gadget by pressing the numerical ‘1’ 
key on your keyboard.  Alternatively, you may activate the NavGuides gadget through 
the QuickSelect tabs.  To do so, press the Menu/Select button on the InterLink Elite 
controller.  Next, move the Data Lever downward twice.  Finally, press the 
Mode/Select button to activate the NavGuides. 

When you select NavGuides, you should see the NavGuides gadget appear on your 
screen: 

 

As discussed previously, you can customize the gadgets for personal preference.  For 
complete information on how to do so, please refer to the chapter pertaining to the 
Window menu options. 

Virtual Flight Instruction- 
RealFlight G4 includes a variety of basic, intermediate and advanced pre-recorded 
maneuver lessons for helicopter and airplane pilots.  A professional, award-winning 
R/C pilot talks you through every facet of the maneuver.  You can use the Virtual 
Flight Instruction to learn new maneuvers as well as to perfect those maneuvers that 
you already know. 

To activate the pre-recorded maneuvers, click on the Training menu followed by the 
Virtual Flight Instruction… menu item.  Alternatively, press the ‘V’ key on your 
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computer’s keyboard.  Either method brings forth two options:  airplane and 
helicopter, each preceded by a [+] (plus) symbol.  Each option has a number of pilots 
listed beneath.  To select amongst the pilots, click the [+] (plus) which precedes their 
name.  Alternatively, you may double-click the pilot’s name. 

 

To select a maneuver, double-click the name of the maneuver itself.  Alternatively, 
highlight the name of the maneuver by clicking on it, then select OK.  After you have 
selected a maneuver, click OK to proceed.  RealFlight G4 will automatically load the 
default airport and then start the VFI recording. 

Once the VFI starts, you will see the instructor’s aircraft fly the maneuver and hear the 
instructor’s voice explaining how it’s done.  As depicted below, you can also watch the 
instructor’s actual stick movements using the on-screen, digitized R/C radio. 
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You can even fly your own aircraft next to the instructor’s!  This allows you to mimic 
the inputs and aircraft reaction simultaneously.  To simultaneously watch your aircraft 
and the instructor’s, create an additional viewport focused on your aircraft.  The main 
window will show the instructor’s aircraft and the on-screen radio will show the 
instructor’s stick movements.  The newly created viewport will show your aircraft. 
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RealFlight Trainers- 
RealFlight G4 includes several training aids to help learn the basics of taking off and 
landing an airplane.  Obviously, mastering these skills is essential to the success of your 
entry into radio control flight.   

The Takeoff training feature, as the name suggests, is designed to enable pilots of all 
skill levels to perfect their takeoffs.   

To select the Takeoff training feature, click on the Training menu title followed by the 
Takeoff Trainer… menu item.  The Takeoff Trainer will start using the default 
settings.  If, however, you wish to alter any of the settings, click on the Trainer menu 
title.  For additional information pertaining to these settings, please refer to the section 
entitled Takeoff Trainer on page 202 in this manual.   
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The Landing Trainer feature is designed to enhance a pilot’s landing skills.  As with 
full-scale aircraft, it is imperative that an R/C pilot be well-versed in the proper 
technique of landing their aircraft in various conditions.  Failure to land an aircraft 
properly may result in a damaged aircraft…or perhaps even destroy it entirely.   

To select the Landing Trainer feature, click on the Training menu title followed by the 
Landing Trainer… menu item.  The Landing Trainer will begin with the aircraft in a 
pre-determined position using its default settings.  If, however, you wish to alter any of 
the settings, click on the Trainer menu title.  For additional information pertaining to 
these settings, please refer to the section entitled Landing Trainer located on page 207 
in this manual.   
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Airport Editing- 
RealFlight G4 offers the most powerful, flexible flying site editor ever produced on an 
R/C simulation.  G4’s FlexiField™ editor allows you to completely customize virtually 
every aspect of your flying sites. 

 

You can add, remove, change the orientation of, or resize virtually every aspect of your 
flying site.  You can alter the position and orientation of the ground objects (such as 
runways) that ‘snap’ to the terrain—you can even have a runway running up a hill!  It’s 
even possible to control lighting, terrain, clouds, fog/haze, and much more.  FlexiField 
provides you with almost unlimited freedom to create the flying environment you 
want.  Moreover, when you’ve created an airport, you can share it with other RealFlight 
G4 users. 

To learn more about the FlexiField flying site editor, please refer to the section titled 
Edit Current Airport… on page 40. 

 

Where to Go From Here 
 
The examples in this chapter only scratch the surface of RealFlight G4’s unparalleled 
capabilities.  You can fly with others over the internet, fly with a friend using 
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MultiMode on the same PC, try your hand at a limbo event, customize your aircraft’s 
flight parameters, and much, much more!  We encourage you to explore RealFlight G4 
using some of the methods below. 

• Browse through the menus.  Many of the menus are self-explanatory, providing 
you with a more thorough look at the software.  If you’re adventuresome, dive 
right in and start making modifications to an aircraft or a flying site!  It’s a great 
way to learn more about what makes G4 tick! 

• If you’d like to learn more about a particular menu or item, look it up in the table 
of contents. 

• If you would like RealFlight G4 to perform a certain function but cannot locate the 
appropriate command, check the index. 

• Use the Help facilities in RealFlight’s Help menu. 

• Talk to other RealFlight users at www.knifeedge.com. 
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The InterLink Elite 
Controller 
The InterLink Elite is your all-access pass to the RealFlight world. 

he R/C transmitter is a key component in all types of R/C flying.  This unique 
method of control is part of what separates R/C from every other type of 
aviation.  Consequently, a realistically simulated transmitter is an important key 
to an authentic simulation of the R/C experience. 

With this in mind, we at Great Planes are proud to offer our revolutionary USB 
InterLink Elite (U.S. Patent #6,842,804 and #7,010,628) controller, made by Futaba.  
The InterLink Elite controller was designed from the ground up to meet the needs of 
the R/C purist.  We believe that no other R/C simulator control method goes farther 
to enrich your R/C simulator experience. 
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Features of the InterLink Elite Controller- 
• USB compatibility and convenience.  The InterLink Elite offers the “plug and 

play” convenience, “hot pluggable” installation and removal, as well as the high-
speed digital performance made possible by Universal Serial Bus (USB) 
technology. 

• High quality “mockup” transmitter.  Use the InterLink Elite controller by itself as a 
pseudo R/C transmitter, with the controls you expect in a standard 8-channel 
radio.  The mockup transmitter features two 2-position switches, one 3-position 
switch, a rotary knob, knurled control sticks with adjustable length and a push-
button reset. 

• Built-in Transmitter interface.  If you so choose, you can use your own FM or FM-
compatible R/C transmitter to control RealFlight, using the InterLink Elite 
controller’s built-in interface.  You can even switch back and forth between the 
pseudo controller and your own transmitter!  Interface adapter cords are included 
for most JR, Futaba and Hitec transmitters. 

• Simultaneous interface and controller.  The InterLink Elite makes it possible for 
two modelers to fly on the same PC, each using his/her own controller to pilot the 
aircraft. 

• QuickSelect menu controls.  With the InterLink Elite, you’re able to make a variety 
of common adjustments to the simulator (such as, selecting a different aircraft or 
airport.) without having to touch the keyboard and mouse.   

• Easy setup and use.  Unlike other computer joysticks, in most cases, you do not 
even have to calibrate the InterLink Elite controller.  Simply plug it in and go! 

• Simulate sophisticated computer radios.  The InterLink Elite, used in conjunction 
with the RealFlight software, allows you to simulate the programmability (mixing, 
exponential, etc.) of sophisticated computer radios. 

Start Flying! 
When you start RealFlight for the first time, the software will automatically detect the 
InterLink Elite controller.  Simply add throttle and start flying right away. 

RealFlight, by default, uses the InterLink Joystick setting.  This setting affords G4 the 
plug-and-play capability in the simulation.  In this mode, the InterLink Joystick allows 
the InterLink Elite to control all functions associated with the flight of your aircraft. 

The InterLink Elite also allows you to use your own R/C transmitter to control the 
RealFlight aircraft.  This is referred to as the Transmitter Interface Mode. 
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QuickSelect- 
The InterLink Elite also offers QuickSelect buttons located at the bottom of the 
controller.  These buttons allow you to make simple changes to the simulator without 
having to put the controller down and reach for the keyboard and/or mouse.  This 
makes it convenient to change the current aircraft and airport, or display popular on-
screen gadgets. 

To access the QuickSelect tabs, press the Menu/Select button to display a number of 
tabs on the left side of the simulator.  Use the Up and Down direction on the Data 
Lever, located on the lower right side of the controller, to scroll through these options.  
Pressing the Menu/Select button again will select the highlighted tab.  Pressing the 
Cancel button on the InterLink Elite will exit out of the tabs and hide them. 

The options available are: 

  Select Aircraft 

  NavGuides Gadget 

  Binocular View 

  Variometer 

  Select Airport 

  Radio Gadget 

  Viewport 

When using the QuickSelect buttons in the Select Aircraft or Select Airport dialog 
screen, press Menu/Select to select the current highlighted item.  Pressing Cancel on 
the InterLink Elite will move you up a level so you can quickly change folders.  To exit 
out of these dialog screens without making any changes, simply press the Reset 
button.  
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Look for the icon to the left throughout this manual for suggestions 
on when to use the QuickSelect buttons. 
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The Simulation Menu 
Allows access to a variety of  simulation-related features, functions and options. 

he Simulation menu brings forth a pull-down menu, giving you access to many 
simulator related features, such as changing flying sites or importing and 
exporting RealFlight files. 
Clicking the Simulation menu will bring forth a screen that looks similar to the 

following screen shot. 

 
Menu items that are available are: 

• Select Airport... 

• Edit Airport Name 

Chapter 
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• Create New Airport… 

• Capture Screenshot 

• Mute Audio 

• Environment 

• Flight Failures 

• Import 

• Export 

• Manage User Files 

• Settings 

• Exit 

• Airport MRU 
 
 

Select Airport… 
 
When you click on Select Airport… the following dialog appears: 
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This dialog lets you choose the flying site that you wish to use for your flight.  Each 
location offers its own unique characteristics and challenges. 

The list on the left of the dialog box displays all of the flying sites available to you.  If 
you have created any flying sites, those sites will also be visible here. 

The flying sites are listed in files and folders in accordance with the software from 
which they were loaded.  If, for example, you have installed Expansion Pack 2, the sites 
from this disk will be listed, alphabetically, beneath the Expansion Pack 2 folder.  You 
can change how the airports are organized by clicking on the Grouping drop-down 
and select another grouping option.  The options are: 

Product, Scene: As explained above, airports are first grouped into folders by the 
product in which they are contained.  Within each group they are then grouped further 
by scene. 

Product: Airports are grouped by product alone. 

Scene: Airports are grouped by scene alone.   

None: Airports are not grouped into folders at all.  Rather, they are listed 
alphabetically. 

Click the [+] (plus) or the [-] (minus) symbol to reveal or hide the airports within 
these folders.  To select an airport, click on the name of the airport at which you wish 
to fly. 

The rotating image on the right side of the screen provides you with a preview of what 
to expect at the desired location.  The dialog box below the terrain map contains a 
description and pertinent information regarding the highlighted airport. 

Have some fun while you’re in the Select Airport dialog.  Using the mouse, click and 
drag the preview screen to point the camera angle to your choosing.  To resume 
rotating automatically, right-click the preview screen. 

When you are satisfied with your selection, click OK to return to your flight using the 
new airport selection. 

The Cancel button will return you to the simulation at the previously selected flying 
site. 

Change airports simply by using the InterLink Elite.  Press the 
Menu/Select button, then, using the Data Lever, move down one 
tab and press the Menu/Select button again.  This will bring up the 
Select Airport dialog window.  You can continue using the  
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QuickSelect buttons in this dialog to select a new airport, or press Reset to resume 
flying without making any changes. 

 
 
Movement Modes 

If applicable to the respective airports, Generation 4’s Movement Modes allow you to 
explore the scenery without an aircraft.  Movement is not possible at PhotoFields 
airports. 

To select a Movement Mode, press the ‘Q’ key on your keyboard.  You can press the 
‘Q’ key repeatedly to cycle through the available modes:  Walk, Fly or Hover. 

Walk mode simulates the effect of you, the pilot, physically walking across the field, 
complete with sound effects.  The Fly mode allows you to move through the air and 
position the camera anywhere that you desire. 

Once you have entered the desired Movement Mode, use the ‘W’, ‘S’, ‘A’ and ‘D’ keys 
on your keyboard to control the movements.  If you wish to increase the speed of your 
movement, press and hold the Shift key at the same time you are using the ‘W’, ‘S’, ‘A’ 
or ‘D’ key. 

The mouse wheel controls the angle or height at which you traverse the scenery.  To 
increase the altitude, roll the wheel away from you.  This is known as the Hover Mode. 

You may also control the zoom levels during your travels.  Press the [+] (plus) key to 
Zoom In and the [-] (minus) key to Zoom Out.  The Backspace key resets the 
zoom level to its default value. 

Edit Current Airport… 
 
RealFlight G4 offers unparalleled freedom to edit flying sites.  You can add and 
remove objects, alter their location, rotate, and even resize items.  It is also possible to 
alter the atmospheric or lighting conditions at the various flying locations.  The first 
several times you access the airport editing function, the possibilities might seem 
daunting.  It will require some getting used to before you are comfortable with this 
feature and its related functions.  The best way to do so is to simply dive in and 
experiment. 

To modify the currently selected flying location, click the Simulation menu followed 
by the Edit <Current Airport>… menu item, where <Current Airport> is the name 
of the airport you have loaded at the moment.  This activates RealFlight G4’s 
FlexiField flying site editor, with the currently active airport loaded and ready to edit. 
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Airport Editor Menus- 

Selecting the Edit Current Airport option activates the screen shown above.  There are 
five menus in the Airport Editor dialog: 

• File 

• Edit 

• View 

• Options 

• Window 

File Menu- 

This menu and its menu items are used to manipulate and control the various folders 
and related items in the airport editor. 
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Open- 

This menu item is used to open existing and edited airports.  Selecting this 
menu item opens the Select Airport dialog. 

  Save- 

This option becomes active once you have renamed and saved the edited 
airport.  Prior to doing so this option remains inactive and grayed out. 

Save As- 

Upon completion of the airport editing, click this menu item to save the 
modifications.  You will be asked to create a name for this new airport.  After 
you have renamed the airport, click OK to accept the new name.  Afterwards, 
the airport will appear in the airport listings found in the Select Airport… 
which is located in the Simulation menu. 

Save folder- 

This option allows you to select an entire sub-folder in an airport and save it as 
a new file.  For example, it is possible to select the entire “Objects” sub-folder 
in RealFlight Ranch and save it off to a disc. 
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To save the folder, right click on the existing folder and select Save Folder.  
This brings forth a dialog that allows you to determine the new folder’s name 
as well as the location where it will be saved. 

Alternatively, with the respective folder highlighted click on the File menu and 
select Save Folder menu item from the pull-down menu. 

Load Folder- 

This option allows you to load a folder from the saved folders.  To do so, right 
click on an existing folder.  Next, select the folder from the list. 

Alternatively, with the respective folder highlighted click on the File menu and 
select Load Folder menu item from the pull-down menu. 

Exit to Simulator- 

Use this option to cease editing the airport and return to the simulation.  If you 
have not made any changes to the airport, you will return directly to the 
simulation.  If you have unsaved changes, a message box will ask for 
confirmation before returning to the simulation. 

Edit Menu- 

This menu may be used for some simple editing functions on the selected airport. 
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Undo- 

Select this to undo the last change you made in the airport editor. 

Redo- 

Choose Redo to repeat the last action you did in the airport editor. 

Cut- 

Select one or more objects at the airport and choose Cut to remove the 
selected objects.  The objects are stored temporarily in RealFlight’s memory 
and can be pasted back into an airport. 

Copy- 

Like the Cut options, Copy will store the selected objects in RealFlight’s 
memory allowing you to later paste it into an airport.  Unlike Cut, the selected 
object will remain at the current airport. 

Paste- 

If any objects have been cut or copied, choose Paste to add them to the 
current airport. 

Delete- 

Delete will remove the selected objects from the airport. They cannot be 
retrieved later.  Therefore, you cannot paste the object(s) back in the scenery. 

Select All- 

This menu option will select all objects at the airport you are currently editing. 

Deselect- 

Choosing this menu option will deselect any airport objects that might be 
selected at the moment.  If no objects are selected, Deselect will remain grayed 
out. 

Previous Object- 

If any airport object is currently selected, choosing Previous Object will select 
the preceding object in the folder list. 

Next Object- 

If any airport object is currently selected, choosing Next Object will select the 
next object in the folder list. 
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Select Parent- 

All objects belong to a group or parent.  To select the parent that the current 
selected object belongs to, choose Select Parent. 

Select Child- 

If a group is currently selected, choose Select Child to select the first object 
listed in that group. 

Set As Default Pilot Spawn- 

Choose a pilot spawn and click this menu option to set it to the default 
spawning point.  This point will be the default camera position each time you 
load the current airport. 

View menu- 

This menu allows you to make alterations and modifications related to the perspective 
of the simulation during the editing process.  Modifications to the vantage point do not 
have any effect on the simulation during its operation. 

 

Mode- 

The Mode menu is utilized to alter the camera perspective when viewing the 
scene.  There are three distinct view modes in G4:  Pan Camera, Pivot Camera 
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and Normal Camera.  These modes, as well as the methods to access them will 
be discussed in depth in the sections that follow. 

Pan Camera- 

The Pan Camera option allows the camera to shift the vantage point 
on the selected scenery. 

There are several ways to access the Pan Camera mode.  The first, and 
probably the easiest, is to press the ‘C’ key on your keyboard.  
Alternatively, you may right click on the scene and select Pan Camera 
from the available options.  The final method that may be used is to 
select Pan Camera through the View menu and Mode menu item. 

To increase the pan view, rotate the mouse wheel towards the 
computer screen.  Alternatively, you may also press the [-] (minus) 
key on the number pad of the keyboard.  This causes the camera to 
zoom out incrementally. 

Conversely, to decrease the pan view, either rotate the mouse wheel 
away from the computer screen or press the [+] (plus) key on the 
keyboard’s number pad.  This causes the camera to zoom in 
incrementally. 

You can exit this mode by using the menus or by hitting the ‘Z’ key, 
which returns you to the normal viewing mode. 

Pivot Camera- 

The Pivot Camera mode, as the name suggests, pivots or rotates the 
camera in relationship to a particular object or location. 

There are several ways to access the Pivot Camera mode.  The first, 
and probably the easiest, is to press the ‘X’ key on your keyboard.  
Alternatively, you may right click on the scene and select Pivot Camera 
from the available options.  The final method that may be used is to 
select Pivot Camera View menu and Mode menu item. 

To increase the pivot view, rotate the mouse wheel towards the 
computer screen.  Alternatively, you may also press the [-] (minus) 
key on the number pad of the keyboard.  Doing so will cause the 
camera to zoom out incrementally. 

Conversely, to decrease the pivot view, either rotate the mouse wheel 
away from the computer screen or press the [+] (plus) key on the 
keyboard’s number pad.  Again, this will zoom the camera in 
incrementally. 
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To exit the Pivot Camera feature, right click in the editing view once 
again and then mouse click the desired option in the popup menu.  
You can also exit this mode by hitting the ‘Z’ key, which returns you 
to the normal viewing mode. 

Normal Camera- 

This mode returns the camera to its normal, or default perspective. 

There are several ways to access the Normal Camera mode.  The 
easiest is to simply press the ‘Z’ key on the keyboard.  Alternatively, 
you may right click in the scene and select Normal Camera from the 
options listed.  Finally, you may select Normal Camera through the 
View menu and Mode menu item. 

Center View on Selection- 

This option centers the vantage point on a particular object.  This is useful for 
repositioning, resizing, rotating, etc. 

If you have not selected an object from the Folder Listing or highlighted an 
object in the scene, this option will remain inactive or grayed out.  If, however, 
you have made a selection or highlighted an object, there are several ways to 
select the Center View on Selection option. 

Simply right click on the selected object or folder in the Folder Listing.  
Alternatively, in the scene, right click on the highlighted object and select the 
Center View on Selection from the options listed.  The final option is to use 
the View menu and select the Center View on Selection option. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key 
on the keyboard.  Each time you press the [+] (plus) key or select the Zoom 
In menu item, the zoom level increases incrementally.  Alternatively, you may 
select the Zoom In option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the 
[-] (minus) key on the keyboard.  Each time you press the [-] (minus) key or 
select the Zoom Out menu item, the zoom level decreases incrementally.  
Alternatively, you may select the Zoom Out option from the View menu. 

Fit Selection in View- 

This option is utilized to ensure that your selection fits in the view.  If, for 
example, your zoom magnification is at an extremely high level, the object may 
not completely fit on the screen.  This feature ensures that it will. 
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To access the Fit Selection In View, right click on the highlighted object in the 
scene and select the Fit Selection In View from the options listed.  The final 
option is to use the View menu and select the Fit Selection In View option. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key 
on the keyboard.  Each time you press the [+] (plus) key or select the Zoom 
In menu item, the zoom level increases incrementally.  Alternatively, you may 
select the Zoom In option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the 
[-] (minus) key on the keyboard.  Each time you press the [-] (minus) key or 
select the Zoom Out menu item, the zoom level decreases incrementally.  
Alternatively, you may select the Zoom Out option from the View menu. 

Zoom In- 

Click this menu item to magnify or zoom in on the selected item.  
Alternatively, you may magnify the view or zoom in on the selected item by 
pressing the [+] (plus) key on the keyboard.  Each time you press the [+] 
(plus) key or select the Zoom In menu item, the zoom level increases 
incrementally. 

Zoom Out- 

Click this item to reduce the magnification, or zoom out of the current view.  
Alternatively, press the [–] (minus) key on the keyboard.  Alternatively, you 
may zoom out via G4’s menus.  Each time the [-] (minus) key or the Zoom 
Out menu item are pressed or selected, the view will decrease incrementally. 

Zoom Reset- 

This menu item resets the view to the default magnification.  Alternatively, you 
may also press the Backspace on the keyboard to reset the zoom to its default 
value. 

Options Menu- 

The Options Menu allows you to adjust how many of the functions in the airport 
editor will work. 
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Selectable Items- 

The Selectable Items menu determines whether a particular type of object may 
be clicked and selected on-screen. 

To eliminate the possibility of selecting an item, simply mouse click on the 
desired listing in the pull-down menu.  This capability is useful if there are 
many objects clustered in a small area and you want to select just one of them.  
For example, suppose that an airport has a tight cluster of trees with a dirt pile 
in the middle.  If you want to select the dirt pile, it may be easier to turn off the 
tree selection first.  This will allow you to easily select the dirt pile without the 
trees getting in the way. 

Add Object Grouping- 

The items available for addition in RealFlight G4 are all grouped or organized 
accordingly.  This menu item determines the methodology by which they are 
grouped in the Object Palette window. 

Product, Type, Name- 

Selecting this option causes the objects in the Object Palette to be 
displayed by the Product then by the Type and finally by the Name.  
That is, objects are first listed within the product in which they appear 
(e.g., G4, Expansion Packs, etc.).  Within the product, the objects are 
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then classified by Type (e.g., Buildings, Trees, etc.).  Once you’ve 
selected the Product and Type of object that is desired, the objects are 
then listed alphabetically by Name. 

For information on adding objects and how to use the Object Palette, 
please refer to the Object Palette section of this manual. 

Type, Name- 

This option causes the objects in the Object Palette to display by the 
Type and the Name designations only.  They are not sorted by the 
Product in which they appear.  Objects that appear in G4, Expansion 
Packs, etc. will be included on one extensive listing. 

This option is useful if you are unsure as to which product included a 
particular object. 

Name- 

Selecting this option causes the objects to be listed in alphabetical 
order by their name designations (e.g., Barn).  This listing is extensive 
as it includes all of the objects available to you. 

This option is useful if you are unsure as to which product contained 
the object or if you are unsure as to the type of object that you wish to 
utilize.  It also offers a rapid overview as to the number and breadth of 
objects available to you. 

Rotation Snap- 

When rotating an object on the flying site, you have the ability to control the 
amount of rotation with the Rotation Snap.  There are four snap settings that 
may be utilized in the editor to provide quick orientation settings for placing 
objects. 

None 

The object rotates without any restrictions.  This is useful for making 
minor refinements to object placement. 

45 Degrees  

The object will rotate 45 degrees each time if this option is selected.  
This is useful for making large changes to object position. 

15 Degrees 

The object will rotate 15 degrees each time if this option is selected. 
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5 Degrees 

The object will rotate 5 degrees each time if this option is selected. 

Display Metric Units- 

Click this item with your mouse to switch the measurement indicators in the 
Properties pane from SAE (feet, inches, pounds) to metric (meters, 
centimeters, kilograms). 

Window Menu- 

This menu item activates or eliminates items from the display or window.  For 
example, if you were to click the Properties item in the pull-down menu this would 
eliminate the Properties window from the screen. 

 

Folder Listing- 

This listing includes all of the folders available to you for use in the airport 
editor.  Selecting this item from the pull-down menu will remove the Folder 
Listing dialog from the screen. 
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Object Palette- 

The Object Palette includes the complete selection of objects available to you 
for use in editing an airport.  Selecting this item from the pull-down menu will 
remove the Object Palette dialog from the screen. 

Pilot Preview- 

Selecting this item from the pull-down menu will eliminate the pilot’s 
perspective from the screen. 

Properties- 

Selecting this item from the pull-down menu will remove the Properties dialog 
from the screen. 

Reset Window Position- 

This menu item resets the positions of the airport editing windows back to 
their default locations.  Additionally, if you have removed any of the default 
windows, they will return to the screen at this time. 

 

Utilizing the Editor 
 
Opening the airport editor reveals four distinct windows.  For the purpose of clarity, 
we will examine each window individually.  It is, however, important to note that these 
windows interact with one another. 

Folder Listing Window- 

The Folder Listing window consists of the folders and items (objects) that comprise 
the currently selected airport. 
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To determine what items are contained within the Objects and Clouds folders, click on 
the [+] (plus) or double-click on the name itself (e.g., Objects).  Doing so brings up 
the various sub-folders that are contained within the main item. 

As denoted by the [+] (plus) symbols, these folders, in turn, also have another level.  
Again, to open these respective levels, click on the [+] (plus) icon or double-click the 
folder name. 

Alternatively, clicking on an object in the scene will highlight the respective object.  It 
will also open the folder that contains the object.  The converse is also true, clicking the 
folder or object in the Folder Listing menu will highlight the respective item as well. 

If you wish to move an object from one folder to another, mouse click and hold the 
object to be moved.  Next, drag the object to the desired location (folder) using the 
mouse and release.  The object will be listed at the bottom of the folder in which it has 
been situated.  Please note:  this removes the object from the original folder. 

You may use either of two methods to delete an object from the folder, and therefore 
the scene as well. 
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First, you can highlight the object or sub-folder (e.g., Fences) in the Folder Listing and 
press the Delete key on the keyboard.  

Alternatively, with the object or sub-folder highlighted, right click and select the Delete 
Object pull-down option. 

Properties Window- 

The Properties window indicates the detailed information for the item highlighted in 
the Airport Editor window.  Consequently, the contents of the Properties window vary 
depending upon the selection in the Folder Listing window. 

The example below indicates what is displayed if the flying site’s root or top-level 
folder is highlighted.  Regardless of what is selected, the Properties are all very similar 
in nature and in their method of modification. 

 

An asterisk to the left of an item indicates that it has been modified.  Right clicking the 
item will bring up the Restore Original Value or Set to Default Value options. 
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Object Palette Window- 

The Object Palette window is used to add a new object or objects to the airport.  The 
object window consists of two separate sections:  the preview box in the top section of 
the window, and the objects list in the bottom section. 

 

All objects are grouped according to their root directory.  Within the root directory the 
grouping is further refined.  For example, you will find all available benches in the 
Benches, Chairs and Tables group.  This, of course, assumes that you are utilizing the 
Product, Type, Name or Type, Name as determined by the Add Object Grouping 
Selection in the Options menu. 

Each object group is preceded with a [+] (plus) and an icon.  The [+] (plus) indicates 
that there is another expansion level, or selection, available to you.  Clicking on the [+] 
(plus) or double-clicking the respective root directory name (e.g., RealFlight G4) will 
bring forward the pull-down menu of the items contained within the specified folder. 

If, for example, you wanted to add a bench to the current airport, take the following 
steps: 
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1. Click on the [+] (plus) icon in front of the Benches, Chairs and Tables group (or, 
double-click the group name itself).  This reveals the next expansion level to you. 

2. From this expansion list, select the ‘Bench’ object.  The selected object appears in 
the preview box. 

3. Click the Add button, which adds the object to the scene. 

You will find additional information pertaining to object placement, positioning, etc., in 
the Properties section of this chapter. 

You may use any one of several available methods to change the location of an object 
in the airport.  To use the drag and drop method, click on the object to highlight it, as 
shown below.  Once you have highlighted the object, press and hold the mouse 
button.  Move the mouse to the desired location and then release the button to drop 
the object in the new location. 

 

Alternatively, with the object highlighted, right click the mouse elsewhere in the 
scenery.  This brings up a pop-up menu with several options available to you.  To 
move the selected object, point the mouse to the location that you desire and click the 
Move Here option. 
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G4 also allows you to easily replicate the selected objects.  To do so, hold the ‘Ctrl’ key 
down, click and hold the mouse button and use the mouse to drag the object to a new 
location.  You will see that the original object stays in place.  Release the mouse button 
and the ‘Ctrl’ key to drop the new item in place. 

Once you have added an object to the airport, you can modify it freely.  Refer to the 
Properties Window – Object Selection section for information on how to do so. 

Pilot Preview- 

This window provides you with the ability to view the scene from the pilot’s 
perspective.  It is very useful when editing PhotoField airports. 

 

The number of pilot perspectives available to you varies; dependent upon the selected 
scene.  For example, RealFlight Ranch offers:  Runway Center, Runway End and 
Helipad as the viewing options.  To select amongst these options, open the Spawn 
Folder in the Folder Listing.  Use the up/down arrow keys on the keyboard or the 
mouse to select the desired perspective. 

It is also possible to modify the selected vantage points.  For example, you may Zoom 
In and Out, or simply scan the horizon.  Note that in order to modify the vantage 
point, the Pilot Preview window must be the active window.  To ensure that the Pilot 
Preview window is the active window, simply click on, or in, this window. 
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To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally. 

In most cases, you can also use the scroll wheel on the mouse to zoom in and out on 
the scenery 

RealFlight also allows you to scan the scene.  To do so, press and hold the mouse 
button.  Moving the mouse will shift the scenery. 

Create New Airport 
 
This menu enables you to create an entirely new airport, starting with a fresh canvas.  
The FlexiField flying site editor provides you with virtually unlimited editing options, 
limited only by your imagination. 

 

The options available to you when creating an airport are identical to those found in 
the section pertaining to the airport editor above.  As such, we will avoid duplicating 
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these instructions.  Instead, we encourage you to experiment with the options, settings 
and choices as you see fit. 

After you have finished creating your airport, click the file menu and save the airport.  
The airport name will appear in your RealFlight G4 directory for future use. 
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Capture Screenshot 
 
Just like the perfect photo opportunity at the local flying field, RealFlight G4 offers the 
chance to snap off screenshots.  Captured screenshots are great to share with friends, 
add as your desktop wallpaper, or put on the Internet for the world to see. 

 

To snap a screenshot, click the Capture Screenshot menu item.  Alternatively, press 
the Tab key on the keyboard. 

Screenshots are stored in the My Documents folder. 

 



 

 61 

Mute/Unmute Audio 
 
At times, you may want to fly without any sound.  Choose this menu item to mute the 
audio.  Select it again to activate the sounds. 
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Environment 
 
The Environment menu item has a number of sub menus that allows you to adjust the 
sun location and wind settings. 

 

Sun- 

RealFlight G4 gives you the ability to adjust the position of the sun in the sky.  
By changing the Azimuth, you can rotate the sun around you.  Change the 
Inclination to adjust how high in the sky the sun should be, or turn day into 
night by moving the sun below the horizon. 
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The sun settings are not applicable at PhotoField flying sites. 

Adjusting the Sun Azimuth- 

If you customize an airport, and find that the sun is always in your 
flight path, adjusting the sun’s Azimuth is a good way to move it 
around the sky, out of your way. 

To adjust the Azimuth, select the Sun menu.  This will bring forth the 
Azimuth and Inclination options.  Highlight the Azimuth menu item 
in the pull-down selections.  To rotate the sun to the right, click 
Increase.  Clicking Decrease will rotate the sun to the left. 

Alternatively, you may increase or decrease the Azimuth by pressing 
Shift + Home or Shift + End. 

When altering the Azimuth, the simulation temporarily displays the 
new location in the lower left corner of the window. 

Adjusting the Sun Inclination- 

To position the sun higher in the sky, or set it below the horizon, 
modify the Inclination. 
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To adjust the Inclination, select the Sun menu.  This will bring forth 
the Azimuth and Inclination options.  Highlight the Inclination menu 
item in the pull-down selections.  To raise the sun higher into the sky, 
click Increase.  Click Decrease to lower the sun, or to set it below the 
horizon to make it night time. 

Alternatively, you may increase or decrease the Inclination by pressing 
Shift + Page Up or Shift + Page Down. 

When altering the Inclination, the simulation temporarily displays the 
new location in the lower left corner of the window. 

At night time, RealFlight G4 will automatically turn on the lighting 
effects on objects and aircraft that offer the lighting abilities. 

Wind- 

RealFlight G4’s TruFlo Wind Dynamics offers the most realistic wind model 
of any R/C simulator.  Its five components work together to capture this 
complex, ever-changing force with unmatched realism.  Just as it would at the 
field, your model will encounter a variety of wind forces as it soars across the 
skies in RealFlight.  Sailplane enthusiasts will appreciate the lifelike effect of the 
winds as they follow the drafts on the slopes and hills of G4. 
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RealFlight offers you the ability to adjust both the speed and direction of the 
wind.  To access the Wind settings, click on the Simulation menu followed by 
the Wind menu item.  Several methods may be utilized to adjust the wind 
speed and direction. 

Adjusting the Wind Direction- 

RealFlight G4 allows you to alter the direction (expressed in degrees) 
of the wind.  This function is perfect for practicing crosswind landings. 

Selecting the Wind menu item brings up the Speed and Direction 
options.  To adjust the wind direction, highlight the Direction menu 
item in the drop-down selections.  To increase the degree of wind 
direction, click on the Increase option in the drop-down selections.  
Likewise, clicking the Decrease option lowers the degree of wind 
direction.  The wind direction degree increases and decreases in 15-
degree increments. 

You may also adjust the Direction through the Settings… menu item.  
This method allows you to adjust the direction in one-degree 
increments. 

Alternatively, you may increase the angle of the wind direction by 
pressing the Home key on the keyboard.  To decrease the angle of the 
wind direction, press the End key on the keyboard. 

When altering the wind direction, the simulation temporarily displays 
the new wind direction in the lower left corner of the window. 

Adjusting the Wind Speed- 

Increasing the wind speed is an ideal way to learn to fly in the less-
than-perfect wind conditions that frequently occur at an R/C field.  To 
adjust the speed of the wind, select the Wind menu.  This will bring 
forth the Speed and Directions options.  To adjust the speed of the 
wind, highlight the Speed menu item in the pull-down selections.  To 
increase the speed of the wind, click on the Increase option in the 
pull-down selections.  Clicking the Decrease option reduces the wind 
speed. 

Alternatively, you may increase the wind speed by pressing the Page 
Up key on your keyboard.  To decrease the speed of the wind, press 
the Page Down key on your keyboard.  Each time the Page Up or 
Page Down key is pressed the wind is increased or decreased 
incrementally. 
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When altering the wind speed, the simulation temporarily displays the 
new wind speed in the lower left corner of the window. 

Alternatively, you may adjust the Wind through the Settings… menu item.  
For information on how to do so, please refer to the Settings section on page 
76. 

 

Flight Failures 
 
RealFlight G4 offers the ability to simulate common failures for your aircraft.  This 
feature aids in teaching you how to remain calm and react appropriately when an actual 
failure occurs at your R/C field.  RealFlight G4 allows you to determine both the types 
of flight failures that you will face as well as how often those failures will occur. 

 

Adjust the Rate of Occurrence- 

There are several methods available to adjust the frequency at which flight 
failures will occur.  To use the first method, click on the Simulation menu 
followed by the Flight Failures menu item, and then the Frequency menu 
item.  This brings up a sub-menu as shown in the screen below.  Once the sub-
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menu is visible, simply mouse click on one of the options in the pull-down 
menu. 

 

Alternatively, you can adjust the rate of occurrence in the Settings… menu 
item.  To access this menu item, click on the Simulation menu followed by 
the Settings… menu item.  Next, click on the Flight Failures listing.  You 
can bring forth the Flight Failures options by clicking on the [+] (plus) or by 
double-clicking on the Flight Failures listing itself.  To adjust the frequency of 
occurrence, click on the value as indicated in the column to the right of the 
probability indicator.   

The Settings section on page 76 discusses the Flight Failures options in detail. 

If you do not wish to experience any flight failures, click the Never option in 
the drop-down menu.  Conversely, if you wish to gain a great deal of 
experience at handling emergencies, click the Always option.  The Always 
options means that each time you reset the aircraft, something is guaranteed to 
go wrong.  Maybe not right away – an engine failure will usually wait until 
some entirely inconvenient time to reveal itself, but it will happen.  The Rarely 
option corresponds to roughly a 5% chance per reset that something will fail. 
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 Selecting the Type of Flight Failures- 

As noted previously, RealFlight G4 also allows you to determine the type of 
flight failures that you will experience within the simulation.  To do so, click 
the Simulation menu followed by the Flight Failures menu item.  Next, 
select Enable to bring forth the list of available flight failures.  If an item has a 
check mark next to it, then that flight failure is enabled.  To disable the flight 
failure, click on it with the mouse.   

 

Cause Flight Failure- 

This feature causes a flight failure to occur.  To access this menu item, click on 
the Simulation menu, and then click on the Cause Flight Failures menu 
item.  As an alternative, press the ‘F’ key on your keyboard to cause a flight 
failure. 
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Import 
 
The Import menu item allows you to utilize, or import, content created by other users.  
There are three types of files that are associated with RealFlight G4; each will be 
covered in the section that follows. 
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KEX- 

Knife Edge Software has created a plug-in, or software module that functions 
with popular 3D modeling tools to create subject matter for the RealFlight 
software.   

The KEX importer is used to bring the model from the plug-in into the 
simulation itself. 

For more information, see: http://www.knifeedge.com/KEmax/ 

Raw Panoramic Image- 

This file type refers to the panoramic image that helps generate the PhotoField 
flying sites.  This option allows you to create a PhotoField using a panoramic 
image that you may have downloaded or created yourself.  It works best with 
large images (8000x4000) that are equirectangular, spanning 360 degrees 
horizontal by 180 degrees vertical.  Click on the Raw Panoramic Image… 
selection to import an image into the simulation.  Browse to the location of the 
image you would like to import.  The image may be either a bitmap (.bmp), 
targa (.tga) or a JPEG (.jpg) file extension.   

Once you have located the appropriate folder and desired image, double-click 
the image.  Alternatively, select this image and click Open.  The conversion 
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process can take several minutes for large images.  When the process is 
complete, G4 will automatically create a new PhotoField airport that uses your 
newly imported image. 

To edit the new PhotoField airport (for image alignment, object placement, 
etc.), access the Airport Editor.  To do so, click the Simulation menu, 
followed by the Create New Airport… menu item.  To see the image from 
the pilot’s perspective, refer to the Pilot Preview window.  This will make it 
easier to place objects and adjust the image correctly.  If necessary, adjust the 
image using the Panoramic Image Y Alignment, Panoramic Image X 
Alignment and/or the Panoramic Image Facing options located in the 
Properties window. 

RealFlight Archive (RFX, G3X)- 

RFX is the file extension that is used for all files exported from RealFlight G4.  
This menu option allows you to import an RFX file.  You will use this for all 
files that you have downloaded.  There is nothing special you need to know 
about the file beforehand; the RFX importer handles all types of content, 
including planes, color schemes, airports, PhotoFields, and recordings.   

After choosing the Import menu item followed by the RealFlight Archive 
(RFX, G3X), you will be presented with an Open file dialog.  Use this dialog to 
find the file that you want to import.  Double-click the file or click the file and 
click Open.  The import process will start immediately and once it’s finished 
you will see a message confirming its success. 

This menu item also allows you to import G3X files used in RealFlight G3 and 
G3.5. 
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Export 
 
The Export menu item allows you to share user-created content.  It is provided in the 
menu as a shortcut to using the Manage User Files dialog. 

 

G4 users may share the following items:  Color Schemes, Aircraft Variant, Entire 
Aircraft, Airport and Panoramic Images.  If one or more of these options on the list is 
grayed out, it is because the currently loaded color scheme, aircraft, or airport is part of 
the simulation by default and not available for export. 

Once any of these items are exported, you can then share them with friends or the rest 
of the RealFlight community.  The best choice is to upload the files to the RealFlight 
swap site found at: 

http://www.knifeedge.com/forums/downloads.php? 

Color Scheme- 

This option allows you to share the current aircraft color scheme (a.k.a. trim 
scheme) with other RealFlight users.  

To export a Color Scheme, select the Export menu item followed by the 
Color Scheme option.  A save dialog will appear so that you can choose 
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where you would like to save the exported color scheme and determine the 
filename.  After saving, a message will appear on-screen advising you whether 
or not the export was successful.  This message will also list the location and 
name of the file that was exported. 

Aircraft Variant- 

This option enables you to export an aircraft that has undergone structural 
modifications such as lengthened wing span, more prop thrust, different 
airfoils, etc.  It is important to note in addition to any wire frame modifications, 
the Aircraft Variant file option also includes any modifications to the aircraft 
powerplant, batteries, etc. 

To export an aircraft variant, select the Export menu item followed by the 
Aircraft Variant option.  A save dialog will appear so that you can choose 
where you would like to save the exported color scheme and determine the 
filename.  A verification message will appear on-screen advising you whether 
or not the export was successful.  This verification message will also list the 
location and name of the file that was exported. 

Entire Aircraft- 

This option enables you to export the entire contents of an aircraft such as 
trim scheme, structural changes, etc. 

To do so, select the Export menu item followed by the Entire Aircraft 
option.  A save dialog will appear so that you can choose where you would like 
to save the exported color scheme and determine the filename.  A verification 
message will appear on-screen advising you whether or not the export was 
successful.  This verification dialog will also list the location and name of the 
file that was exported. 

Airport- 

This option enables you to export a modified airport.  Note that any custom 
panoramic image you may be using with this airport will not be exported.  To 
export an airport with a custom panoramic image, use the “Airport (include 
Panoramic Image)” option. 

To export an airport, select the Export menu item followed by the Airport 
option.  A save dialog will appear so that you can choose where you would like 
to save the exported color scheme and determine the filename.  After saving, a 
verification message will appear on-screen advising you whether or not the 
export was successful.  This verification message will also list the location and 
name of the file that was exported.  
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Airport (include Panoramic Image)- 

This option enables you to export an airport along with its custom panoramic 
image.  To do so, select the Export menu item followed by the Airport 
(include Panoramic Image) option.  A save dialog will appear so that you 
can choose where you want to export the airport and what you want to name 
the file.  A verification message will appear on-screen advising you whether or 
not the export was successful.  This verification message will also list the 
location and name of the file that was exported. You may then upload the 
exported file to a web site for others to enjoy. 

 

Manage User Files 
 
The Manage User Files menu item allows you to modify the new user content that you 
have added to the simulation.  You will find that the Manage User Files menu item is a 
handy tool as it maintains all such files in one, easy to find location. 

 

The Manage User Files dialog allows you to copy, rename, delete, or export 
any custom resource that exists in the simulation.  It is important to note that 
the various Manage User Files buttons will be inactive until a modification to 
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one of the files exists.  That is, this menu item is only utilized to modify user-
created items.  It will not allow you to modify the airports or vehicles included 
in the RealFlight Generation 4 software. 

Copy- 

This option duplicates the information and data pertaining to the currently 
selected item.  If, for example, you wish to duplicate a flying site located in the 
User Files, click the Copy button.  

Once you have copied the file, enter a name for the new item.  Using our 
previous example, simply rename the flying site as desired.  This new name will 
then be used in the Select Airport dialog.   

Rename- 

This option is utilized to rename a user-created item.   

To do so, highlight the desired item (flying site, etc.) and click Rename.  Enter 
the desired name for the item in the dialog provided.    The item will now 
appear in its respective list of offerings with the new name.   

Delete- 

This option is utilized to delete an item entirely.  All files associated with the 
item will be removed from your computer. 

Again, it is important to note that users are only allowed to delete items which 
they, or other users, have created.  That is, you are not allowed to delete default 
items that are included with the software. 

To delete a user-created item, select the item in the User File menus and click 
Delete.  If you wish to delete this item, click Yes in the verification dialog.  
Please note: once deleted this resource will no longer be available in the 
simulation.   

Export- 

This button is used to Export, or place the airport/aircraft/recording in a 
location so that the user may share it with others.  If you have created 
interesting or unusual content, we encourage you to share your designs with 
other RealFlight users.  The more content that is shared the more enjoyment 
everyone will experience. 

To export a user-created item, select the respective item in the User File menus 
and click Export.  A verification dialog will appear on-screen advising you 
whether or not the export was successful and the location and name of the file 
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that was exported.  You may upload the exported file to a web site, move it to 
another computer, or email it for others to enjoy. 

 

Settings 
 
The Settings options are an integral part of the G4 software.  This menu item allows 
you to adjust a multitude of features and functions within the simulation. 

 

To access this menu item, click on the Simulation menu followed by the Settings… 
menu item.  The Settings dialog will appear, showing the available options. 
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The Settings that are available to you are as follows: 

• Audio 

• Camera 

• Console 

• Flight Failures 

• Graphics 

• Multiplayer 

• Physics 

• Wind and Weather 

Audio- 

Audio settings are split into two different categories which are as follows.  Double-click 
on the Audio name, or click on the [+] (plus) to expand the list and show the Audio 
options. 
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Application- 
 The Application section controls the sound over the entire simulator. 

 

• Volume (%) - This setting adjusts the master volume level for the entire 
simulator. 

• Sound Enabled - Choosing No for this option will mute all sounds for the 
simulator. 

Sounds- 

The Sound settings control the various options related to the miscellaneous 
sounds within the simulation.  RealFlight allows you to make modifications to 
the various sounds based upon your preferences. 
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For each type of sound that is adjustable, there are two parameters that can be 
changed.  First is the Volume, which is a percentage of the overall volume.  
The second is whether the sound should be enabled or muted. 

The different sound types are: 

• Aircraft – affects aircraft related sounds such as servos. 

• Airport – affects the ambient sounds around the airport. 

• Collision – adjust these to affect the crashing sounds associated with 
collisions. 

• Effects – this represents the miscellaneous sounds that don’t fit into 
any other category. 

• Engine – adjust this to affect the motor and engine sounds. 

• Voiceover – these parameters adjust the voiceovers used for the 
Virtual Flight Instructions. 

• Walk – adjusts this to control the walking sound when moving the 
camera angle. 
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• Wind – this affects the sound produced by the wind. 

Camera- 

The camera options available to you are designed to enhance the field of view when 
utilizing the Keep Ground in View zoom mode.  For additional information on this 
option, please refer to the View menu section of this manual. 

 

Minimum Field of View (deg)- 

This setting determines the absolute minimum field of view when utilizing the 
Keep Ground in View zoom option. 

To adjust the minimum field of view, click the existing value.  Next, enter the 
desired value either directly from the keyboard or via the mouse wheel. 

Camera Lag (%)- 

This controls how quickly the camera reacts to the aircraft’s movements.  If 
the lag is set to zero, the camera always looks directly at the aircraft.  At all 
other values, the camera will have a spring-like reaction to the aircraft during 
flight. 

At very high values, the camera hardly ever looks directly at the aircraft, and 
often the aircraft will fly off the screen as the camera tries to catch up.  At 
lower values, the effect is very subtle and yet still softens the camera movement 
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enough so that minor changes in the aircraft’s speed/position are more 
noticeable. 

Please note:  these settings apply to fixed view cameras only.  They are not 
applicable to the cockpit or chase views. 

Console- 

The Console option has a number of sub-categories that allow you to perform 
modifications to the messages that appear on-screen while running the simulator.  It 
also offers two parameters that affect all the sub-categories. 

 

Show At Most- 

This numerical value indicates the maximum number of messages that will 
appear on your screen at any given time.  When the maximum number is 
surpassed, an older message will be removed and the most recent message will 
take its place on-screen. 

To adjust the number of messages displayed on-screen at one time, click on 
the value as indicated in the column to the right of the Show At Most 
indicator.  Input the desired value directly from the keyboard or use the mouse 
wheel. 
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Clear on Reset- 

This setting controls whether all the on-screen messages are cleared when the 
aircraft resets.  This prevents the screen from becoming overly cluttered with 
messages and information. 

Using either the up/down arrow keys on the keyboard, or the mouse, select 
either Yes (messages automatically clear) or No (messages remain on-screen 
after a reset) from the pull-down listings.  If using the up/down arrow keys, 
press Enter to finalize your selection. 

Double-clicking on the Console name or clicking on the [+] (plus) will bring forth 
the following options: 

• Instructions 

• Notifications 

• Warnings 

• Errors 

• Chat Messages (Sent) 

• Chat messages (Received) 

• Commands 

Each of the System Messages screens is independently adjustable and may be tailored 
to suit your personal preferences.  For information on how to do so, please read the 
following section. 

Instructions- 

As the name suggests, modifications will affect only the System Instructions. 
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Font Size- 

This option allows you to adjust the font size for the messages 
pertaining to the instructions.  Please note:  this only affects the 
Instructions.  It does not affect any other system messages. 

To access the Font Size options, click on the value shown in the 
respective column.  The desired values may be input directly from the 
keyboard or modified using the mouse wheel. 

Foreground Color- 

This option allows the user to adjust the color of the foreground for 
the Instructions messages. 

To access the options pertaining to the foreground color, click on the 
current value.  Click the more options button (the gray folder with 
the ellipsis) to bring forth the palette of available colors.  This will 
reveal a screen that appears as follows: 
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To select a color, click the desired color on the palette.  If you wish to 
make a custom color, click the Define Custom Colors button and 
create the color or colors to suit your tastes.  Click OK to finalize the 
selection.  The selected color will be reflected immediately in the value 
column. 

Background Color- 

As with the Foreground Color, this setting allows the user to adjust the 
color of the background for the Instructions messages. 

To access the options pertaining to the background color, click on the 
current displayed color. 

Click the more options button (the gray folder with the ellipsis) to 
bring forth the palette of available colors.  To select a color, click the 
desired color on the palette.  If you wish to make a custom color, 
click the Define Custom Colors button and create the color or colors 
to suit your tastes.  Click OK to finalize the selection.  The selected 
color will be reflected immediately in the value column. 

Background Alpha (%)- 

This option adjusts the transparency of the text background for the 
message. 
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The desired values may be input directly from the keyboard or 
modified using the mouse wheel.  The higher the value, the more 
transparent the text background will become. 

Message Duration (sec)- 

This option adjusts the length of time that a message remains on-
screen before it disappears. 

You may input desired values directly from the keyboard or modify 
them using the mouse wheel.  Of course, the higher the value, the 
longer the message remains on-screen. 

Enabled- 

This option determines whether Instructions messages are displayed or 
not. 

To determine whether this is enabled, click on the respective value 
indicator.  Using either the up/down arrow keys on the keyboard, or 
the mouse, select either Yes (Instructions messages are enabled) or 
No (Instructions messages are disabled) from the pull-down listings. If 
using the up/down arrow keys, press Enter to finalize your selection. 

Notifications- 

To select the Notifications options, click on the Notifications name.  These 
options function in the same manner as the options for the Instructions 
messages, except that they only affect Notification messages. 
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Warnings- 

This option determines the settings for the system warning messages. 

 

To select the Warnings options, click on the Warnings name.  These options 
function in the same manner as the options for the Instructions messages, 
except that they only affect Warning messages. 
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Errors- 

This option allows you to modify the behavior of system error messages. 

 

To select the Errors options, click on the Errors name.  These options 
function in the same manner as the options for the Instructions messages, 
except that they only affect Error messages. 
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Chat Messages (Sent)- 

This option allows you to modify the appearance of text that you type for chat 
messages during multiplayer sessions. 

 

To select the Chat Messages (Sent) options, click on the Chat Messages (Sent) 
name.  These options function in the same manner as the options for the 
Instructions messages, except that they only affect Chat Messages (Sent) 
messages. 
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Chat Messages (Received)- 

This option allows you to modify the appearance of text that you receive from 
other players during multiplayer sessions. 

 

To select the Chat Messages (Received) options, click on the Chat Messages 
(Received) name.  These options function in the same way as the options for 
the Instructions messages, except that they only affect Chat Messages 
(Received) messages. 

There is one additional parameter available for this option called Play Sound.  
This allows you to set whether a sound is heard when an incoming chat 
messages arrives. 
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Commands- 

This option allows you to modify the appearance of commands typed in the 
console screen. 

 

To select the Commands options, click on the Commands name.  These 
options function in the same manner as the options for the Instructions 
messages, except that they only affect Commands messages. 
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Flight Failures- 
To adjust the Probability options or the Notify When settings, click on the Flight 
Failures root directory. 

 

Double-click on the Flight Failures name or click on the [+] (plus) to expand the list 
and show the Flight Failures options.  RealFlight defaults all Flight Failures to enabled 
(active).  Each item may be enabled or disabled individually.  To disable a specific flight 
failure, click on the respective failure located within the pull-down list.  Next, click on 
the Yes value as indicated in the value column.  This brings forth the Yes/No pull-
down list.  To disable the respective failure, simply choose the No option.  For 
example, to disable the Reverse Servo flight failure: 

1. Select the Reverse Servo option in the Flight Failures sub-menu  

2. Click the Yes in the right hand pane 

3. Select No from the pull-down list 

Probability- 
To adjust the frequency of occurrence, click on the value as indicated in the 
column to the right of the probability indicator. 

If you do not wish to experience any flight failures, select the Never option in 
the drop-down menu.  Conversely, if you wish to gain a great deal of 
experience at handling emergencies, click the Always option. 



 

 92 

Notify When- 
This setting allows you to determine if, or when, RealFlight notifies you as to 
the flight failure experienced. 

To adjust the settings of this feature, click on the value as indicated in the 
column to the right of the Notify When indicator.  Your options are: 

After Flight - RealFlight will advise you as to the flight failure experienced 
upon the completion of the flight. 

Before Flight - RealFlight will tell you which flight failure you are about to 
experience before the flight begins. 

Never - RealFlight G4 will never advise you as to the flight failure that you 
have experienced, or are about to experience.  A little mystery is a good thing. 

On Failure - RealFlight will tell you about the flight failure just as it occurs. 

The different Flight Failures available in RealFlight G4 are as follows: 

• Reverse Servo - The travel direction of one of your servos is reversed. 

• Kill Engine - The engine will fail or quit in flight, which means that you will have 
to perform a deadstick landing or autorotation. 

• Servo Stuck - A servo will become fixed, or stuck, in a certain position. 

• Servo Trim - A servo alters the trim settings, modifying the flight control position. 

• Channel Swap - This failure simulates the effect of inadvertently swapping two 
channels.  As an example, you may find that your rudder controls the throttle, and 
vice versa. 

• Radio Lockout (PCM) - The receiver will experience intermittent radio dropouts 
during which time the aircraft will fail to respond to control inputs. 

• Radio Interference (FM) - The receiver will experience intermittent radio 
interference during which time the servos will behave erratically. 

• Radio Range - The receiver will experience interference proportional to the 
distance between the pilot and the aircraft.  If the aircraft is close to the pilot’s 
position, the range problems will be minimal, increasing as the aircraft gets farther 
away. 



 

 93 

• Reverse Channel - One of the channels, selected at random, will operate in reverse 
direction. 

• Structural Integrity – This failure determines how strong the aircraft is and if parts 
could break off during flight.  This failure also has a parameter called Allow 
Multiple Failures which allows this flight failure to be triggered more than once 
during a flight. 

Graphics- 
Double-click on the Graphics name or click on the [+] (plus) to expand the menu 
and display the various Graphics options available to you. 

Quality Options- 
The Quality options are quite useful in fine-tuning your simulator to ensure 
that it runs as efficiently and realistically as possible on your PC.  Use the 
settings in the Graphics options to obtain the perfect blend of optimal visuals 
and performance from your PC.  If you are experiencing slow frame rates or 
other performance issues, it may be prudent to turn down some graphics 
quality options. 

 

Note that many of the adjustments will not take place immediately.  In many 
cases, you will need to restart the simulator in order for the option to take 
effect. 
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Clouds- 
This option determines whether your flying sites will include clouds in 
the skyline. 

Click on the respective value indicator.  From the pull-down options 
select either Yes (clouds will be present) or No (clouds will not be 
present). 

Particles- 
This option determines whether RealFlight will utilize particles such as 
engine smoke. 

Click on the respective value indicator.  From the pull-down options 
select either Yes (G4 will display smoke) or No (G4 will not display 
smoke). 

Scenery Objects- 
This option determines whether the simulation displays background 
objects such as buildings, rocks, benches, etc.  If Yes is selected, the 
background objects will be present.  If No, the background objects will 
not appear in the simulation. 

To change this setting, first click on the respective value indicator.  
From the pull-down options select either Yes or No. 

Shadows Enabled- 
The Shadows option determines whether the simulation displays 
shadows. 

To change the Shadows setting, click the value located to the right of 
the Shadows name.  Next, click Yes to display the shadows or No to 
eliminate shadows from the simulation. 

Terrain Detail- 
This option determines whether or not RealFlight G4 displays the 
details found in the textures.  Modify the Terrain Detail setting by 
clicking on the value located to the right of the Terrain Detail name.  
Click Yes to display the terrain detail texture or No to eliminate the 
terrain details. 

Trees- 
The Trees setting determines whether RealFlight G4 display trees.  To 
change the Trees setting, click the value located to the right of the 
Trees.  Select No if you do not wish to display the trees in your 
simulation.  If you wish to view the trees during flight, select Yes. 
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Please note:  the display of trees does have an effect on the frame rate 
of your simulation. 

Wind Field Indicators- 
This parameter determines whether or not RealFlight displays the 
wind field indicators that are present at select airports. 

Post-processing: Bloom- 
The Bloom effect will cause lighter colors or lights to bleed into 
neighboring parts, enhancing their perceived brightness. 

Please note:  the Bloom effect does have an effect on the frame rate of 
your simulation. 

Post-processing: Night Flying Glow- 
This option affects whether lights for night flying glow, causing the 
objects to appear brighter. 

Please note:  the Night Flying Glow effect does have an effect on the 
frame rate of your simulation. 

Foliage Density (%)- 
This setting determines the density and drawing time of the trees and 
the grass.  Lowering the percentage will ensure that the scenery is 
drawn faster.  Again, if you are experiencing low frame rates, lowering 
this value will speed up the simulation. 

To adjust the percentage, click on the value located to the right of the 
Foliage Density (%) name.  Enter the desired input directly from your 
keyboard, or use the mouse wheel. 

Optimize Shadows- 
This parameter will allow shadows to be rendered faster, increasing the 
frame rate, if your video card allows it.  If you see problems such as 
flickering with shadows, try disabling this option. 

Water Quality- 
This setting specifies the quality of the water in the simulation.  
RealFlight G4 attempts to automatically optimize the settings for your 
PC.  However, it may be necessary for you to perform some manual 
fine-tuning in order to obtain the best possible performance. 

To modify the quality of the water, click on the value indicated in the 
column to the right of the Water name.  Select the desired level for 
your simulation from the pull-down list.  The Highest setting will 
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render the best water, but it requires additional processing power.  If 
your frame rate is low, we suggest you reduce the water quality.  

Shadow Quality- 
This setting specifies the quality of the shadows in the simulation.  
RealFlight G4 attempts to automatically optimize the settings for your 
PC.  However, it may be necessary for you to perform some manual 
fine-tuning in order to obtain the best possible performance. 

To modify the quality of the shadows, click on the value indicated in 
the column to the right of the Shadows name.  Select the desired level 
for your simulation from the pull-down list.  The Highest setting will 
render the best shadows, but it requires additional processing power.  
If your frame rate is low, we suggest you reduce the shadow quality. 

Particle Quality- 
This setting adjusts the quality of the smoke, debris and other small 
objects during the simulation.  If the frame rate drops when the smoke 
is thick, try lowering the quality of the smoke until you achieve an 
acceptable frame rate. 

To do so, click on the existing particle quality.  Next, from the pull-
down menu, select the desired quality level. 

Streamer Quality- 
This setting adjusts the quality of the streamers during the simulation.  
If the frame rate drops when flying an aircraft with streamers, try 
lowering the quality of the streamers until you achieve an acceptable 
frame rate. 

To do so, click on the existing streamer quality level.  Next, from the 
pull-down menu, select the desired quality level. 

Texture Quality- 
Use this setting to add the realistic textures to the items and various 
other objects found in the simulation. 

To do so, click on the existing texture quality level.  Next, from the 
pull-down menu, select the desired quality option. 

Please note: you must restart the simulation for the new setting to take 
effect.  

Misc. Graphics Quality- 
This setting adjusts the quality level of miscellaneous items in your 
simulation. 
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To alter the Miscellaneous Graphics level, click on the value located to 
the right of the Misc. Graphics name.  Next, select the desired level to 
utilize for the graphics.  

Please note: you must restart the simulation for the new setting to take 
effect. 

Brightness (%)- 
This setting adjusts the brightness of the ambient lighting found in the 
simulation.  If dark colors appear to be overly dark, increase the 
brightness percentage. 

To adjust the brightness percentage, click on the current brightness 
percentage.  Enter the desired value directly from the keyboard or use 
the mouse wheel. 

Contrast (%)- 
The contrast percentage brightens the lighter colored items in the 
simulation.  It does not affect the darker items in the simulation. 

To adjust the contrast percentage, click on the contrast percentage.  
Enter the desired value directly from the keyboard or use the mouse 
wheel. 
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Hardware- 
The Hardware settings are used to adjust the non-software settings to achieve 
the best possible simulation for your PC. 

 

Graphics Adapter- 
The Graphics Adapter is the device that RealFlight utilizes to run the 
simulation, generically referred to as a video card.  Most PC’s have 
only one video card; however, some PC’s are equipped with multiple 
cards. 

To determine if your PC has an additional video card available to you, 
click on the video card information located in the values column to the 
right of the Graphics Adapter name.  If multiple cards appear in the 
drop-down selection there is another option for you.  If not, your PC 
is equipped with only one video card. 

Graphics Device- 
Some video cards offer multiple devices.  HAL (Hardware Abstraction 
Layer) is the preferred device to use for the graphics rendering.  In 
general, you should never need to modify this setting. 

To determine if your PC offers alternative devices, click on the value 
indicated in the column to the right of the Graphics Device name. 
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Full Screen- 
This option determines whether RealFlight will run using the entire 
monitor screen for the simulation.  If you decide to run in the Full 
Screen mode, RealFlight’s menus will not appear on the screen. 

To access the menu while in Full Screen mode, press either the ESC 
key or the ALT key on the keyboard. 

To adjust the Full Screen option, click on the value as indicate in the 
column to the right of the Full Screen name.  From the pull-down 
menu, select Yes to run in Full Screen or No to run in the Windowed 
mode. 

Alternatively, you may access the Full Screen mode by pressing the Alt 
and Enter keys simultaneously on the keyboard.  To exit Full Screen 
mode, press the ALT and Enter keys simultaneously. 

Resolution- 
This control adjusts the screen resolution and color depth.  If your 
frame rate is unacceptably low, you can improve it by reducing the 
resolution or color depth.  This will reduce some of the rendering 
processes required of your video card. 

To adjust the resolution for your simulation, click the value indicated 
in the column to the right of the Resolution name.  Select the desired 
level for your simulation from the drop-down list. 

Please note:  this option is only effective when using RealFlight in the 
Full Screen mode.  

We suggest that you test a variety of resolutions and color options to 
achieve the optimum performance and setup for your system. 

Refresh Rate- 
The refresh rate is the number of times per second that your monitor 
retraces its video display.  Your video hardware (monitor and graphics 
card) dictates what refresh rates you are able to utilize in the 
simulation.  As with Resolution, this option is only effective when 
running RealFlight in the Full Screen mode. 

To adjust the refresh rate, click the value that is indicated in the 
column to the right of the Refresh Rate name.  If there are multiple 
options in this list, you might opt for a lower value to determine if this 
improves the frame rate of your simulation. 
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Vertical Sync- 
This option dictates where the monitor will draw the next vertical line.  
Activating Vertical Synchronization slows the simulation slightly, but it 
prevents the ‘tearing’ of on-screen images. 

To adjust the Vertical Sync, click the respective value.  Select Yes or 
No from the pull-down menu that appears. 

Multiplayer- 
Settings available here affect multiplayer parameters, either in split screen MultiMode, 
or over the internet. 

 

Pilot Name- 
This setting allows you to enter a name for the multiplayer sessions.  To do so, 
click on the value that appears to the right of the Pilot Name column.  Click 
the more options button (the gray folder with the ellipsis).  Enter a name of 
your choosing.  When satisfied, press the Enter button on your keyboard. 

Please note:  when participating in a multiplayer session, other players may be 
able to view the name you have selected. 

MultiMode Screen Layout- 
This setting specifies the layout of the screen for the MultiMode option.  If you 
select Vertical, the computer screen will split in half on its vertical axis.  If you 
select Horizontal, the computer screen will split in half on the horizontal axis. 
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To select which mode best suits your tastes, click on the value displayed to the 
right of the MultiMode Screen Layout column.  Next, select either Horizontal 
or Vertical from the pull-down options. 

Collisions- 
The Collisions options allow you to enable or disable the collisions between 
aircraft in Multiplayer sessions.  If you are connected via dialup, or have a slow 
network connection, Select No as this may speed up the performance of the 
simulator. 

Physics- 
The physics options are quite useful in fine-tuning the items applicable to the physics 
of your simulated aircraft. 

 

Airplane Physics Quality- 
This setting determines the detail level of physics utilized for the airplanes in 
the simulation.  When the physics level is adjusted to the highest setting, the 
simulation performs the aircraft calculations more accurately and more 
frequently.  Unless you are running the simulation on an older, slower PC, we 
suggest using either the ‘high’ or ‘highest’ settings.  Lowering the physics level 
will reduce the quality and detail level used in the simulation, thereby allowing 
the simulation to run at a faster rate for slower PC’s. 

To alter the physics options, click on the value indicated in the column to the 
right of the Airplane Physics Quality name.  Using either the up/down arrow 
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keys on the keyboard, or the mouse, select the level for your simulation from 
the pull-down list.  If using the up/down arrow keys, press Enter to finalize 
your selection. 

Helicopter Physics Quality- 
This setting determines the detail level of physics utilized for the helicopters in 
the simulation.  When the physics level is adjusted to the highest setting, the 
simulation performs the aircraft calculations more accurately and more 
frequently.  Unless you are running the simulation on an older, slower PC, we 
suggest using either the ‘high’ or ‘highest’ settings.  Lowering the physics level 
will reduce the quality and detail level used in the simulation, thereby allowing 
the simulation to run at a faster rate for slower PC’s. 

To lower the physics option, click on the value indicated in the column to the 
right of the Helicopter Physics Quality name.  Using either the up/down arrow 
keys on the keyboard, or the mouse, select the level for your simulation from 
the drop-down list.  If using the up/down arrow keys, press Enter to finalize 
your selection. 

Unlimited Fuel- 
This option determines whether or not your aircraft will run out of fuel.  If you 
select Yes, the engine will run indefinitely – assuming, of course, that you do 
not crash.  If you select No, the aircraft will indeed run out of fuel.  The length 
of time required to do so is based upon a number of factors including the 
engine utilized and throttle management, just as it would at the flying field. 

To determine whether your aircraft will run out of fuel, click on the value 
column to the right of the Unlimited Fuel option.  Using either the up/down 
arrow keys on the keyboard, or the mouse, select either Yes or No from the 
pull-down listings. If using the up/down arrow keys, press Enter to finalize 
your selection. 

Use Metric Units- 
This option determines the unit of measurement for the various displays found 
in the simulation.  RealFlight defaults to display measurement in SAE units.  
You can easily change this to use metric units. 

To do so, click on the value column to the right of the Use Metric Units name.  
Using either the up/down arrow keys on the keyboard, or the mouse, select 
either Yes or No from the pull-down listings. If using the up/down arrow 
keys, press Enter to finalize your selection. 

Physics Speed- 
Expressed as a percentage, this value controls the time scale of the simulation.  
Reducing the value allows you to create a slow-motion effect.  This is useful 
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when learning new skills or maneuvers, as you may slow the aircraft’s reaction 
time. 

It is important to note that these adjustments do not affect RealFlight during 
multiplayer sessions or events. 

To adjust the Physics Speed, click the value.  Enter the desired value directly 
from the keyboard or use the mouse wheel. 

Automatic Reset Delay (sec)- 
This setting will force RealFlight to automatically reset the aircraft after a crash 
where a piece of the aircraft has broken off. 

To adjust the Reset Delay, click the respective value.  Enter the desired value 
directly from the keyboard or use the mouse wheel. 

Wind and Weather- 
The wind and weather options control the atmospheric conditions encountered in the 
simulation.  You can adjust these to match the conditions typically found at your local 
flying site. 

Global Wind- 
These options determine the global wind conditions for the current airport.  
Please note:  the adjustments made here will temporarily override the airport’s 
default values.  Upon selecting an alternative airport or closing RealFlight, the 
default values will be restored. 
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Wind Direction (deg)- 
To adjust the wind direction, click on the value indicated to the right 
of the Wind Direction name.  Next, input a numerical value between 0 
and 359 degrees to modify the wind direction.  Alternatively, the 
mouse wheel may be used to alter the input value. 

You may also adjust the wind direction from the keyboard.  Press the 
Home key to increase the wind direction.  The End key will reduce the 
direction of the wind. 

The direction that the wind comes from is expressed in degrees; where 
0 is north, 90 is east, 180 is south and 270 is west.  It is also possible to 
adjust the wind direction to any angle in-between. 

Wind Velocity (MPH)- 
This setting adjusts the average winds that prevail over the entire 
simulation.  The velocity here is the speed of the wind approximately 
6.5 feet (2 meters) above the terrain.  RealFlight G4’s wind gradient 
ensures that the wind below this level is slightly slower and that the 
wind at higher altitudes is faster. 

To adjust the wind velocity, click on the value indicated to the right of 
the Wind Velocity (MPH) name.  Next, input a numerical value 
between 0 and 50, using either your keyboard or the mouse wheel.  
This will be the wind speed in MPH. 
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You may also increase/decrease the wind velocity in smaller 
increments by pressing the Page Up/Page Down keys on the 
keyboard. 

Wind Variation (%)- 
This adjustment represents the variation in the wind speed and 
direction in relation to the average speed.  Just as the winds that you 
experience at the local field are not constant, neither are the winds in 
RealFlight. 

To adjust this variable, click on the value indicated to the right of the 
Wind Variation (%).  Using either your keyboard or the mouse wheel, 
input a numerical value between 0 (unchanging) and 200.  A higher 
value produces more dramatic changes in the wind. 

Wind Gust (%)- 
This value represents the change of the wind speed and direction 
corresponding to a proportion of the wind speed it calculates in one 
second. 

To adjust this variable, click on the value indicated to the right of the 
Wind Gust (%).  Using either your keyboard or the mouse wheel, 
input a numerical value between 0 (no changes) and 100 (large 
changes). 

Turbulence System- 
RealFlight’s wind model is so authentic that it even recreates the turbulence 
which your aircraft will experience when out at the field. 
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Turbulent Layer Height- 
Use this setting to mimic the turbulence level at your local flying site.  
This setting represents the maximum height above the ground at 
which your aircraft will experience the effects of G4’s turbulent winds. 

To adjust the Turbulent Layer Height settings, click on the value 
indicated in the column to the right of this respective option.  The 
desired values may be input directly from the keyboard or modified 
using the mouse wheel. 

Turbulence Strength Proportion (%)- 
This option allows you to adjust the strength of the medium-level 
turbulence.  Since this setting represents a median, some turbulence 
will be more severe than this, and some turbulence will be less 
noticeable. 

To adjust the Turbulence Strength Proportion (%) settings, click on 
the value indicated in the column to the right of this respective option.  
The desired values may be input directly from the keyboard or 
modified using the mouse wheel.  A value of 0% indicates that there 
will not be any mid-level turbulence. 
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Micro-Turbulence Strength Proportion (%)- 
This option allows you to adjust the strength of the lower level 
turbulence.  Some turbulence will be more severe.  This is the lowest 
level of turbulence that you will experience, however. 

To adjust the Micro-Turbulence Strength Proportion (%) settings, 
click on the value indicated in the column to the right of this respective 
option.  The desired values may be input directly from the keyboard or 
modified using the mouse wheel.  A value of 0% indicates that no 
micro-turbulence will occur. 

 

Exit 
 
Use this menu item to exit the program entirely. 
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Airport MRU 
 
If you have previously selected an alternative flying location, or locations, you will note 
that it will appear on a list in the Simulation menu.  This list is at the very bottom of the 
menu and is commonly referred to as a Most Recently Used, or MRU list.  It is limited 
to the eight most recently selected locations.  If you wish to fly at one of these locations 
simply click on the respective location and it will begin loading. 
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The Aircraft Menu 
Offers access to a variety of  aircraft related features, functions and options. 

licking the Aircraft menu brings forth a pull-down menu similar to the 
following screen shot. 

 

 

The menu items that are available from the Aircraft menu include: 

• Select Aircraft… 
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• Edit Current Aircraft… 

• Select Color Scheme 

• Save Color Scheme As… 

• Remember Aircraft Position 

• Clear Aircraft Position 

• Reset Position 

• Kill Engine 

• Aircraft MRU 

The following sections describe the function and purpose of each of these menu items. 
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Aircraft Selection… 
 
When you click on Select Aircraft… the following dialog appears: 

 

This dialog allows you to select the aircraft that you wish to fly. 

Change aircraft simply by using the InterLink Elite.  Press the 
Menu/Select button, then, with the airplane tab highlighted press 
the Menu/Select button again.  This will bring up the Select 
Aircraft dialog window.  You can continue using the QuickSelect 
buttons in this dialog to select a new aircraft, or press Reset to 
resume flying without making any changes. 

The list on the left of the dialog box displays all of the aircraft available to you.  If you 
have created any customized aircraft, they will also appear in this list. 

By default, the aircraft are listed in files and directories in accordance with the software 
from which they were loaded.  If, for example, you have installed Expansion Pack 2, 
the aircraft from this disc will be listed, alphabetically, beneath the Expansion Pack 2 
directory. 
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Click the [+] (plus) or [-] (minus) symbol to reveal or hide the aircraft within these 
directories and folders. 

Aircraft Selection 
Every aircraft has its own unique flying characteristics, special features and functions.  
To view an aircraft from the listings, simply use the mouse to click on the aircraft 
name.  Alternatively, use the up/down keys on the keyboard to scroll through the list, 
one aircraft at a time. 

The first time an aircraft is selected, G4 creates a collision mesh for the aircraft.  This 
process may take a few seconds to complete.  A progress bar will appear while the 
collision mesh is being calculated. 

Click the [+] (plus) symbol to reveal the aircraft contained within the folder.  Using 
either the up/down arrow keys on the keyboard or the mouse, select the desired 
aircraft from the listings.  If utilizing the up/down arrow keys, click OK to finalize your 
selection.  Alternatively, if using the mouse, double-click on the aircraft to load it. 

Have some fun while you’re in the Select Aircraft dialog.  Using the mouse, click and 
drag the preview screen to point the camera angle to your choosing.  Use the scroll 
wheel to zoom in or out.  Or, move the gimbals to see the control surfaces move. To 
resume rotating automatically, right-click the preview screen. 

Description/Specifications- 
The pane below the Aircraft Preview box shows either the aircraft description or 
aircraft specifications.  This box provides you with a brief history of the aircraft (if 
applicable) and serves to provide you with specific information pertaining to the model 
selected. 

Using the mouse, select either the Description or Specifications tab. 

Grouping- 
This list controls how the dialog organizes the list of available aircraft.  By default, the 
aircraft are sorted by Product.  Here is an explanation of the different sorting methods: 

Product, Airframe: Aircraft are grouped first by which product they are found in (all 
custom aircraft will be in the “Custom Aircraft” folder).  Within each product, the 
aircraft are further grouped by airframe.  For example, “NextSTAR” and “NextSTAR 
with AFS” are both found in the NexSTAR airframe folder.   

Product: Aircraft are grouped by product alone.   

Airframe: Aircraft are grouped by airframe, not by product.  Individual aircraft are 
grouped inside each airframe folder. 

None: There is no grouping at all.  All aircraft are sorted alphabetically. 
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Color Scheme- 
If applicable, this list contains the alternative trim schemes for the selected model.  If 
the Color Scheme dialog is grayed out, there are no alternative trim schemes available 
for this particular aircraft. 

If the list control is active, click on the down arrow to reveal the alternate trim 
scheme(s).  To select an alternate trim scheme, use either the up/down arrow keys on 
the keyboard or select one with the mouse.  When an alternative trim scheme is 
selected, this scheme will appear immediately in the ReadySelect preview box, replacing 
the previous trim scheme. 

Additionally, modelers may create their own trim schemes in RealFlight using a third-
party bitmap editor capable of manipulating Targa (*.tga) files.  Please see the section 
titled “Save Color Scheme As….”. 

 

Edit Current Aircraft 
 
RealFlight G4 offers the user unparalleled freedom to edit or modify their aircraft.  It’s 
possible to add and remove components, alter their location, change airfoils and much, 
much more!  The first several times that you access the aircraft editor, the task might 
seem daunting.  It may require some getting used to before you are comfortable with 
this feature and its related functions.  The best way to do so is to simply dive in and 
experiment. 

To modify the currently selected aircraft, click the Aircraft menu followed by the Edit 
Current Aircraft menu item.  This brings up the Aircraft Editor dialog, which will 
allow you to modify any of the hundreds of parameters for the currently selected 
aircraft. 
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The Aircraft Editor dialog will have an appearance similar to the screen shot shown 
below.  It may deviate slightly depending upon the type of aircraft that you are editing 
(i.e., biplane, electric model, etc.).  However, all aircraft are edited in a similar manner.  
As such, this section presents you with the general information necessary to edit any 
aircraft found in G4. 

Aircraft Editor Menus- 
Selecting the Edit Current Aircraft option activates the screen shown above.  The 
Aircraft Editor dialog has four menu options: 

• File 

• Edit 

• Options 

• View 

File Menu- 
This menu and its menu items are used to manipulate and control the various 
folders and related items in the aircraft editor. 
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Open…- 
This menu item is used to open existing and edited aircraft.  Selecting 
this menu item opens the Select Aircraft dialog.  To select an aircraft 
from this list, follow the procedure described in the Aircraft Selection 
section of this manual. 

Save- 
This option becomes active once you have renamed and saved the 
edited aircraft.  Prior to doing so this option will remain inactive or 
grayed out.  This allows you to make further modifications to the 
aircraft without renaming it each time. 

Save As…- 
Upon completion of the aircraft editing, click this menu item to 
rename and save the modifications.  You will be asked to create a 
name for this new aircraft.  After you have renamed the aircraft, click 
OK to accept the new name.  Afterwards, the aircraft will appear in 
the aircraft listings found in the Select Aircraft… in the Aircraft menu. 
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Revert- 
This menu item allows you to revert, or go back to the settings the last 
time that the aircraft was saved.  If you have not previously saved the 
aircraft, the aircraft will return to the default settings. 

To use this menu item, open the File menu and click Revert.  This 
will bring forth the verification dialog. 

Click Yes if you wish to return to the last saved version of this model.  
Please note: any modifications performed after the last time that this 
model was saved will be lost.  Clicking No will allow you to save the 
modifications or continue refining the aircraft. 

Exit to Simulator- 
This menu item returns you to the simulation.  If you have performed 
any modifications to the aircraft and have not saved these 
modifications, a verification dialog will appear.  Choose Yes to save 
the modifications.  If you select No, the modifications will be lost.  
Selecting Cancel will return you to the editing dialog. 

Edit Menu- 
As is suggested by the name, this menu is utilized to edit the aircraft.  The 
available options depend upon which item or folder is highlighted in the 
directory.  If you have not highlighted an item or folder, the Edit menu will 
remain grayed out or inactive. 
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For example, if the aircraft name is highlighted and the Edit menu is selected, 
there will not be any actions available to you.  If the airframe is highlighted, the 
aircraft editor will allow you to add various components to the airframe. 

Alternatively, if you wish to either add or remove an item from one of the 
aircraft components, right-click on the respective component.  This will bring 
forth the available options. 

When editing aircraft, you can click and drag the mouse in the preview area to 
rotate the aircraft to different angles.  This helps to better see components you 
might be modifying.   

Options Menu- 
This menu provides you with a number of choices, or options, available to you 
for use in the aircraft editor. 

Selecting the Options menu brings forth the drop-down menu items discussed 
below. 
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Play Engine Sounds- 
Selecting this menu item plays the respective engine sounds during the 
editing of this aircraft.  Please note:  this setting is only temporary.  
That is, this setting is not retained after you exit the aircraft editor. 

To select this option, click the Play Engine Sounds menu item.  This 
will place a check mark before the setting and return to the aircraft 
editor.  Additionally, the engine sounds will become audible. 

Additionally, you may also press the ‘P’ key on the keyboard to enable 
or disable the engine sounds. 

Display Advanced Properties- 
This option displays advanced properties for the components in the 
airframe.  Using the advanced properties you may fine-tune the physics 
calculations performed by RealFlight, in order to adjust the flight 
performance to your liking.  When this option is checked, additional 
component properties will be displayed in the property listing area of 
the aircraft editor dialog.  These properties are marked as “Advanced” 
in the following sections. 
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Additionally, you may also press the ‘D’ key on the keyboard to display 
or eliminate the advanced properties from the dialog. 

Units- 
This option toggles the units of measure between metric and SAE 
units.  It is important to note that modifying this option affects all 
measurements in the simulation.  For example, changing from SAE to 
metric in the editor also affects the airport editor dialogs. 

To modify this option, click the Display Metric Units setting.  Then 
select the unit of measurements you would prefer from the drop down 
menu.  The options are English or Metric.  A check mark will appear 
next to the unit that is currently displayed. 

Alternatively, you can press the ‘U’ key on the keyboard to switch 
between the different units of measurement. 

Reload Color Scheme- 
This option allows you to view the results of an edited trim scheme. 

There are two ways that you can do so.  The first is to use the Select 
Color Scheme menu, which is found within the Aircraft menu.  
Simply click on the color scheme that you have just edited, and 
RealFlight will reload the color scheme onto your aircraft and reset the 
aircraft back on the runway. 

Alternatively, within the aircraft editor, click on the Options menu 
item.  Select Reload Color Scheme.  Clicking this reloads the color 
scheme, showing any changes you have made to the aircraft.  To 
improve visibility of the trim scheme, you may wish to remove the 
wireframe from the preview.  To do so, please follow the procedure 
noted in the description for “Show Wireframe.” 

You can also press the ‘R’ key on the keyboard to reload the color 
scheme. 

View Menu- 
The View menu in the aircraft editor offers choices on the perspectives of the 
aircraft in the preview window. 
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Look At- 
This option allows you to determine the view of the aircraft being 
edited.  There are three options available from this menu. 

• Aircraft Center- Check this option is you wish to keep the entire 
aircraft centered in the view. 

• Component Center- Check this option to center the view around 
the component you are editing.  For example, if you are modifying 
the rudder, the aircraft will shift so that the rudder appears in the 
center of the preview area. 

• Component Origin- Checking this option will focus the view on 
the root, or origin, of the component you are currently modifying.  
For example, if you have the Main Gear selected, the preview area 
will be centered at the location where the Main Gear is attached to 
the fuselage. 

To adjust the Look At perspective, click the Look At menu item and 
select the desired view. Alternatively, you may use the ‘A’ key on the 
keyboard to toggle through the selections. 
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Look From- 
Alternatively, you can select from pre-determine angles from the Look 
From menu item.  They include: 

• Above – Look from above the aircraft.  Or press the Q key to 
quickly change to this view. 

• Below – Look from below the aircraft.  Or press the Shift-Q keys 
to quickly change to this view. 

• Right – Look from the right side of the aircraft.  Or press the W 
key to quickly change to this view. 

• Left – Look from the left side of the aircraft.  Or press the Shift-W 
keys to quickly change to this view. 

• Front – Look from the front of the aircraft.  Or press the E key to 
quickly change to this view. 

• Back – Look at the back of the aircraft.  Or press the Shift-E keys 
to quickly change to this view. 

 
Show Wireframe- 
This option determines whether the aircraft displayed in the preview 
box is shown as a wireframe or is rendered complete with textures, etc.  
The wireframe option is automatically selected by default. 

If you would prefer to view the fully rendered image, click the Show 
Wireframe option from the pull-down list.  This will eliminate the 
check mark from the setting and return to the aircraft editor.  
Additionally, the preview aircraft window will show the rendered 
image of the aircraft. 

Alternatively, you may press the ‘S’ key on the keyboard to display or 
eliminate the wireframe view. 

Aircraft Parts Tree- 
The bottom half of the Aircraft Editor contains three important areas; the Aircraft 
Parts Tree, Parameter window, and the description pane.   
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The Aircraft Parts Tree breaks down the entire list of aircraft components and radio 
data into an easy-to-use hierarchy. 

The first item listed is the name of the aircraft you are currently editing, and is 
considered the root item for all other items listed here.  Selecting it will offer a variety 
of common parameters that you can edit in the Parameter window.  These include the 
description of the aircraft, Launch Method, Power Plant Type and Radio Type. 

Below the aircraft name, there are additional options that allow you to customize the 
individual parts of the aircraft.  You also have the ability to modify the electronics and 
radio program for the aircraft. 

Each part belongs to a higher component, or parent, with the root being the highest 
component.  In return, it’s possible that the part itself also has children parts that 
belong to it.  For example, if you wish to edit the wheel size on the P-51, you will find 
it under the following path in the Aircraft Parts Tree: 
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• P-51 Mustang - root of the aircraft, found at the top of the Aircraft Parts Tree list 

o Airframe – Contains all the physical parts of the aircraft, like wings, 
fuselage, etc. 

 Main Wing – One of many physical parts found in the Airframe 

• Main Gear – The Main Gear on the P-51 attaches to the 
wing, therefore, we found it under the Main Wing part. 

o Main Wheel – Finally, you’ll see the wheel 
component which, understandably, is found 
under the Main Gear part. 

Once the Main Wheel is selected, the Parameter window will change to show all 
parameters available to the Main Wheel.  You’ll notice that one of these parameters is 
wheel diameter. 

All other parts are found and modified in much the same way. If, however, you are 
unsure as to the location of a part, an easier way to access the part is to click on the 
desired item in the Preview screen on the top half of the window.  For example, if you 
want to modify the parameters for the horizontal tail of the P-51, simply click on that 
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portion of the image.  You’ll notice that the Horizontal Tail is now selected in the 
Aircraft Parts Tree. 

Preview Screen- 
As mentioned above, to quickly find the part in the Aircraft Parts Tree for 
modification, you can simply click that part in the Preview screen itself.  At times, you’ll 
notice that the part you want to click might be hidden behind another section of the 
aircraft.  If you find yourself in this situation, click and drag the mouse cursor around 
the Preview screen.  This will rotate the aircraft image around so you may view it from 
different angles.  You may also use the scroll wheel on the mouse to zoom in and out 
for a closer look at the section you are working on. 

Parameter Window- 
On the bottom half of the Aircraft Editor, you will see the Parameter window on the 
right side.  This window will list all the parameters available for the currently selected 
part in the Aircraft Parts Tree. 

 

Clicking on the parameter will allow you to view a description of its use in the 
Description pane directly below the Parameter window.  This will also allow you to 
modify the currently selected parameter. 
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Add and Removing Components- 
There are times when you may want to add a new component to the aircraft.  The first 
step is to determine the location for the new part.  For example, if you were to add 
flaps, it makes more sense to add it to the main wing, than to the fuselage. 

After having determined the location for the new part, you can add it in one of two 
ways.  Select the new part from the Edit menu.  Alternatively, you can right-click on 
the component in which you are adding the new part.  Again, if you were adding flaps, 
right-click on the Main Wing component, then select Add Control Surface. 

Removing a component works in much the same way.  In the Aircraft Parts Tree, 
select the component you wish to remove. Then select Delete Component from the 
Edit menu.  Alternatively, you can accomplish the same thing by right-clicking on the 
part to remove and selecting Delete Component. 

More Information- 
The Aircraft Editor may seem a little overwhelming at first.  The best way to become 
familiar with the editor and its related functions is to simply use it and start 
experimenting.  RealFlight does not allow you to customize the stock aircraft.  As such, 
if you make a change to one of the stock aircraft, you will be forced to save it under a 
new name.  Therefore, you always have the stock aircraft to default to, should the need 
arise. 

Our online forums and swap pages provide a great source of information, and 
assistance from other RealFlight users.  These pages may be found at: 

http://www.knifeedge.com/forums/ 

 

Select Color Scheme 
 
This menu item allows you to choose an alternative trim scheme (if available) for the 
current aircraft. 
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To view the alternative color schemes, click the Select Color Scheme menu item.  To 
select an alternate trim scheme, click the existing selection in the value box.  This will 
bring forth the pull-down menu selections.  Use either the Up/down arrow keys on 
the keyboard, or the mouse to select the desired option.  If utilizing the arrow keys, 
press Enter to finalize the selection.  The new trim scheme will appear immediately on 
the aircraft.  Please note:  if only one scheme appears in the pull-down menu, 
alternative schemes are not available for this aircraft.    

  

Save Color Scheme As… 
 
This menu item is used to create an editable version of the currently selected trim 
scheme. 
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RealFlight G4 allows you to create a custom paint/decal scheme for your aircraft.  The 
color schemes you create are limited only by your imagination. 

However, only individuals that own, and know how to use, a third-party bitmap editing 
program such as Adobe® Photoshop®, should attempt to create a custom color 
scheme.  Your editor must be able to read and edit Targa (“.tga”) files. 

To create a custom color scheme click the Save Color Scheme As… menu item.  
Enter the desired name in the dialog box that appears.  The location of the file will 
appear in the lower left corner of the RealFlight screen. 

To access the file that contains the custom color scheme, open the My Documents 
folder.  Next, open the RealFlight G4 folder followed by the Vehicles folder.  A 
number of folders are available here, open the folder called ColorSchemes.  This will 
bring up all of the custom color schemes that have been stored in RealFlight.  The 
name of the aircraft will precede the name that you have selected for your custom 
color scheme.  Click on the file for which you wish to modify the trim scheme. 

DO NOT ALTER THE NAME OF THIS FILE, AS REALFLIGHT MAY 
NOT BE ABLE TO CORRELATE THE COLOR SCHEME WITH THE 
AIRCRAFT. 
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Once you have finished editing and saving your color scheme, you will probably want 
to see the results of your work.  There are two ways that you can do so.  One is to use 
the Select Color Scheme menu, which is found within the Aircraft menu.  Simply click 
on the color scheme that you have just edited, and RealFlight will reload the color 
scheme onto your aircraft and reset the aircraft.  Within seconds, you are ready for 
flight with your new color scheme. 

Alternatively, access the Aircraft Editor (see section Edit Current Aircraft on page 113).  
Within the aircraft editor, look for Reload Color Scheme which is located in the 
Options menu.  Clicking this will reload the color scheme, showing any changes you 
have made to the aircraft.  You can disable the wireframe using the Options menu to 
improve your view. 

While looking in the ColorSchemes directory for your new color scheme, you may also 
notice a “.colorscheme” file with the same name as the “.tga” file.  This file can be 
opened in a text editor such as Notepad.  Within the file, you will find six values to edit:  
Specular, Reflectivity, PowerSpecularOff, PowerSpecularOn, PowerReflectiveOff, and 
PowerReflectiveOn. 

Specular - A multiplier for the overall specularity of the aircraft.  Specular=1 is neutral, 
Specular=0 disables specular highlights. 

Reflectivity - A multiplier for the overall reflectivity of the aircraft.  Reflectivity=1 is 
neutral, Reflectivity=0 disables reflections. 

Specular highlights vary from fully off to fully on as the specular power of each piece 
of the aircraft goes from the value PowerSpecularOff to PowerSpecularOn. 

Reflections vary from fully off to fully on as the specular power of each piece of the 
aircraft goes from the value PowerReflectiveOff to PowerReflectiveOn. 

Tips for Color Schemes 

• A quick and easy way to change a color scheme is to replace one color 
with another.  Photoshop has a command that can easily do this called 
“Replace Color”. 

• Make sure you save the file as 32 bit TGA files so that the Alpha Channels 
are preserved (See below). 

• You are only allowed a single Alpha Channel. 

• Do NOT alter the resolution of the image. 

• Other formats (JPG, BMP, etc) are not allowed. 
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Alpha Channels 
Almost all of the color schemes for the aircrafts incorporate an Alpha Channel, which 
defines what areas of the color scheme are opaque and what areas are transparent.  
White portions of the alpha channel will be 100% opaque and Black portions of the 
alpha channel will be 100% transparent.  Shades in-between will be partially 
transparent. 

Consult the image editor’s manual to determine how to use Alpha Channels. 

Note:  RealFlight uses TGA files instead of the BMP format.  This is because BMP formats do not 
support alpha channels. 

 

Remember Aircraft Position 
 
The Remember Aircraft Position menu item saves the current position of the aircraft.  
When you reset the aircraft, it will return to the same position (speed, attitude, heading, 
etc.) as when this menu item was selected.  This feature is ideal for practicing 
maneuvers, such as an autorotation in a helicopter. 
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To activate this menu item, click the Remember Aircraft Position menu item when 
the aircraft is in the desired location and altitude.  Alternatively, pressing the ‘P’ key on 
the keyboard will also remember the aircraft’s position. 

Each time the aircraft is reset it will begin flight from the saved location.  Please note:  
the saved position is only temporary.  If you select another airport, aircraft, or if you 
exit the simulation and restart, you will need to save the desired position once again. 

 

Clear Aircraft Position 
 
This menu item clears the position saved in the Remember Aircraft Position without 
exiting the simulation, changing flying sites and/or aircraft. 

 

To do so, simply click the Clear Aircraft Position menu item.  When the aircraft is 
reset, it will return to one of the default starting positions. 
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Reset Position 
 
There are three ways to reset the aircraft to its takeoff position: 

1. Press the Reset button on the InterLink Elite controller.  This is probably the 
fastest and simplest method. 

2. Press the keyboard’s space bar. 
3. Click the Reset Position menu item. 

 
 



 

 132 

Kill Engine 
 
Click on this item to instantly stop the motor from running.  This is useful when you 
are practicing dead-stick landings in airplanes and when practicing autorotations for 
helicopters.  Alternatively, you may also press the keyboard’s ‘K’ key. 
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Aircraft MRU 
 
The final items in the Aircraft menu indicate the most recently used aircraft.  The first 
item is the aircraft that you are currently flying; successive items are aircraft you have 
previously flown.  The MRU shows only the eight most recently selected aircraft. 

 

You can load an aircraft by selecting it from this list.  This shortcut allows you to 
switch between your favorite aircraft without using the Select Aircraft dialog. 
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Controller Menu 
Determine the method of  control, map the channels to your liking, and calibrate 
the controller. 

he Controller menu allows you to select the method of control, calibrate the 
controller and to map the channels for your desired method of control for 
RealFlight G4. 

When you click the Controller menu, a screen similar to that below will appear: 

 

The menu items available are: 
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• Select Controller 

• Controller Calibration… 

• Channel Mapping… 

 

Select Controller 
 
When you click on the Select Controller menu item, the following sub-menu appears: 

 

To choose the method of control, click on the Select Controller menu item from the 
Controller menu.  The selection(s) will vary depending on whether or not you have 
attached an actual R/C transmitter to the interface adapter for the InterLink Elite. 

Please note:  if you have attached a controller to the InterLink Elite’s interface port, 
RealFlight will pause briefly while it detects the transmitter. 

The selections are (usually) InterLink Elite and InterLink Elite Transmitter X Channel.  
If you will be using your own controller in the simulation, choose the InterLink Elite 
Transmitter X Channel.  The sections that follow will explain the differences 
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between the various modes and methods of control and the means and ways to access 
and utilize them. 

If you have attached a Generation 2 InterLink controller or a G3 InterLink Plus 
controller in addition to the G4 InterLink Elite, there will be an option allowing you to 
select these controllers as well.  

 

Controller Calibration 
 
The Controller Calibration… menu item allows you to adjust  your controller for use 
in the simulation.  Calibration is the method of fine-tuning the controller input for the 
simulation, so that you will achieve the desired responses. 

 

Once selected, the following screen appears: 
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As directed, place all sticks, knobs and switches to their center positions.  Click Next 
when finished. 
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It is imperative to move all of the sticks, knobs and switches through their complete 
range of motion several times.  This is the key to a properly calibrated controller.  
When completed, click Finish.  You will now be returned to the simulation with a 
calibrated controller. 

 

Channel Mapping… 
 
G4’s Channel Mapping feature allows for incredible flexibility and adjustability 
regardless of radio manufacturer or flight mode utilized.  This menu item enables you 
to define the functionality of the transmitter when utilized in the simulation. 

 

To access the Channel Mapping… menu item, click the Controller menu.  Next, select 
the Channel Mapping… option.  This will bring forth the following screen. 
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It is important to have a basic understanding of the Channel Mapping… screen prior 
to actually modifying the actual mapping itself. 

Channel- 
This column corresponds to the actual channel of the transmitter used to control the 
functionality, as defined in the Map To column. 

For example, radio channel 3 on a Futaba radio corresponds to the throttle.  As such, 
the Map To value is defined as throttle.  On the other hand, radio channel 3 on a JR 
radio controls the pitch (elevator). 

The first column displayed shows the number for the input channel.  You can change 
this by clicking the down arrow next to the number and selecting a different channel.  
This is useful if you want the same channel to control multiple functions.  For example, 
with this option you could assign channel 3 to control both throttle and elevator.  It’s 
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important to note that this will affect all aircraft.  See Edit Current Aircraft on page 113 
for information on how to edit the individual aircraft. 

The radio channel values serve as placeholders, or reminders, for the functionality of 
your transmitter with regards to the Map To functions. 

Map To- 
The values here define the function or duties that will be performed by the transmitter.  
Using the example from the Radio Channel above, the Map To for Futaba’s Channel 3 
dictates that this will control the throttle of the desired aircraft.  For JR radios, Channel 
3 on the transmitter controls the pitch (elevator). 

If your transmitter varies from the default definitions, it is necessary to modify the Map 
To functions.  To do so, click on the Map To channel that corresponds to the channel 
you wish to adjust.  Using either the up/down arrow keys on the keyboard or the 
mouse, select the desired Map To channel.  If using the up/down keys, press Enter to 
finalize your selection. 

If the channels are mapped, or defined properly but control input produces results that 
are backwards (e.g., increasing the throttle stick actually decreases the throttle on the 
aircraft), please refer to the Reverse Channel section that follows. 

Reverse Channel- 
The value here determines whether to reverse the input received from the radio 
channel.  If checked, the input will be reversed. 

To adjust the input direction, click on the corresponding Reverse Channel checkbox 
as necessary. 

Using RealFlight’s Channel Mapping- 
Now that you have a basic understanding of the Channel Mapping, it is time to utilize 
this knowledge to program the software for your controller. 

While watching the channel values, move the gimbal stick that controls the throttle 
input for your aircraft.  Taking note of the value, map this channel to the throttle. 

Repeat this procedure for ALL corresponding channels on the transmitter.  When you 
have finished, click OK.  Next, return to the simulation and test the Channel Mapping 
to ensure that all channels are mapped correctly and that all function as desired.  If not, 
please return to the Channel Mapping…menu item and refine accordingly. 

After you have correctly mapped the channels, it is best to re-calibrate your transmitter.  
To do so, please see the Controller Calibration section on page 137. 
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Joystick Mode vs. Transmitter Mode 
 
In single-player mode, RealFlight allows you to quickly and easily change the method 
used to control the action in the simulation.  RealFlight G4 offers two control modes: 

• Joystick Mode.  Using the InterLink Elite in Joystick Mode, RealFlight G4 accepts 
control input from the sticks, switches, knob and push-button on the InterLink 
Elite controller.  This is the default mode when you install RealFlight.  Again, we 
suggest that you fine-tune the calibration of the controller.  For information on 
how to do so, please refer to the Controller Calibration section on page 137. 

• Transmitter Mode.  Using the InterLink Elite in the Transmitter Mode, RealFlight 
G4 accepts commands from your actual R/C transmitter.  To use this mode, your 
transmitter must be connected to the InterLink Elite controller via the InterLink’s 
built-in interface.  This is an optional use of the InterLink, and we have provided 
the necessary cables for using most popular R/C transmitters.  Using the 
Transmitter Mode takes slightly more setup and understanding of your radio than 
does using the Joystick Mode. 

• To switch between these modes, highlight the Select Controller menu item.  The 
InterLink Elite controller will automatically test to determine whether an R/C 
transmitter is present.  After the detection testing completes, select the mode that 
you wish to utilize for your flight -- either Transmitter Mode or Joystick Mode.  
Regardless of which mode you select, you will return to the simulation and be 
ready to start flying immediately. 

 
 

InterLink Elite Controller (Joystick Mode) 
 
In Joystick Mode, RealFlight accepts control input from the sticks, switches, rotary 
knob and push-button found on the InterLink Elite controller.  This is the default 
mode when you install RealFlight G4. 

The RealFlight G4 software, working in conjunction with the InterLink Elite 
controller, actually does all the radio processing to measure the raw stick, switch, knob 
and push-button input from the controller.  It then processes this input to produce the 
servo outputs that are used to control the aircraft. 

Helicopters, for example, ordinarily require a great deal of mixing to achieve flight.  
This mixing is normally the function of a computer radio.  When RealFlight G4 uses 
the Joystick Mode, the mixing is done by the RealFlight G4 software itself and not by 
the InterLink Elite controller. 
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Channel Modification- 
It is possible to modify the mixing of the radio in the Software Radio menu.  To access 
the Software Radio menu, click the Aircraft menu followed by the Edit Current 
Aircraft menu item.  Next, click on the Software Radio menu.   

Every aircraft in RealFlight has its own unique software radio program that maps 
(converts) the raw stick inputs from the InterLink Elite controller into the correct 
servo input for that particular aircraft. 

Controller Calibration- 
Occasionally it may become necessary to fine-tune your InterLink Elite controller’s 
calibration.  To do so, click on the Controller menu followed by the Controller 
Calibration… menu item.  Follow the directions that appear on-screen to complete 
the calibration procedure. 

Stick Mapping 
As noted above, RealFlight’s Channel Mapping… feature allows you the flexibility to 
modify the operational mode of the transmitter.  Typical operation modes are as 
follows: 

• Transmitter Mode 1 (Europe, Asia) - Mode 1 transmitters have aileron and throttle 
on the right stick, and rudder and elevator on the left stick. 

• Transmitter Mode 2 (USA) - Mode 2 transmitters have aileron and elevator on the 
right stick; rudder and throttle on the left stick. 

• Transmitter Mode 3  - Mode 3 transmitters have rudder and elevator on the right 
stick; aileron and throttle on the left stick. 

• Transmitter Mode 4  - Mode 4 transmitters have rudder and throttle on the right 
stick, and aileron and elevator on the left stick. 

 

InterLink Elite Controller (Transmitter Mode) 
 
This exciting feature allows you to plug your own R/C transmitter into the back of the 
InterLink Elite controller.  You can then use your own transmitter to control the 
RealFlight aircraft.  With Universal Serial Bus (USB) connectivity, the InterLink Elite 
controller offers high resolution, rapid data transfer from your transmitter to the PC, 
and immediate response from the simulated aircraft. 

When compared to the Joystick Mode, using your own radio adds a slight amount of 
complexity and initial configuration setup.  The advantage to this method is that it will 
allow you to become familiar with the programming on your actual R/C transmitter.  
Additionally, you will develop the ‘feel’ of using your transmitter rather than the 
InterLink Elite controller. 
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Two ways to use the InterLink Elite Transmitter Mode- 
There are two ways to use Transmitter Mode.  They are commonly referred to as the 
“Pass Through Interface” and “Joystick Emulation Interface” (not to be confused with 
the “Joystick Mode” in the previous section).  Here is a quick chart that will help you 
decide which mode to use. 

 InterLink 
Elite 
Joystick 
Mode 

InterLink Elite 
Transmitter 
Mode:  Joystick 
Emulation 
Interface 

InterLink Elite 
Transmitter 
Mode:  Pass 
Through Interface 

Radio used to Fly InterLink 
Elite 
Controller 

Your own R/C 
radio 

Your own R/C 
radio 

Ease of 
Configuration 

Very Easy Medium.  Must 
calibrate and 
setup radio one 
time. 

Harder.  Must 
separately calibrate 
and set up radio for 
each aircraft. 

Fly Stock aircraft 
without 
Modification 

Yes Yes No 

Gives you the 
feel of your own 
radio 

No Yes Yes 

Puts “wear and 
tear” on your 
own transmitter 

No Yes Yes 

Allows you to 
perform mixing 
in your own 
radio 

No No Yes 
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R/C transmitter 
required 

No Required: 4-8 
channels.  
Computer radio 
not required 

Required: computer 
radio with multiple 
model memory.  
Recommended: 
radio with 7-12 
channels. 

 

 

Transmitter Mode: Joystick Emulation Interface 
 
The purpose of the Joystick Emulation Interface is to create a program on your own 
R/C transmitter to provide RealFlight with raw stick inputs.  This enables RealFlight to 
use its own software radio to control all of the stock aircraft. 

It also allows you to use a single model memory, or program, on your R/C transmitter 
to control, without modification, all of the stock aircraft in RealFlight.  We suggest that 
you perform the Channel Mapping and Controller Calibration procedures in this order, 
respectively.  This will prevent you from having to re-calibrate your controller if one (or 
more) of the channels is not mapped correctly.  

Channel Mapping 
Before accessing the Channel Mapping… menu item, you will need to create a new 
program or model memory on your R/C transmitter.  We suggest that you call it 
RFJOY or something similar. 

Please make sure that this new program meets the following criteria: 

• Is an airplane program--you do not want a heli program with all of its mixing (since 
all the mixing will be performed by the RealFlight software) 

• Does not have any mixing programmed 

• Has trims centered 

• Has ATVs set to 100% 

• Has dual rates and expo turned off – as these may be emulated in the RealFlight 
software radio 

 
Prior to starting this wizard, make sure that your transmitter is attached to the 
InterLink Elite controller and that the controller is on.  Click the Controller menu 
followed by the Select Controller menu item.  There will be a momentary pause while 
RealFlight detects the R/C transmitter.  Next, click InterLink Elite Transmitter X 
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Channel.  After this is accomplished, click Channel Mapping… Follow the on-
screen instructions, making sure that you read all of the instructions in each step. 

Once you have finished, it is best if you never modify the RealFlight radio program in 
your transmitter again.  A change in this “RFJOY” program will affect every RealFlight 
aircraft flown with this transmitter.  Instead, edit the Software Radio in RealFlight.  
Changes to the Software Radio only affect the aircraft whose radio you have edited. 

Controller Calibration 
By calibrating the R/C transmitter for use with RealFlight’s software you are, in 
essence, advising RealFlight as to the minimum, maximum and center values for each 
channel on your particular radio. 

To calibrate your transmitter, click the Controller menu followed by the Controller 
Calibration… menu item.  Follow the on-screen instructions to complete the 
calibration procedure. 

You are now ready to fly any of the stock aircraft available in RealFlight. 

 

Transmitter Mode: Pass Through Interface 
 
This is the most advanced method for controlling the RealFlight aircraft.  It provides 
total control of an aircraft from your own radio and utilizes all of your radio’s mixing 
functionality.  All values received by RealFlight are passed directly to the aircraft 
without modification from the RealFlight software.  The disadvantage is that you will 
have to create a new radio program (model memory) on your R/C transmitter for each 
aircraft you want to fly with this mode.  You must also set up your radio, mixes, trims, 
dual rates, etc. on the transmitter for each aircraft you want to fly with this mode. 

The advantage of this mode is that if you are mainly flying one or two aircraft on 
RealFlight, you use your own radio program for these aircraft and have complete 
control over them.  It also is a very good tool for learning how to use your own R/C 
radio as it forces you to set up the transmitter the same way you would have to set it up 
if you were going to control an actual R/C aircraft. 

Before you use the Pass Through Interface- 
IMPORTANT!   Make sure that you follow the procedures for both the Controller 
Calibration… AND the Channel Mapping… menu item in the previous sections 
BEFORE attempting to use the Pass Through Interface.  Failure to do so may result in 
an aircraft that either does not perform adequately or fails to perform at all. 
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Setting the Pass Through Interface- 
After completing the Controller Calibration… and the Channel Mapping… 
procedures, select the desired aircraft.  Next, select the Edit Current Aircraft menu 
item.  Highlight the aircraft root (name of the aircraft) and select the value for the 
Radio Type. Using either the mouse or the up/down arrow keys on the keyboard, 
select the Pass Through option from the pull-down menu.  

Mapping channels to Servos- 
If any channels are mapped to the wrong functions on the aircraft, edit the aircraft 
using the following procedure.  Click the Edit Current Aircraft menu item.  Access 
the Electronics options.  Double-click the Electronics name or click on the [+] 
(plus).  Select the incorrectly mapped channel from the pull-down list that activates.  
To change the respective channel of operation, click on the corresponding value and 
select the appropriate option from the pull-down list. 

IMPORTANT!  Do not change the servo mapping using the Channel Mapping… 
menu item.  If you do so, the change will also affect ALL stock aircraft.  Instead, 
simply change the servo mapping using the Electronics options above for a single 
aircraft. 

Sharing Aircraft that use the Pass Through Interface- 
In most cases, when you make a custom aircraft that uses the Pass Through Interface 
option, you will not be able to provide that aircraft to your friends or submit it to the 
RealFlight Model Swap Page.  This is because the RealFlight software does not receive 
the necessary input for the radio programming.  Consequently, you would have to 
provide other RealFlight users with all of your R/C radio’s settings for that particular 
aircraft.  Moreover, they would have to have the exact same R/C transmitter in order 
for them to use the aircraft.  These complications effectively prohibit swapping aircraft 
under these conditions. 

 

InterLink Elite Controller Tips 
 
What if my transmitter has fewer channels than the model I select?  
This issue can arise when you use your own transmitter to control RealFlight G4.  In 
this situation, we highly recommend that you use the InterLink Elite controller. 

When to use the Channel Mapping, and when to use the Software Radio or Servo 
page- 
This issue arises only if you use your own transmitter to control RealFlight.  When you 
use the InterLink Elite controller as a mockup transmitter, you should not alter the 
Channel Mapping. 
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Remember that Channel Mapping is used to set the input channels for your 
transmitter.  This means that you are setting the channels used to monitor physical 
movements or positions of your transmitter’s sticks, switches, and knobs.  Unless you 
change transmitters, you should only need to set this once.  Only use the Channel 
Mapping… menu item to tell RealFlight which channel your controller is using for each 
stick/knob/switch input, not what control function you want that stick/knob/switch to perform. 

The Software Radio controls mixing, exponential, and other channel processing that a 
computer radio would normally perform.  The Software Radio determines the control 
function you want each stick/knob/switch setting to perform.  You will most likely 
want to adjust this differently for various aircraft.  For example, the mixing utilized for 
your glider will probably not be very useful on a jet. 

The Electronics options modify the servo properties (e.g., servo speed) as well as 
adjusting the input channels in the same way as the Channel Mapping… wizard.  
However, changes made using the Electronics options only apply to the particular 
aircraft that you are editing.  Use the Electronics options only when you want to edit a specific servo 
property (like servo speed) or if for some reason you need to reassign an input channel for one aircraft 
only.  In most cases, you should not need to do the latter.  Instead, you should normally 
use the software radio to configure control outputs. 

A good rule of thumb:  if a setting will not be the same for every aircraft, you should not try to 
implement the setting by using the Channel Mapping… menu item.  Instead, adjust the Software 
Radio.
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Events Menu 
Challenge your flying skills by competing in events, by yourself, or join others 
online. 

n event is an organized flying contest with a set of rules.  RealFlight G4 
supports five types of events: Autorotation/Deadstick, Free Style, Limbo, 
Pylon Racing and Spot Landing.  You can participate in these events by 
yourself or compete with other RealFlight G4 users over the internet. 

To participate in an event alone, all you have to do is start the event.  RealFlight G4 
does the rest. 

If you want to compete with other RealFlight G4 users, you must first start a 
multiplayer session (or join an existing one). See the Multiplayer chapter for additional 
information on how to do so. 

When all of the participants have joined the session, the session host will start the 
event.  This enrolls every member of the multiplayer session in the Event.  If any 
multiplayer session members want to leave the event, they can do so while remaining a 
part of the multiplayer session. 

RealFlight G4 limits you to running only one event at a time.  This rule also applies to 
multiplayer sessions. 

The Events menu accesses all events, and event-related options.  When you open the 
menu, the items are: 

Chapter 

8 

A 
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• Autorotation/Deadstick 

• Freestyle 

• Limbo 

• Pylon Racing 

• Spot Landing 

• Options… 

• End Current Event 

• Forfeit Turn 

Some of these items may be grayed out if they do not apply to the current situation.  
For example, you cannot end the current event unless an event is already running.  
Consequently, the End Current Event menu item will be grayed out. 
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Autorotation/Deadstick 
 
The Autorotation/Deadstick event is similar to the Spot Landing event mentioned 
below.  This event requires that you make a landing with all power off. 

 

The goal of this event is to land the airplane, or autorotate the helicopter, into the 
marked zones.  The various landing zones have different point values assigned to them.  
The zones that are more difficult to target are awarded higher point values.  If 
participating in a multiplayer event, the player with the highest points total at the end 
wins. 

It is possible to enable the software to “kill” the player’s engine when their aircraft 
passes a particular altitude. 

Selecting Your Name for the Event- 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, please 
do so in the space provided when you select an event.  Click OK when completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This brings up the 
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multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options- 
The Options… menu item adjusts the parameters and rules for each event.  To access 
the Options… menu item, click the Events menu followed by the Options… menu 
item.  Next, from the column on the left side, select the event that you wish to adjust.  
The selections that appear will depend upon the event selected.  This section examines 
the selections available for the Autorotation/Deadstick Landing Options. 

 

Zone Point Values- Zones A through E- 
The landing zones are divided into five segments.  In the default settings, each 
segment has a different point value assigned to it based upon degree of 
difficulty.  Zone A is the smallest, most difficult target.  Therefore, it offers the 
highest point value.  Zone B, which surrounds the center, offers the second 
highest points, followed by Zone C, D and E. 

To adjust the values of these points, click on the values in the column to the 
right of the respective Zone Points.  For example, to adjust the points for 
Zone A, click on the corresponding Value in the column next to Zone A.  
Enter the desired value directly from the keyboard or via the mouse wheel. 

Turns Per Event- 
This option determines the number of turns that each player is allotted per 
event.  When each player has taken the designated number of turns, the event 
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is over.  The only exception is if the host activates the Crash Eliminates Player 
setting.  In this case, the event will end if all of the players crash before they 
reach the turn limit. 

To adjust the number of turns, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Throttle cut altitude- 
As mentioned previously, in an Autorotation/Deadstick event, the host can set 
the rules so that the throttle is cut manually or automatically.  This section 
refers to the settings for a manual throttle cut.  For information on automatic 
throttle cuts, please see the Player Kills Engine section below. 

To adjust the altitude at which the throttle is cut, click on the corresponding 
value.  Enter the desired altitude value directly from the keyboard or via the 
mouse wheel. 

Time to Complete Turn (sec)- 
This is the amount of time allotted for each player to complete his or her turn. 

Note:  the countdown or timer is initiated at takeoff. 

To adjust the amount of time to complete the Event, click on the 
corresponding value.  Enter the desired value directly from the keyboard or via 
the mouse wheel. 

Target Scale- 
This option determines the size of the landing targets. 

To modify the size of the landing area, enter a number in the corresponding 
value column.  Enter the desired value directly from the keyboard or via the 
mouse wheel.  The size of the targets will scale proportionally. 

Crash Eliminates Player- 
This option determines whether a crash eliminates a player from the 
competition.  If No, the player will be able to continue his/her turn regardless 
of whether or not they have crashed.  If Yes, the event is over for them as 
soon as a crash occurs. 

To set Crash Eliminates Player option, click the value in the corresponding 
column.  From the pull-down list, select either Yes or No. 

Player Kills Engine- 
This option determines whether you want to cut off the engine manually or 
allow RealFlight G4 to do so for you.  If enabled, the player must manually kill 
the engine above the Throttle Cut Altitude.  RealFlight will display the engine 
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cut notification for you on-screen.  With automatic throttle cutting, RealFlight 
G4 will automatically cut the throttle as soon as the aircraft crosses the 
minimum altitude threshold.  Again, RealFlight will display the engine cut 
notification for you on-screen. 

To set Player Kills Engine option, click the value in the corresponding column.  
From the drop-down list, select either Yes (manual cut required) or No 
(automatic cut at altitude). 

 

Autorotation/Deadstick Instructions 
 
You can run an autorotation competition in either a single player or multiplayer 
environment. 

 

The person who starts the event decides upon the applicable rules and parameters.  For 
example, you can set: 

• The time allotment for each player’s turn. 

• How many turns each player receives. 
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• Whether a player’s engine is automatically or manually killed during a turn. 

• The altitude at which an engine must be killed. 

• The physical dimensions of the landing target. 

• Whether or not a crash automatically disqualifies a player. 

• Point values of the different zones within the landing target. 
 
RealFlight G4 automatically applies the rules you choose, and keeps track of scores.  
During the event, the announcer’s voice will guide you through each phase of the 
competition. 
 
Rules  
The Autorotation/Deadstick course consists of a target: 

The object of the Autorotation/Deadstick event is to fly your model over the target, 
kill the engine, then touch down as close as possible to the center of the target.  Players 
take turns making landing attempts.  When your turn comes, you will normally takeoff, 
gain altitude until you are above the minimum Throttle Cut Altitude, fly towards the 
target, and then kill your engine and autorotate or glide to the ground. 

If the host so decides, you must kill your engine before dropping below the minimum 
altitude to kill engine.  Alternatively, the host can decide that your engine will 
automatically shut off when you pass below this altitude.  The host must also decide on 
the minimum Throttle Cut Altitude. 

A “touch down” occurs when any part of your airplane or helicopter touches ground.  
Each touch down is marked with an ‘X’ on the spot at which the aircraft landed. 

Please note:  this is not necessarily the point at which the aircraft stopped moving. 

An “attempt” means you have passed below the minimum altitude to kill your engine.  
Once your engine is disabled, you cannot reactivate it until your turn expires.  
Additionally, you must land successfully (without crashing) to receive any points for 
your attempt. 

Furthermore, you must complete your landing before your turn time expires.  If you do 
not touch down in time, you will lose your turn. 

The points you receive during a turn are dependent upon where you touch down.  
Within the target, each colored zone has a different point value.  Normally, the closer 
to the center you land, the more points you will receive.  Your touch down point is the 
point on the ground directly below the center of your aircraft, no matter what part of 
your aircraft touches first. 
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The event continues until the players complete all of their turns, all of the players are 
disqualified (usually by crashing), or everyone has left the event.  The player with the 
highest point total at the end of the event is the winner. 

Events Viewport Display Box- 
During the event, a situational screen will appear on your display.  This screen serves 
several purposes:  it indicates the player’s name, tracks the amount of time remaining to 
complete the event, and indicates the remaining altitude before the engine is cut. 

If you do not wish to view this information, double-click on the title bar of the display 
box.  This will hide the information.  To view it once again, simply double-click the 
title bar again. 

To reveal the statistics for the event, click the arrow button in the upper right corner of 
the box.  Click the arrow button one more time to hide this information. 

To resize the viewport, position the cursor over the lower right corner of the 
viewport’s frame.  Using the mouse, drag the frame according to your wishes.  If you 
drag it downward, the vertical size of the viewport will increase.  Dragging the frame to 
the right or left will increase/decrease the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the viewport will close the viewport. 

 

Freestyle 
 
RealFlight G4’s Freestyle event lets you make the rules.  When you start a Freestyle 
event, RealFlight G4 will allot every player a set of turns.  Each player’s turn ends when 
that player’s time expires (or if the player crashes).  When this occurs, the next player’s 
turn begins.  What players do during their respective turns is completely up to the 
participants.  We’ve included some possible freestyle examples below.  
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Whatever activity you pick, RealFlight will see that each player receives a timed turn.  
You can use freestyle with any aircraft (airplanes or helis). 

Selecting Your Name For the Event 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, please 
do so in the space provided when you select an event.  Click OK when completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options 
As the name suggests, the Options… menu item is used to adjust the parameters and 
rules for each of the events.  The Autorotation/Deadstick Event section discusses general 
notes for this option.  This section examines the selections available for the Freestyle 
options. 
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Time to Complete Turn (sec)- 
This is the amount of time allotted for players to complete their turn. 

Please note:  the time begins at takeoff. 

To adjust the amount of time to complete the event, click on the 
corresponding value.  Enter the desired value directly from the keyboard or via 
the mouse wheel. 

Turns Per Event- 
This option determines the number of turns that will be allotted to a player for 
the event.  The event is over when each player has taken this number of turns, 
or sooner if the host activates the Crash Eliminates Player option and a crash 
occurs. 

To adjust the number of turns, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Crash Eliminates Player- 
This option determines whether a crash eliminates a player from the 
competition.  If No, the player will be able to continue his/her turn regardless 
of whether or not they’ve crashed.  If Yes, the event is over for them as soon 
as they crash. 
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To determine whether a crash eliminates a player, click the value in the 
corresponding column.  From the pull-down list, select either Yes or No. 

 

Freestyle Instructions 
 
You will usually want to use Freestyle in a multiplayer environment, but it works in 
single player mode as well. 

 

Before you start this event, you will ordinarily decide what the participants must do.  
You may just want to use the event to give everyone an equal chance to showcase his 
or her aerobatic skills.  This will prevent you from worrying about your scoring.  If you 
want to have a competition, we suggest that before you begin the event: 

• Everyone should agree on the rules. 

• The host may need to edit the airport to add any equipment (pylons, runways, 
fences, obstacle rings, limbo poles, etc.) that you will need for the event. 

• Everyone should agree how the event will be judged.  You could appoint one 
player to decide on a score for every other player, or have everyone in your session 
vote on the best maneuver, etc. 
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The person who starts the Event (multiplayer session host) can pick: 

• How much time each player is allotted per turn 

• How many turns each player receives, and 

• Whether a player who crashes is automatically disqualified 
 
We emphasize, the only limit on the freestyle event is your imagination.  A few examples of what 
you might wish to do: 

• Touch and Go.  Appoint one partner to count runway touches, the contestant with 
the most touches in a turn wins. 

• Aerobatics.  Players use their turns to perform any stunt they want.  At the end, 
everyone votes on the best stunt. 

• Obstacle course.  Set up a long obstacle (table, etc.) close to the ground and take 
turns flying under it; land or takeoff from ramps, circle around pylons, etc. 

 
It does not have to be a contest.  You might all just want to take an equal turn at using 
the runway (takeoff, land on alternate turns). 
 
Events Viewport Display Box- 
During the event, a situational screen will appear on your display.  General notes on 
this display were discussed in the Autorotation/Deadstick event section. 

 

Limbo 
 
A limbo event is a contest of piloting skill and courage.  Players attempt to maneuver 
their aircraft under a horizontal bar suspended across two vertical bars.  After each 
successive pass, the bar is lowered.  The event continues until only one pilot remains. 
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Selecting Your Name For the Event- 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, please 
do so in the space provided when you select an event.  Click OK when completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options- 
The Options… menu item is used to adjust the parameters and rules for each of the 
Events.  See the Autorotation/Deadstick section for general notes about this screen.  This 
section examines the specific selections available for the Limbo options. 
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Minimum Bar Height- 
This setting determines the lowest height that the bar will reach during the 
Event. 

To adjust the Minimum Bar Height, click on the corresponding value.  Enter 
the desired value directly from the keyboard or via the mouse wheel. 

Maximum Bar Height- 
This setting determines the highest setting (starting value) that the bar will 
reach during the event. 

To adjust the Maximum Bar Height, click on the corresponding value.  Enter 
the desired value directly from the keyboard or via the mouse wheel. 

Distance to Drop Bar each Round- 
After a participant successfully passes under the limbo bar, on their next 
attempt the bar will lower by the amount indicated in this setting. 

To adjust the distance by which the bar will be lowered each round, click on 
the corresponding value.  Enter the desired value directly from the keyboard or 
via the mouse wheel. 

Commit Line Distance- 
This indicates the distance between the commitment lines and the limbo bar.  
There is a commitment line on either side of the limbo bar and participants 
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may approach from either side.  These lines detect an attempted pass at the 
limbo bar. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

Distance Between Poles- 
The value entered here indicates the distance between the two vertical poles 
that support the limbo bar.  The wider the space between the poles, the easier 
it is to pass through the gate, so to speak. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

Time to Complete Turn (sec)- 
This is the amount of time allotted for each player to complete his or her turn. 

Please note:  the countdown or timer is initiated at takeoff. 

To adjust the amount of time to complete the Event, click on the 
corresponding value.  Enter the desired value directly from the keyboard or via 
the mouse wheel. 

Attempts Per Turn- 
This value indicates the number of attempts that each pilot is allotted at any 
given height of the limbo bar before being eliminated for that turn. 

To adjust the number of attempts, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Turns Per Event- 
This option determines the number of turns per player for this event.  When 
this number is reached, the event is over.  If the host activates the Crash 
Eliminates Player option, however, the event may end sooner. 

To adjust the number of turns, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Crash Eliminates Player- 
This option is used to determine whether a crash eliminates the player from 
the competition.  If No, the player will be able to continue his/her turn 
regardless of whether or not they have crashed.  If Yes, the event is over for 
them as soon as a crash occurs. 

To determine whether or not a crash eliminates a player, click the value in the 
corresponding column.  From the drop-down list, select either Yes or No. 
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Limbo Instructions 
 
A limbo competition can be run in either a single player or multiplayer environment. 

The limbo course consists of a limbo pole, and two attempt lines (also called 
commitment lines), one on each side of the limbo pole. 

 

The object of limbo is to fly an aircraft past the attempt line, then under the limbo bar, 
in the time allowed.  Players take turns attempting to fly under the bar.  When your 
turn comes, you will normally takeoff, circle back towards the limbo pole, then pass 
across the attempt line and under the bar, then land.  If you successfully fly under the 
bar, the bar height will be lowered prior to your next turn. 

An “attempt” means you have crossed the attempt line, approaching the limbo bar.  
You can make multiple attempts, if necessary, during a turn. 

You have anywhere from 10 seconds to five minutes between the moment you first lift 
off and the moment you successfully pass under the bar.  If you fail to make it under 
the bar in time, you lose your turn.  (Before the event begins, the host decides the exact 
time limit.) 
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You can approach the limbo bar from either direction (i.e., you can cross either 
attempt line).  For an attempt to count, you must be approaching the limbo bar when 
you cross an attempt line.  Your aircraft must be airborne when it crosses the attempt 
line and when it passes under the bar (i.e., if you taxi, your attempt will not count). 

The event continues until each player has made it under the lowest bar height, or has 
been disqualified (usually by crashing), or has left the event.  

The player with the highest score wins.  Your score for each successful turn is: 

(time between first liftoff and successful pass) X (height cleared) / 100 

Notice that you will achieve or earn the highest score by passing under the bar as soon 
as possible after takeoff. 

If you did not make it under the bar, your score for that turn is zero. 

Events Viewport Display Box- 
During the event, a situational screen will appear on your display.  This screen serves 
several purposes.  General notes on the functionality for this window were discussed in 
the Autorotation/Deadstick event section. 

 

Pylon Racing 
 
In pylon racing, pilots race their planes around a closed course.  Pylon Racing 
challenges the pilots’ nerves and skills as they attempt to round the pylons, avoid mid-
air collisions, and finish first, without cutting any pylons. 
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Selecting Your Name For the Event- 
If you have already entered a name in the Settings… menu item, this name will be 
utilized for single player and multiplayer events.  If you have not entered a name, please 
do so in the space provided when you select an event.  Click OK when completed. 

To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options 
As the name suggests, the Options… menu item is used to adjust the parameters and 
rules for each of the Events.  To access the Options… menu item, click the Events 
menu followed by the Options… menu item.  Next, from the left hand column, click 
on the event for which you wish to adjust the Options….  The selections that appear 
will be dependent upon the event selected.  This section examines the selections 
available for the Pylon Racing Options. 
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Laps to complete- 
This value determines the number of laps that each participant must complete 
in the event.  The person who completes the laps in the shortest amount of 
time (after penalties) is the winner. 

To adjust the number of laps, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel. 

Cuts Allowed- 
This setting dictates the number of cuts (passes inside a pylon) that a racer is 
allowed before being eliminated from the event. 

To adjust the number of allowable cuts, click on the corresponding value.  
Enter the desired value directly from the keyboard or via the mouse wheel. 

Cut Penalty (sec)- 
This option determines the time penalty that a player receives for each cut they 
make during a race.  If the player exceeds the number of allowable cuts, they 
are eliminated from the race. 

To adjust the penalty seconds per cut, click on the corresponding value.  Enter 
the desired value directly from the keyboard or via the mouse wheel. 
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Three Pylons on Course- 
This setting determines whether the course is a three-pylon course or a two-
pylon course.  If Yes is selected, the course is a three-pylon course.  If No, the 
course is a two-pylon course. 

To set this option, click the value in the corresponding column.  From the 
pull-down list, select either Yes (three pylon course) or No (two pylon course). 

Threshold Rules- 
In threshold racing, the planes do not actually have to go around the pylon.  
Rather, they only have to break the plane of the pylon.  This option is only 
enabled for two pylon courses.  It is grayed out (not applicable) on three pylon 
courses. 

To determine whether the Threshold Rules will be utilized, click the value in 
the corresponding column.  From the pull-down list, select either Yes or No. 

Distance between pylons 1 and 2- 
If you have selected a two-pylon course, this option indicates the distance 
between the two pylons.  Increasing the value places the pylons farther apart. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

Distance to pylon 1- 
This is the distance from the starting point to pylon number 1.  This option is 
only applicable to three-pylon courses. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

Distance between pylons 2 and 3- 
If you have selected a three-pylon course, this option indicates the distance 
between the pylons two and three.  Increasing the value places the pylons 
farther apart. 

To adjust the distance, click on the corresponding value.  Enter the desired 
value directly from the keyboard or via the mouse wheel. 

 

Pylon Racing Instructions 
 
You can run a pylon race in either a single player or multiplayer environment. 
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The person who starts the event (the host) decides upon the applicable rules and 
parameters.  For example, the host can set: 

• How many pylons mark the course (two or three). 

• Regular or threshold-style racing (two-pylon races only). 

• The number of laps in the race. 

• The distances between pylons. 
 
RealFlight G4 automatically applies the rules you choose, and keeps track of scores.  
During the event, an announcer’s voice will guide you through each phase of the 
competition. 

Pylon Racing Rules- 
A pylon-racing course consists of two or three pylons.  Here is an example of a three-
pylon course: 

For both two-pylon and three-pylon races, the object is to takeoff and circle the pylons 
(without “cutting”) in the shortest amount of time.  A pylon race usually has two or 
more laps.  All racers start simultaneously.  The race continues until each player is 
either finished or disqualified (usually by cutting or crashing). 
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All players start at the same point on the runway.  When you hear the horn sound, 
takeoff and start the race. 

In pylon racing, you always circle the pylons counterclockwise viewed from above—
that is, when you come to a pylon you always turn left.  As you approach each pylon, 
you will hear a voice telling you when to start your turn.  When you have made a 
successful turn, you will hear a brief tone. 

“Cutting” is illegal.  The first time you cut during a race, you are penalized one lap.  
The second time you cut, you are disqualified.  To avoid being called for a cut, your 
entire aircraft must normally go completely around each pylon. 

Exception:  in a two-pylon style course, you can choose to use threshold-racing rules.  
In threshold racing, your aircraft only has to “break the plane” of the pylon to get 
credit for a legal turn.  This allows pilots to find independent race lines, which may 
reduce collisions during a race.  Before the race begins, the host chooses whether the 
race will follow regular or threshold rules. 

The pilot who finishes the required number of laps in the shortest amount of time wins 
the race. 

Events Viewport Display Box 
During the Event, a situational screen will appear on your display.  This screen serves 
several purposes.  General notes on this screen were discussed in the 
Autorotation/Deadstick event section. 

 

Spot Landing 
 
In a Spot Landing event, pilots take turns trying to touch their aircraft down within 
marked zones.  Generally, the zones that are more difficult to target have higher point 
values.  In a multiplayer event, the player with the highest points total wins. 
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Selecting Your Name For the Event- 
To select a different name for this event, click on the Simulation menu, followed by 
the Settings… menu item.  Next, click the Multiplayer name.  This will bring up the 
multiplayer options.  Click the value found next to the Pilot Name item.  Use the 
keyboard to input the name you wish to utilize for the events. 

Options- 
As the name suggests, the Options… menu item adjusts the parameters and rules for 
each of the Events.  To access the Options… menu item, click the Events menu 
followed by the Options… menu item.  Click on the event, located in the left column 
that you wish to adjust.  The options that appear are dependent upon the event 
selected.  This section discusses the selections available for the Spot Landing options. 
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Zone Point Values- Zones A through E 
The landing zones are divided into five segments.  In the default settings, each 
segment has a different point value assigned to it based upon degree of 
difficulty.  Zone A is the most difficult to hit.  Therefore, it offers the highest 
point value.  Zone B, which surrounds the center, offers the second highest 
points, followed by Zone C, D and E. 

To adjust the point values of the different zones, click on the values in the 
column to the right of the respective Zone Points.  For example, to adjust the 
points for Zone A, click on the corresponding value in the column next to 
Zone A.  Enter the desired value directly from the keyboard or via the mouse 
wheel. 

Target Scale- 
This option determines the size of the landing targets.  To increase the size of 
the landing area, enter a larger number in the corresponding value column.  
The target size will scale proportionally. 

Time to Complete Turn (sec)- 
This is the amount of time allotted for players to complete their turn. 

Please note:  this time begins at takeoff. 
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To adjust the amount of time to complete the event, click on the 
corresponding value.  Enter the desired value directly from the keyboard or via 
the mouse wheel. 

Turns Per Event- 
This option determines the number of turns allotted to the player for the 
Event.  The event is over when each player has completed the number of turns 
specified.  If the Crash Eliminates Players option is enabled, the event can also 
end when all of the players have been eliminated due to crashing. 

To adjust the number of turns, click on the corresponding value.  Enter the 
desired value directly from the keyboard or via the mouse wheel.  

Crash Eliminates Players- 
This option determines whether a crash eliminates a player from the 
competition.  If No, players will be able to continue their turns regardless of 
whether or not they crash.  If Yes, the event is over for them as soon as they 
crash. 

To determine whether a crash eliminates the player, click the value in the 
corresponding column.  From the pull-down list, select either Yes or No. 

 

Spot Landing Instructions 
 
A spot landing competition can take place in either a single player or multiplayer 
environment. 
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The person who starts the event (the host) is responsible for selecting the rules.  For 
example, you can set: 

• How much time each player receives per turn. 

• How many turns allowed per player. 

• The physical dimensions of the landing target. 

• Whether a crash automatically disqualifies the player. 

• Point values of the different zones within the landing target. 
 
RealFlight G4 automatically applies the rules you choose, and keeps track of scores.  
During the event, the announcer’s voice will guide you through each phase of the 
competition. 

Rules- 
The object is to touch down as close as possible to the center of the target.  Players 
take turns making landing attempts.  When your turn comes, you will normally takeoff, 
gain altitude and then fly towards the target on a landing approach. 
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A “touch down” occurs when any part of your airplane or helicopter touches the 
ground.  A large, visible ‘X’ marks each touch down on the spot where the aircraft 
landed. 

Please note:  this is not necessarily the point at which the aircraft stopped moving. 

Furthermore, you must complete your landing before time expires, thus ending your 
turn.  If you do not touch down in time, you lose your turn. 

The points you receive during a turn are dependent upon where you touch down.  
Within the target, each colored zone has a different point value.  Normally, the closer 
to the center you land, the more points you receive.  Your touch down point is the 
point on the ground directly below the center of your aircraft, no matter what part of 
your aircraft touches first. 

The event continues until each player has completed all of his or her turns, or has been 
disqualified (usually by crashing), or has left the event.  The player with the highest 
point total is the winner. 

You can only touch down once per turn, so if it looks like you may miss the target, pull 
up, circle around, and try again. 

The event continues until the players have completed all of their turns, all of the players 
have been disqualified (usually by crashing), or everyone has left the event. 

The player with the highest total score wins. 

Events Viewport Display Box- 
During the event, a situational screen will appear on your display.  The 
Autorotation/Deadstick event section provides general notes on this display box. 

 

Options 
 
The Options… menu item allows you to determine the various settings and parameters 
for the respective events.  The options available to you are dependent upon the Event 
selected. 

To access the Options… menu item, click on the Events menu followed by the 
Options… menu item.  Next, select the Event for which you would like to view the 
Options….  For further information as to the Options… available for each event, see 
the applicable event as discussed previously. 
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End Current Event 
 
This menu item immediately ends the current event.  If there are no events in progress, 
this menu item is grayed out.  If you are in a multiplayer session and are not the person 
hosting this session, the option is also grayed out. 

 

 

Forfeit Turn 
 
This item allows you to forfeit one turn.  If you are a multiplayer participant, all other 
pilots will take their turns before you can participate again. 
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This item is grayed out if you are playing an event where players do not take turns (e.g. 
Pylon Racing). 
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Multiplayer Menu 
Fly with friends, at the same computer, or over the internet. 

he Multiplayer option allows you to fly with others.  In fact, you are able to 
share the skies with up to seven additional pilots.  These other pilots can be 
across the street, around the block, or around the world! 

There are two ways to link up with the additional pilots; via a LAN (Local Area 
Network), or over the internet.  In order to do so, you will need a TCP/IP connection, 
either through your LAN or an ISP (Internet Service Provider). 

Every session requires someone to serve as host.  The host initiates the multiplayer 
session.  When the Host starts a session, other participants may join in. 

The Multiplayer menu allows you to access a variety of multiplayer-related features, 
functions and options.  Clicking the Multiplayer menu brings forth a pull-down 
menu, which will look similar to the following screen shot: 

Chapter 

9 
T 
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• Host… 

• Join… 

• Disconnect 

• Boot Player… 

• Publish Hosting Information 

• Enter MultiMode 

Some of these items will be grayed out if they do not apply to the current situation.  
For example, you cannot disconnect unless you are currently connected.  As such, the 
Disconnect menu item is grayed out unless you are in a multiplayer session. 

When you participate in multiplayer sessions, the menu commands you will access 
depend on whether you are the host or whether you opt to join someone else’s session.  
These commands also depend upon whether you already have a specific session you 
want to join. 

Depending on what options the participants utilize, it is possible to have a private 
session that is only open to players who know the host’s IP address. 
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Please note:  a computer’s IP address is its internet “postal code”.  It tells other 
computers on the internet how to contact that computer.  The following sections will 
explain more about IP addresses as necessary. 

It is also possible to participate in a public session using our list server.  The list server 
is a publicly available list of open RealFlight G4 sessions.  Currently we provide the list 
server to all RealFlight G4 owners, free of charge.  The list server allows you to 
participate in multiplayer sessions with other RealFlight G4 users anywhere in the 
world. 

IMPORTANT INFORMATION ABOUT THE LIST SERVER:  At the time 
of this writing we are providing the list server service on a trial basis.  This 
service may be modified, interrupted or cancelled at any time without notice.  
In particular, we make no guarantee about the reliability of this service.  To use 
this service you must register your product and may need to obtain product 
updates.  Inclusion of this manual on your RealFlight CD-ROM does not imply 
that this service will be available at the time you purchase this product.  
Moreover, we reserve the right to bar any individual user, or all users at 
individual IP addresses or domains, from using the list server at our discretion.  
Abusive behavior, for example, will not be tolerated. 

 

Chatting 
 
During Multiplayer sessions, you may want to chat with other participants.  Doing so is 
as simple as typing a message much like popular instant messenger programs. 

To send a chat message, press the Enter key to bring up the Chat field at the bottom 
of the screen.  Next, using the keyboard, type the message you wish to send.  Press the 
Enter key again on the keyboard to send the message. 

Please note:  all messages are viewable by all participants.  RealFlight G4 does not offer 
private chat. 

Any messages received from other participants will appear at the bottom of the screen. 

 

Host 
 
Every multiplayer session requires one participant to function as the host.  If you are 
the host, you will be the one who starts the session.  When you leave the session one of 
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the remaining participants automatically assumes the role of Host.  The host is also the 
one who starts and ends the events (Limbo, Pylon Racing, etc.). 

 

Once you have started the session, other players may join in as they wish. 

If you opt to broadcast the session to the list server, the session is known as a public 
session.  The session will be open to all G4 owners searching for multiplayer events. 

If you wish to keep the session private, only those participants to whom you have 
provided your IP address will be able to join. 

The procedures for starting public and private sessions are very similar.  In order to 
join your session, the participants will usually need to know the IP (Internet Protocol) 
address of your computer.  The exception is if you are holding the session over a LAN, 
in which case the other players do not need to know your IP address.  For a public 
session, your partners can retrieve your IP from the list server.  For a private session, 
you must provide the IP address directly to the desired participants.  When the session 
starts, RealFlight G4 will display your IP in the lower left corner of the main display. 

To access the Host… menu item, click on the Multiplayer menu followed by the 
Host… menu item. 
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Host Information- 
The Host Information allows you the ability to name your multiplayer session.  You 
can also choose the maximum number of pilots and whether or not you wish to make 
your multiplayer session public or private. 

 

Session Name- 
Using the keyboard, enter the name of the session that you will be hosting. 

Please note:  this is the name of your session, not necessarily your personal 
name.  In fact, you might find it useful to use a descriptive name such as “3D 
Fun Fly.”  This is particularly useful when other participants are searching for a 
likely session to join. 

Max Players- 
To adjust the maximum number of players allowed in your session, click the 
down arrow.  Enter the number directly from your keyboard or use the mouse 
wheel. 

Currently, a multiplayer session may not have more than eight members.  If the 
host computer is somewhat slow or has a poor internet connection, you may 
want to limit the number of participants. 

Optional Port Number- 
For users that are behind firewalls, you may want to use a port other than the 
default port (which is 2302).  Most users should leave this field blank. 

Broadcast to the List Server- 
Clicking this option allows your session to be posted on the list server.  This 
allows other RealFlight G4 users to join your session.  This is a good option if 
you are looking for new (or additional) partners to fly with.  If you check this 
box, you will be prompted for session information (see next section). 

If you leave this box unchecked, your session will not be posted on our list 
server and you will have a private session.  You will have to directly provide 
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your IP address to your multiplayer partners (through phone, email, chat room, 
or whatever means you wish).  This is a good option if you want to limit your 
session to a private group of friends. 

If you do not want to broadcast your session information now, you can do so 
after the start of the session (see section pertaining to Publish Hosting 
Information on page 188).  

Finally, please remember that at the time of this writing, we are providing the 
list server on a trial basis only.  This service may be modified, interrupted or 
discontinued at any time without notice. 

 

Join 
 
This option allows you to participate in a Multiplayer session without being the Host of 
the session yourself. 

 

To access the Join… menu item, click on the Multiplayer menu followed by the 
Join… menu item. 



 

 185 

Before you can join a session, you will need two things: 

• A network connection and 

• The IP address of the session Host (unless the session is taking place over a LAN 
[Local Area Network]). 

 
You can get the IP address directly from the Host (in the case of a private session), or 
from our list server (in the case of a public session). 

Join Session- 
This dialog allows you to select the multiplayer session that you wish to join.  It also 
provides you with a variety of information pertaining to the various sessions available 
to you. 

 

Search Function- 
The Search function checks two distinct areas for multiplayer sessions.  
RealFlight G4 (at your discretion) will search the list server and the Local 
Network for multiplayer sessions. 

To determine the Search area, click the down arrow next to the Start button.  
This activates the pull-down selections.  Click on the location that you wish to 
search. 

After making your selection, click the Start button to begin the search.  When 
the search completes, the respective sessions and information appear in the 
dialog above.  To select one of these sessions, click on the respective session 
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and then click OK.  Alternatively, you may double-click on the Session Name 
to join. 

Note:  if you are using an updated version of Windows XP (Service Pack 2 or 
later), you may have Windows Firewall installed and running.  If this is the 
case, Windows Firewall will pop up a warning dialog (similar to that shown 
below) the first time you use the Search function.  You must select the 
Unblock option in order to allow RealFlight G4 to continue searching. 

 

Session Name- 
The Session Name column displays the name of all available sessions.  If you 
have not searched (and found) a session, or entered an IP address, the Session 
Name will remain blank. 

Host- 
This column shows the IP address of the host computer.  If you have accessed 
the address via the Search function, this information is automatically filled in 
for you when you select the session.  If you participate in a multiplayer session 
via a LAN, you do not need to fill in the IP address.  If you participate in a 
private session, fill in the IP address here.  When completed, click OK to 
proceed. 

Port- 
This information is important if you are attempting to participate in a 
multiplayer session and the computer is located behind a firewall or NAT.  The 
Port Number will route your computer’s data through the firewall.  It is 
imperative that this port number matches the port number of the host. 
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Players- 
This column shows the users how many players are participating in a given 
multiplayer session.  The host determines the number of allowable participants. 

Latency- 
Latency is the amount of time it takes a packet of information to travel from its 
source to the destination.  The larger the number, the slower the information 
travels.  High latency can result in sluggishness and “lag” while running the 
simulation.  As such, you will want to avoid sessions where the latency number 
is high. 

 

Disconnect… 
 
This menu item is used to disconnect from, or exit, the multiplayer session. 

 

To access the Disconnect… menu item, click on the Multiplayer menu followed by 
the Disconnect… menu item. 

Please note:  if you are not currently participating in a multiplayer session, this item will 
be grayed out and will not be accessible. 
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Boot Player… 
 
This menu item is used to drop a participant from a multiplayer session.  It is only 
available if you are the Host of the session.  Otherwise, this item is grayed out and 
inaccessible. 

 

To access the Boot Player… menu item, click on the Multiplayer menu followed by 
the Boot Player… menu item.  

The booted player will receive an on-screen message advising him/her that the host 
has booted (removed) them from the session. 

 

Publish Hosting Information 
 
You can make your session public (placed on the list server) when you first start the 
session.  Alternatively, you can do this while the session is in progress by selecting this 
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menu item.  When you click OK, RealFlight G4 publishes your session information to 
the list server, where everyone can see it. 

 

Please note:  at the time of this writing, we are providing the list server on a trial basis 
only.  This service may be modified, interrupted or discontinued at any time without 
notice. 

 

Enter MultiMode 
 
MultiMode allows you to fly with another pilot on the same PC, with each pilot 
controlling his or her own aircraft.  This feature is ideal for offering personal flight 
instruction, practicing formation flights, or simply for chasing one another across the 
skies. 
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To access the MultiMode menu item, click on the Multiplayer menu followed by the 
MultiMode menu item. 
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MultiMode will split the screen either horizontally (default) or vertically.  You can 
change this options in the Settings window.  Simply click the Simulation menu, 
followed by Settings.  On the left side of the Settings screen that appears, choose 
Multiplayer.  On the right, you can adjust the Multimode Screen Layout to 
Horizontal or Vertical. 

All options available in RealFlight are also available in MultiMode.  The difference is 
most will function on the half of the screen that currently is active.  To determine 
which half has the focus or is active, look for the yellow outline.  To change focus, click 
the half that doesn’t have the yellow outline.  You’ll notice the focus change when you 
do so. 

For example, if you are flying in MultiMode with a horizontally split screen, you might 
notice that the yellow outline is around the top half.  If you want to change the aircraft 
for the person flying on the bottom half of the screen, first click that half of the 
window so it has the focus or is the active screen.  Select an aircraft following the 
normal procedure. 

To exit MultiMode, select Exit MultiMode menu item under the Multiplayer main 
menu.
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Recordings Menu 
Save and play back RealFlight memories. 

he Recordings menu is used to start and stop recordings to assist you in your 
R/C ventures.  RealFlight G4 also allows you to record your flights for later 
playback -- complete with audio voiceovers.  You can even share your flights 
with friends and fellow pilots. 

 

Menu options that are available for Recordings are: 

• Start/Stop Recording 
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• Open Recording 

• Record Microphone Input 

• Recordings MRU 

 

Start Recording 
 
Click on the Recording menu followed by the Start Recording menu item.  
RealFlight G4 will start recording your flight immediately.  An on-screen message will 
confirm that the recording has started. 

 

Alternatively, you may also press the keyboard’s ‘R’ key to start a recording. 

RealFlight will continue recording your flight until you select the Stop Recording 
menu item or press ‘R’ again to stop recording. 
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Stop Recording 
 
The Stop Recording menu item is not visible until the Start Recording menu item 
activates.  To stop the recording of your flight at any time, click the Recording menu 
title, followed by the Stop Recording option.  RealFlight G4 will stop recording at this 
time.  RealFlight G4 automatically saves all recordings for playback later.  For 
information on how to delete a recording, please see the Open Recording… section 
which follows. 

Alternatively, you may also press the keyboard’s ‘R’ key to stop recording. 

When RealFlight G4 stops recording, an on-screen message appears which indicates 
the default name of the recording that has just been completed.  For information on 
how to change the name of a recording, please see the Open Recording… section 
which follows. 

 

Open Recording… 
 
This menu item allows you to access the recording files.  It also allows you to perform 
a variety of modifications to the files such as renaming them or deleting them.  To 
access the recordings, click the Recording menu title, followed by the Open 
Recording… menu item. 
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To open a recording, click on the file name.  Next, click on the Open button.  
Alternatively, you may double-click on the file.  Regardless of which method you 
utilize, this will start RealFlight’s Playback Gadget.  For more information on the 
Playback Gadget, please refer to the information below. 

If you wish to rename the recording, simply right click on the respective Recording, 
select rename from the drop-down menu and rename the file. 

To delete a recording, right click on the Recording file and select Delete from the pull-
down list. 

Playback Gadget- 
When you open a recording, RealFlight G4’s playback gadget appears on the screen.  
This gadget allows you to control the playback of the recordings using simple mouse 
commands.  It features DVD-like controls that start, stop, and pause the playback.  It is 
also possible to modify the playback gadget. 
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If you do not wish to view the playback information, double-click the title bar of the 
display box.  This will hide the information.  To view it once again, simply double-click 
the title bar again. 

To resize the playback gadget display, position the cursor over the lower right corner of 
the frame.  Using the mouse drag the frame according to your wishes.  Dragging the 
frame to the right or left increases or decreases the width of the viewport, respectively. 

Clicking on the ‘X’ in the viewport’s title tab removes it from the screen and exits the 
playback. 

Loop Play- 
The arrows that forms a circle causes the recording to loop (i.e., play 
continuously).  The continuous loop is activated when the arrows are 
illuminated.  To stop the looping, click on the loop button again. 

  

Look at Recording- 
Click on the ‘eye’ to look at the respective Recording.  This causes the camera 
to treat the recording as its target object, rather than your aircraft.  If you have 
multiple recordings playing, choose the ‘eye’ of the Recording you wish to 
view. 
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Left/Right Arrows- 
The left and right arrows rewind (left) or fast forward (right) the recording.  
Alternatively, you may click on the position indicator, hold the mouse button 
and drag the indicator to the desired position. 

 

Playback/Pause- 
If the recording is paused, the playback button will be the single arrow pointing 
to the right.  To resume playback of the recording, click this arrow. 

 

If the recording is playing, the playback button will switch to a pause button.  
To pause playback, press this button.  You may continue at any time by 
pressing the playback button once again. 

 

Position of Recording- 
The slider bar and position indicator are used to track the progress of the 
recording playback. 

It is also possible to use the position indicator to select the point at which you 
wish the recording to begin playing.  Using the mouse drag, position the slider 
bar to the position desired. 
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Record Microphone Input 
 
RealFlight G4 also allows you to add your voice or other audio to the recordings.  If 
selected, the Record Microphone Input menu item activates and allows you to record 
audio input to accompany your recording. 

 

Adding your voiceover to the recordings is a fantastic way to create personalized 
training lessons.  This feature presents you with the ability to create your own Virtual 
Flight Instructions that you can share with other RealFlight G4 owners around the 
world! 
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Recordings MRU 
 
If you have previously selected a recording, you will note that it appears on a list in the 
Recordings menu title.  Lists such as this are commonly referred to as Most Recently 
Used, or MRU lists.  The MRU list is limited to the eight most recently selected 
recordings.  If you wish to view one of these recordings simply click on the name of 
the recording and it will begin. 
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Training Menu 
Practice makes perfect.  RealFlight’s Training Aids make practicing a little more 
enjoyable. 

ealFlight G4 offers a number of training aids.  These training aids are designed 
for modelers of all skill levels. 

Helicopter pilots will benefit from the Heli Hover Trainer, Heli Orientation 
Trainer and the helicopter Virtual Flight Instructions.  The Heli Hover Trainer and 
Heli Orientation Trainer offer modelers the chance to practice their stick control and 
helicopter attitude recognition.  With Virtual Flight Instructions, R/C professionals 
offer audio and visual instruction on how to perform basic, intermediate and advanced 
maneuvers. 

Airplane modelers will also benefit from the Takeoff Trainer, Landing Trainer, 
Airplane Hover Trainer and Virtual Flight Instructions. 
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Once you click on the Training menu, the following menu options appear: 

• Takeoff Trainer… 

• Landing Trainer… 

• Heli Hover Trainer… 

• Airplane Hover Trainer… 

• Heli Orientation Trainer… 

• Virtual Flight Instruction… 

 

Takeoff Trainer 
 
The Takeoff Trainer offers a great way for first time pilots to learn the basics of taking 
off an airplane.  With this trainer, you have the ability to adjust wind settings, takeoff 
direction, and overall difficult to stay on the runway. 
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To start the trainer, click Takeoff Trainer… menu item from the Training menu.  
The trainer will start automatically. 

The Takeoff Trainer feature is based on RealFlight’s Flight School flying site.  As such, 
you’ll notice that RealFlight automatically uses the Flight School airport.  You’ll see that 
the NexSTAR trainer sitting at the end of the runway, waiting for your inputs.  The 
goal is to takeoff as straight as possible down the runway, pulling back gently on the 
elevator.  As you takeoff, you’ll notice a number of arrows in the sky.  These arrows 
indicate the path that you should follow.  The arrows will appear red in color if you are 
on the correct path, blue if you are not. 
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You’ll also notice the menus have changed, which we’ll discuss here. 

Trainer Menu- 
The Trainer Menu contains the following menu items: 
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• Reset Aircraft 

• Boundary 

• Wind 

• Direction 

• Exit 

Reset Aircraft- 
If you crash or fly too far out of the boundary area, there are three ways to 
reset the aircraft: 

1. Press the Reset button on the InterLink Elite controller. This is 
probably the fastest and simplest method. 

2. Press the keyboard’s space bar. 

3. Click the Reset Aircraft menu item 
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Boundary- 
The Boundary menu item allows you the change the size of the runway path 
for which you must stay inside while taking off.  To change the size or the 
boundary, select the Boundary menu item from the Trainer menu.  A sub-
menu will appear with the following options. 

• None – Eliminates the boundary all together. 

• Small – Creates a tighter boundary which is excellent training for practicing 
precise takeoffs. 

• Medium – Creates a medium path boundary. 

• Large – Creates a large boundary. 

Once you select a boundary size, you’ll notice two blue lines on either side of 
the runway.  During takeoff, you must try to stay between these lines.  If you 
get too close, they will turn red. Correct the flight path of your airplane so that 
you are more centered on the runway. 

Wind- 
Not everyday can be an ideal day to fly.  Every pilot must learn how to takeoff 
with different wind conditions.  The Wind menu will allow you to adjust the 
direction of the wind.  When you select the Wind menu item, the following 
options will appear. 

• None – Turns the wind off to simulate a calm day. 

• Crosswind Left – This will set the wind to blow from the left of the 
aircraft. 

• Crosswind Right – This will set the wind to blow from the right of the 
aircraft. 

• Upwind (Normal) – Upwind will set the wind to blow towards the nose of 
the aircraft. 

• Downwind (Dangerous) – This will create a tail wind, making it more 
difficult to take off due to the decrease in airspeed. 

Direction- 
The Direction menu will allow you to change the direction in which you take 
off.  For an R/C pilot, you don’t have the luxury of sitting in the airplane, so 
you must learn how to control the airplane from any direction.  Selecting the 
Direction menu will show the following options. 
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• Left to Right – Take off from the left side of the runway, heading to the 
right. 

• Right to Left – Take off from the right end of the runway, heading to the 
left. 

Exit- 
If you wish to leave the Takeoff Trainer and return to the simulation, select the 
Exit menu item. 

 

Landing Trainer 
 
The old saying goes, “Take offs are easy, landings are the hard part.”  Once you master 
the Takeoff Trainer, the next step is to learn how to land, which is what the Landing 
Trainer is designed to do. 

 

To start the Landing Trainer, click the Training menu, followed by the Landing 
Trainer… menu item. 
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You’ll notice that RealFlight switched airports to Flight School, if you were not there 
already.  For this training session, you’ll be piloting Hobbico’s NexSTAR.  You’ll also 
have options, should you wish, to adjust where to start the landing, wind direction, and 
how difficult it should be to hit the runway. 

 

For landings, it’s important to understand the different legs during the approach to the 
runway. 
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When you start the Landing Trainer, you’ll notice a new menu has appeared. 

Trainer Menu- 
The Trainer Menu contains the following menu items: 

 

• Reset Aircraft 

• Boundary 

• Wind 

• Direction 

• Leg 

• Exit 

Reset Aircraft- 
If you crash or fly outside the boundary, there are three ways to reset the 
aircraft: 

1. Press the Reset button on the InterLink Elite controller.  This is 
probably the fastest and simplest method. 
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2. Press the keyboard’s space bar. 

3. Click the Reset Aircraft menu item. 

Boundary- 
The Boundary menu item allows you the change the size of the runway path in 
which you must land between.  To change the size or the boundary, select the 
Boundary menu item from the Trainer menu.  A sub-menu will appear with 
the following options. 

• None – Eliminates the boundary all together. 

• Small – Creates a tighter boundary which is excellent training for precise 
landings. 

• Medium – Creates a medium path boundary. 

• Large – Creates a large boundary. 

Once you select a boundary size, you’ll notice two blue lines on either side of 
the runway.  During your landing, you must try to stay between these lines.  If 
you get too close, they will turn red.  Correct the flight path of your airplane so 
that you are more centered on the runway. 

Wind- 
Every pilot must learn how to land with different wind conditions.  In some 
respects, this can be more difficult than takeoffs, since you must learn how to 
deal with different wind conditions for each leg of the approach.  The Wind 
menu will allow you to adjust the direction of the wind.  When you select the 
Wind menu item, the following options will appear. 

• None – Turns the wind off to simulate a calm day. 

• Crosswind Left – This will set the wind to blow left across the runway. 

• Crosswind Right – This will set the wind to blow from the right across the 
runway. 

• Upwind (Normal) – Upwind will set the wind to blow towards the nose of 
the aircraft as you are on your final leg. 

• Downwind (Dangerous) – This will create a tail wind during the final leg, 
making it more difficult to land due to the decrease in airspeed. 



 

 211 

Direction- 
It’s important to learn how to land from any direction.  This menu item will 
change the approach direction to learn the controls from a different aspect.  
The choices that appear when you select the Direction menu item are as 
follows. 

• Left to Right – This will set you up to land on the runway from the left 
end flying towards the right. 

• Right to Left - This will set you up to land on the runway from the right 
end flying towards the left. 

Leg- 
The Leg menu item allows you to practice each leg of the approach.  The 
options are as follows. 

• Downwind – This sets the aircraft up on the downwind side, or parallel to 
the runway.  From here, you must fly the Downwind, turn to Base, and 
then the Final for the landing. 

• Base – This sets the aircraft up for the Base leg of the approach.  You 
must complete the Base leg and then turn to the Final leg prior to landing. 

• Final – The Final leg will set you up for the landing. 

When the training lesson begins, the NexSTAR will be placed at the beginning 
of the Leg you choose.  Simply hit the Reset button on the InterLink Elite to 
begin flying. 

Exit- 
If you wish to leave the Landing Trainer and return to the simulation, select 
the Exit menu item. 

 

Heli Hover Trainer 
 
The Heli Hover Trainer offers you a great way to learn how to precisely control a 
helicopter in a hover.  With the Heli Hover Trainer, you pick which channels you wish 
to control and RealFlight will take care of the rest for you. 



 

 212 

 

To start the trainer, click Heli Hover Trainer… menu item from the Training menu.  
The trainer will start automatically.   

You’ll notice a circle on the ground.  This circle represents the training boundary.  If 
your helicopter ventures beyond this boundary, it will break apart and the session will 
begin once again.  You’ll also note two ‘X’ marks within the boundary.  The circle 
represents the true center of the boundary, the ‘X’ represents the current location of 
your helicopter.  The goal is to control the helicopter in a stable hover, keeping it as 
close to the center of the circle as possible. 



 

 213 

 

You’ll also notice that the menu options have changed. 

Trainer Menu- 
The Trainer Menu contains the following menu items: 
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• Reset Aircraft 

• Boundary 

• Crashes 

• Exit 
 

Reset Aircraft- 
If you crash or fly outside the circle, there are three ways to reset the aircraft: 

1. Press the Reset button on the InterLink Elite controller.  This is 
probably the fastest and simplest method. 

2. Press the keyboard’s space bar. 
3. Click the Reset Aircraft menu item. 
 

Boundary- 
The Boundary menu item allows you to change the size of the circle, or 
eliminate it altogether.  To change the size of the boundary, select the 
Boundary menu item from the Trainer menu.  A drop down menu will 
appear with the following options. 
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• None – Eliminate the boundary circle. 

• Small – Creates a small circle. 

• Medium – Creates a medium sized circle. 

• Large – Creates a large circle. 
 
Crashes- 
After a crash, RealFlight may automatically reset your helicopter for you, if so 
desired.  This option is on by default.  If you would prefer to turn this option 
off, select the Crashes menu item, then select the Automatically Reset 
Aircraft.  If a checkmark appears next to this menu item, then this feature is 
activated.  If the checkmark does not appear, it is not active. 

If Automatically Reset Aircraft is enabled, you may adjust how quickly the 
reset happens.  To adjust this delay, select the Crashes menu item followed by 
the Reset Delay menu item.  Four options will be available to you: 

• None – No delay will be set.  The aircraft will reset immediately. 

• Short – The aircraft will reset approximately one second after it crashes. 

• Medium – The aircraft will reset approximately three seconds after it 
crashes. 

• Long – The aircraft will reset approximately six seconds after it crashes. 
 
 

Exit- 
If you wish to leave the Heli Hover Trainer and return to the simulator, select 
the Exit menu item. 

 
Orientation Menu- 
The Orientation menu allows you the option to select the position and attitude of the 
heli when the session begins or the helicopter is reset. 
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A checkmark will appear next to the currently selected orientation.  The options 
available are: 

• Random Upright – The heli will start in the upright position, but it will randomly 
face either to the right, left, nose out, or nose in. 

• Random Inverted – The heli will start in the inverted position, but it will randomly 
face either to the right, left, nose out, or nose in. 

• Nose Out – The heli will start upright, facing nose out.  This option is the best 
selection for beginning heli pilots. 

• Nose In – The heli will start upright, facing nose in. 

• Left – The heli will start upright, facing to the left. 

• Right – The heli will start upright, facing to the right. 

• Nose Out Inverted – The heli will start inverted, facing nose out. 

• Nose In Inverted – The heli will start inverted, facing nose in. 

• Left Inverted – The heli will start inverted, facing to the left. 

• Right Inverted – The heli will start inverted, facing to the right. 
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Control Menu- 
The Control menu allows you to select which channel or channels to control.  All other 
channels are controlled by RealFlight, allowing you to learn just the controls you wish, 
and adding more as you become more comfortable and confident. 

 

A checkmark will appear in the menu next to the currently selected item.  Your options 
are: 

• Pitch Only – You control only the pitch of the heli, RealFlight will control the roll, 
yaw, and throttle. 

• Roll Only – You control only the roll of the heli, RealFlight will control the pitch, 
yaw, and throttle. 

• Yaw Only – You control only the yaw of the heli, RealFlight will control the roll, 
pitch, and throttle. 

• Throttle Only – You control only the throttle of the heli, RealFlight will control the 
roll, yaw, and pitch. 

• Throttle, Pitch – You control both the throttle and pitch of the heli, RealFlight will 
control the roll, and yaw. 

• Throttle, Roll – You control both the throttle and roll of the heli, RealFlight will 
control the pitch, and yaw. 
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• Throttle, Yaw – You control both the throttle and yaw of the heli, RealFlight will 
control the roll, and pitch. 

• Throttle, Pitch, Roll, Yaw – You control all channels for the heli. 
 

 

Airplane Hover Trainer 
 
The Airplane Hover Trainer offers you a great way to learn how to control an 
aerobatic airplane in a torque roll.  With the Airplane Hover Trainer, you pick which 
channels you wish to control.  RealFlight automatically controls the rest. 

 

To start the trainer, click Airplane Hover Trainer… menu item from the Training 
menu.  The trainer will start automatically.   



 

 219 

 

You’ll notice a circle on the ground.  This circle represents the training boundary.  If 
your airplane ventures beyond this boundary, it will break apart and the session will 
begin once again.  You’ll also not two ‘X’ marks within the boundary.  One represents 
the true center of the boundary; the second is your airplane location.  The goal is to 
control the airplane in a stable hover, keeping it as close to the center of the circle as 
possible. 

You’ll also notice the menus have changed, which we’ll explain here. 

Trainer Menu- 
The Trainer Menu contains the following menu items: 



 

 220 

 

• Reset Aircraft 

• Boundary 

• Crashes 

• Exit 
 

Reset Aircraft- 
If you crash or fly outside the circle, there are three ways to reset the aircraft: 

1. Press the Reset button on the InterLink Elite controller.  This is 
probably the fastest and simplest method. 

2. Press the keyboard’s space bar. 
3. Click the Reset Aircraft menu item. 

 

Boundary- 
The Boundary menu item allows you the change the size of the circle, or 
eliminate altogether.  To change the size or the boundary, select the Boundary 
menu item from the Trainer menu.  A drop down menu will appear with the 
following options. 
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• None – Eliminates the boundary circle. 

• Small – Creates a small circle. 

• Medium – Creates a medium-sized circle. 

• Large – Creates a large circle. 
 

Crashes- 
After a crash, RealFlight may automatically reset your aircraft for you, if so 
desired.  This option is on by default.  If you would prefer to turn this option 
off, select the Crashes menu item, then select the Automatically Reset 
Aircraft.  If a checkmark appears next to this menu item, then this feature is 
activated.  If the checkmark does not appear, it is not active. 

If Automatically Reset Aircraft is enabled, you can adjust how quickly the reset 
happens.  To adjust this delay, select the Crashes menu item followed by the 
Reset Delay menu item.  Four options will be available to you: 

• None – No delay will be set.  The aircraft will reset instantaneously. 

• Short – The aircraft will reset approximately one second after it crashes. 

• Medium – The aircraft will reset approximately three seconds after it 
crashes. 

• Long – The aircraft will reset approximately six seconds after it crashes. 
 

Exit- 
If you wish to leave the Airplane Hover Trainer and return to the simulator, 
select the Exit menu item. 

Orientation Menu- 
The Orientation menu allows you the option to select the position and attitude of the 
helicopter when the session begins or the airplane is reset. 
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A checkmark will appear next to the currently selected orientation.  The options 
available are: 

• Random – The airplane will start in a random position, with either the top, bottom, 
left side or right side facing you. 

• Top – The airplane will start with the top of the aircraft facing you. 

• Bottom – The airplane will start with the bottom of the aircraft facing you. 

• Left – The airplane will start with the left side of the aircraft facing you. 

• Right – The airplane will start with the right side of the aircraft facing you. 
 
Control Menu- 
The Control menu allows you to select which channel or channels to control.  The 
remaining channels are controlled by RealFlight, allowing you to learn just the controls 
you wish, and adding more as you become more comfortable and confident. 
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A checkmark will appear in the menu next to the currently selected item.  Your options 
are: 

• Elevator Only – Check this to control only the elevator of the aircraft.  RealFlight 
will control the throttle, ailerons, and rudder for you. 

• Aileron Only – Check this to control only the ailerons of the aircraft.  RealFlight 
will control the throttle, elevator, and rudder for you. 

• Rudder Only – Check this to control only the rudder of the aircraft.  RealFlight will 
control the throttle, ailerons, and elevator for you. 

• Throttle Only – Check this to control only the throttle of the aircraft.  RealFlight 
will control the elevator, ailerons, and rudder for you. 

• Throttle, Elevator – Check this to control the throttle and elevator of the aircraft.  
RealFlight will control the ailerons and rudder for you. 

• Throttle, Aileron – Check this to control the throttle and ailerons of the aircraft.  
RealFlight will control the elevator and rudder for you. 

• Throttle, Rudder – Check this to control the throttle and rudder of the aircraft.  
RealFlight will control the elevator and ailerons for you. 

• Throttle, Aileron, Elevator, Rudder – Check this to control all four channels.  You 
will not receive any assistance from RealFlight. 
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Heli Orientation Trainer 
 
As you become more proficient with hovering a helicopter, you can test your skills 
with the Heli Orientation Trainer.  The Heli Orientation Trainer challenges you to 
keep your helicopter in the same location as the trainer helicopter.  As you succeed in 
doing so, the trainer helicopter will move, and the level of difficulty will increase. 

 

To start the trainer, select Heli Orientation Trainer menu item from the Training 
menu. 

The Heli Orientation Trainer has a number of different levels, each with an increasing 
level of difficulty than the previous.  To pass a level you must hover your helicopter in 
close proximity to the trainer helicopter.  As you do so, the trainer helicopter will turn 
from blue to red, and the progress bar at the top of the screen will increase, indicating 
that your task is nearly complete. 
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In the upper right corner, a countdown timer is visible.  This is the amount of time you 
have to fill the progress bar and complete the task.  If you fail to do so, both the timer, 
and the progress bar will reset to zero.  You must begin once again. 

The number displayed in the upper left corner indicates the number of locations the 
trainer helicopter will stop for the current level.  It will also indicate how many of these 
locations you have completed.  For example, if it displays 1/3, you have successfully 
completed one spot out of three for the current level. 

As you advance to the next level, you may be responsible for controlling more 
channels, the allotted time might also decrease and the trainer heli will stop in more 
locations.  Additionally, you might experience any combination of these circumstances 
to increase the difficulty. 

Heli Orientation Menu- 
The Heli Orientation menu is the only menu accessible while the trainer is running.  
Two options are available in the Heli Orientation menu: 
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Select Level- 

A drop-down menu will display the levels available to you.  For example, if you 
have only progressed to Level 2, you will not be able to access Level 3 or 
higher in this menu. 
A checkmark will appear next to the level you are currently flying. 
 
Exit- 

To return to the simulator, select Exit to leave the Heli Orientation Trainer. 
 

Virtual Flight Instruction 
 
RealFlight Generation 4 includes on-screen flight training from some of R/C’s best 
pilots.  John Glezellis, Frank Noll Jr., Jason Shulman, Pete Niotis, Todd Bennett, Brian 
Bremer and Jim Bourke are your instructors taking you through a variety of skill levels 
of R/C.  There are basics for beginners as well as more advanced maneuvers for 
intermediate pilots.  G4 also includes instructions on how to perform some of today’s 
hottest 3D flight maneuvers!  G4 includes voice instruction as well as an on-screen 
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radio that shows the exact movements that the instructor is using.  VFI is the perfect 
training tool for pilots of all skill levels. 

 

To access the VFI menu item, click the Training menu followed by the Virtual 
Flight Instruction… menu item.  Alternatively, you may also access the VFI by 
pressing the ‘V’ key on the keyboard.  Determine whether you wish to participate in a 
helicopter or airplane training session.  Open the respective genre by clicking the [+] 
(plus) or double-clicking the listing.  Next, select the pilot you wish to view.  To select 
and begin your training, either double-click the respective maneuver or highlight the 
maneuver and click OK. 
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By default, G4’s radio gadget appears on-screen.  This digital transmitter is a visual 
guide to display the stick inputs, in real-time, utilized for the recordings.  For additional 
information, please refer to the Radio- section on page 247. 
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View Menu 
Adjust your vantage point, change your perspective and more. 

his menu allows you to adjust the various view-related features and functions 
for the simulation.  The View menu adjusts what you are looking at as well as 
where you are looking from. 

 

• Show 

• Camera Type 

• Camera Position 
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• Look at 

• Quick Look 

• Zoom Type 

• Zoom In 

• Zoom Out 

• Zoom Reset 

• Head Tracking 

 

Show 
 
The Show menu item is used to determine whether to show or hide scenery objects in 
the airport. 
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Selecting this item brings forth a pull-down menu with a list of items you can show 
(make visible within the simulation) or hide (remove from visibility).  To show items, 
check them in the drop-down menu.  To hide items, click on them to remove their 
respective checkmark. 

If the frame rate slows dramatically, try eliminating some of the items listed in the 
Show menu title.  This will improve the frame rate. 

To access this menu item, click on the View menu followed by the Show menu item. 

 

Camera Type 
 
The Camera Type menu item determines the Camera Type for the active viewport.  
Each viewport is independently adjustable.  Select from a Fixed Position, Cockpit or a 
Chase view. 

 

If more than one viewport is open, click on the viewport that you wish to modify.  
This becomes the active view in the simulation.  To access the Camera Type 
adjustments, click on the View menu followed by the Camera Type menu item.  
Select your preferred view from the pull-down list. 
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Alternatively, you may press the keyboard’s ‘C’ key to toggle through the available 
Camera Type options. 

Please note:  some airports do not allow Camera Type adjustments. 

Fixed Position- 
In this mode, the camera remains in a fixed, stationary position.  The position is 
determined by the Camera Position setting. 

Cockpit- 
The Cockpit selection places the camera inside the aircraft as if you were a full-scale 
pilot. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you may 
select the Zoom Out option from the View menu. 

Chase- 
The Chase mode positions the camera behind the aircraft.  The camera will follow the 
aircraft as it moves. 

To magnify the view or zoom in on the selected item, press the [+] (plus) key on the 
keyboard.  Each time you press the [+] (plus) key or select the Zoom In menu item, 
the zoom level increases incrementally.  Alternatively, you may select the Zoom In 
option from the View menu. 

To decrease the magnification, or zoom away from the selected item, press the [-] 
(minus) key on the keyboard.  Each time you press the [-] (minus) key or select the 
Zoom Out menu item, the zoom level decreases incrementally.  Alternatively, you may 
select the Zoom Out option from the View menu. 

 

Camera Position 
 
This menu item determines where the camera will be situated.  Depending upon the 
airport selected, there may be one or more Pilot Spawn locations to use as camera 
positions. 
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RealFlight G4 automatically picks the default Pilot Spawn for the airport that you have 
loaded. 

To change the setting, click on the viewport to you wish to modify.  This becomes the 
active view in the simulation.  To access the Camera Position adjustments, click on the 
View menu followed by the Camera Position menu item.  Select your preferred view 
from the drop-down list. 

You may also press the keyboard’s ‘X’ key to toggle through the available Camera 
Position options.  If the airport has two pilot spawn locations, for example, pressing 
the ‘X’ key will toggle back and forth between these two locations. 

 

Look At 
 
This menu item changes what the camera looks at.  Usually you will want the camera to 
remain focused on your aircraft. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the list of things to look at, click on the View menu followed by 
the Look At menu item.  Then select an item to look at.  For example, if you are in a 
multiplayer or MultiMode session, the other players in the session will be listed in the 
popup menu.  Select a player to look at his/her aircraft. 

 

Quick Look 
 
This feature allows you to quickly glance at an object.  When you activate this option, 
the camera briefly looks at the selected item and then returns to the previous vantage 
point for the active viewport. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Quick Look menu item, click on the View menu followed 
by the Quick Look menu item.   

Using the InterLink Elite controller, you can also active the Quick 
Look options with the QuickSelect buttons.  By pressing up on the 
Data Lever, RealFlight will briefly change the camera to look at the 
Wind Sock.  Pressing down will briefly bring the Ground into view. 

 

Alternatively, after you have activated the correct viewport, you can press a key on your 
keyboard to activate the Quick Look feature.  The up arrow will look at the windsock, 
and the down arrow will look at the ground. 

 

Zoom Type 
 
The Zoom Type menu item allows you to change the type of zoom used in the 
simulation. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Type menu item, click on the View menu followed 
by the Zoom Type menu item.  Select the Zoom Type option that accomplishes your 
goal.  You may choose between Manual, Autozoom, and Keep Ground in View. 

Alternatively, after you have activated the correct viewport, press the keyboard’s ‘Z’ 
key.  Each time you press the ‘Z’ key you will toggle to the next Zoom Type. 

Autozoom- 
This zoom type adjusts the zoom range based on the distance of the aircraft from the 
pilot.  The camera automatically zooms in as the aircraft gets further from the pilot and 
then automatically zooms out as the aircraft gets closer to the pilot. 

Keep Ground in View- 
This zoom type adjusts the camera so that the aircraft and the ground are always in 
view.  This is the only zoom type that disallows zooming in and out. 

Manual- 
This enables the standard view with zoom capabilities.  See the Zoom In and Zoom Out 
sections below for more information. 
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Zoom In 
 
Once you have selected the type of zoom that you desire, RealFlight allows you to 
customize it further by zooming in. 

 

Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom In menu item, click on the View menu followed by 
the Zoom In menu item. 

Alternatively, after you have activated the correct viewport, press the [+] (plus) key on 
your keyboard.  Each time you press the [+] (plus) key you will zoom in 
incrementally. 

 

Zoom Out 
 
Once you have selected the type of zoom that you want you can customize it further 
by zooming out.  Zooming Out decreases the magnification. 



 

 240 

 

Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Out menu item, click on the View menu followed by 
the Zoom Out menu item. 

After you have activated the correct viewport, you may also press the [-] (minus) key 
on your keyboard.  Each time you press the [-] (minus) key you will zoom out 
incrementally. 

 

Zoom Reset 
 
This selection resets the zoom magnification level to its default value.  This is useful if 
you are zoomed way in or way out and want to return quickly to the default level of 
magnification. 
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Click on the viewport that you wish to modify.  This becomes the active view in the 
simulation.  To access the Zoom Reset menu item, click on the View menu followed 
by the Zoom Reset menu item. 

Once you have activated the correct viewport, you may also press the Backspace key 
on your keyboard to reset the zoom level. 

 

Head Tracking 
 
RealFlight G4 is compatible with TrackIR from NaturalPoint.  With a TrackIR plugged 
into your computer, you can control the camera with the movement of your head as if 
you are at the field looking around. 
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For example, if you are flying at a high altitude and wish to line up with the runway, at 
a flying field you would look down briefly.  With the TrackIR, you would do the same 
at your computer.  With a small movement of your head, you can look down at the 
runway and back up to your aircraft. 

For more information about TrackIR, and where to purchase one, visit NaturalPoint’s 
website at: 

http://www.naturalpoint.com/trackir/
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Window Menu 
Tools to add more excitement to your RealFlight enjoyment. 

he Window menu allows you to manage the existing windows or viewports, to 
create new ones, and to select from recently used Windows.  The Window 
menu also gives you access to a variety of on-screen gadgets that offer real-
time information about your current flight. 

 

The Window menu offers the following options: 

• Show Title Bar 

Chapter 
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• Gadgets 

• Arrange 

• Close All 

• Window list 

 

Show Title Bar 
 
This menu item determines whether or not the G4 title bar is displayed on the screen.  
By default, the title bar is enabled. 

 

To access this menu item, click on the Window menu followed by the Show Title 
Bar.  This will remove the RealFlight Generation 4 title bar from the screen.  Please 
note:  removing the title bar also eliminates the ability to minimize or maximize the 
screen. 
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Gadgets 
 
A Gadget is an on-screen display that provides you with information pertaining to a 
certain item in your simulation.  To access the Gadgets menu item, click the Window 
menu followed by the Gadgets menu item.  This will open the list of gadgets for the 
simulation. 

 

Selecting this menu item will bring up the Gadgets list as follows: 

• NavGuides 

• Radio 

• Binocular 

• Viewport 

• Variometer 

• Console 



 

 246 

• Chat 

• Edit NavGuides 

• Radio Mode (gadget only) 

 
NavGuides- 
A NavGuide is an on-screen display that allows you to view some basic information 
pertaining to your aircraft.  If you wish to alter the contents of the NavGuide, please 
refer to the Edit NavGuides… section later in this chapter. 

 

To access the NavGuides, click the Window menu title, followed by the Gadgets 
menu item.  Next, click the NavGuides menu item.  You may also bring up the 
NavGuides by pressing the keyboard’s ‘1’ key. 

You may also load the NavGuides using the InterLink Elite with 
the QuickSelect buttons.  Press the Menu/Select button.  Then 
press down twice on the Data Lever until the NavGuides tab is 
highlighted.  It looks like an aircraft gauge. Press the Menu/Select 
button again to activate the NavGuides.  Repeat these steps to 
remove the NavGuides from the screen. 

When the NavGuides are active, an overlay screen will appear on your display.  This 
screen displays the NavGuides information to you. 

If you do not wish to view this information, double-click on the title bar of the display 
box.  This hides the information.  To view it once again, simply double-click the title 
bar. 

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen, entirely. 

Items included by default in the NavGuides are the following: 

Altitude (ASL)- 
This option displays the altitude for the respective aircraft above sea level.  
Even though the aircraft may be taxiing on the runway, the altitude may reflect 
hundreds or thousands of feet, if applicable. 
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Heading- 
This option displays the heading of the aircraft.  The heading is displayed in 
degrees, as they would appear on a compass.  “0” degrees is North, “90” 
degrees is East, “180” degrees is South and “270” degrees is West. 

Airspeed- 
This option displays the airspeed for the aircraft. 

RPM- 
This option indicates the current revolutions per minute, or RPM’s, for the 
engine. 

Graphics Frames/Sec- 
This is an abbreviated version of Frames per Second, or FPS.  While the data 
displayed is not relevant to your aircraft, it is used to provide you with 
feedback on how your computer is performing at any given time.  The higher 
the frames per second, the smoother the simulation will appear. 

Wind- 
This option displays the current wind speed at the flying site. 

Radio- 
The on-screen radio display is useful for many facets of flight.  For example, when 
used in conjunction with Virtual Flight Instruction, this allows you to see real-time 
control input from the professionals.  Observing the link between controller 
movements and aircraft performance will advance your knowledge and understanding 
of a maneuver. 

 

To access the Radio, click the Window menu title, followed by the Gadgets menu 
item.  Next, click the Radio menu item. 
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You may also bring up the Radio by pressing the keyboard’s ‘2’ key. 

You may also load the Radio using the InterLink Elite with the 
QuickSelect buttons.  Press the Menu/Select button.  Then press 
down three times on the Data Lever until the Radio tab is 
highlighted. Press the Menu/Select button again to activate the 
on-screen Radio.  Repeat these steps to remove the Radio from the 
screen. 

If you click the on-screen radio, the entire viewport is displayed, including the title bar.   

To resize the viewport, position the cursor over the lower right corner of the 
viewport’s frame.  Using the mouse, drag the frame according to your wishes.  If you 
drag it downward, the vertical size of the viewport will increase.  Dragging the frame to 
the right or left increases or decreases the width of the viewport respectively. 

Clicking on the ‘X’ in the title tab of the frame removes it from the screen. 

Binocular- 
The Binocular option will show a perfectly zoomed aircraft, as if you were looking 
through a pair of binoculars.  The background of the viewport box becomes 
transparent.  This provides a visual indicator alerting you that you are using “binocular 
vision.” 
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The Binocular option is a great way to see the control surfaces on an aircraft that is too 
far away to see in the Main View.  Although not realistic, it does help to see the control 
input. 

To access the Binocular menu item, click the Window menu title, followed by the 
Gadgets menu item.  Next, click Binocular. 

You may also bring up the Binocular option by pressing the keyboard’s ‘3’ key. 

You may also load the Binocular viewport using the InterLink Elite 
with the QuickSelect buttons.  Press the Menu/Select button.  
Then press down four times on the Data Lever until the Binocular 
tab is highlighted. Press the Menu/Select button again to activate 
the Binocular viewport.  Repeat these steps to remove the Binocular 
viewport from the screen. 

Clicking the Binocular viewport will display the title bar and frame.  To resize the 
viewport, position the cursor over the arrow indication found in the lower right corner 
of the viewport’s frame.  Click and hold on the arrow.  Using the mouse, drag the 
frame according to your wishes.  If you drag it downward, the vertical size of the 
viewport will increase.  Dragging the frame to the right or left increases or decreases 
the width of the viewport, as appropriate. 

Clicking on the ‘X’ in the title tab of the frame removes the frame from the screen. 

Viewport- 
The Viewport menu item allows you to open up a smaller window to you can adjust 
independently from the main simulator screen.  This works much like a picture-in-
picture features found on many TVs.   
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Once you create a new viewport, you can resize or reposition it by dragging with your 
mouse.  You can also fully adjust all the viewport’s properties (zoom level, vantage 
point options, etc.), independent of any properties of the main window. 

To access the Viewport menu item, click on the Window menu followed by the 
Gadgets menu item.  Then select Viewport.  

You may also bring up the Viewport by pressing the keyboard’s ‘4’ key. 

You may also load the Viewport using the InterLink Elite with the 
QuickSelect buttons.  Press the Menu/Select button.  Then press 
down five times on the Data Lever until the Viewport tab, 
pictured with a video camera, is highlighted. Press the 
Menu/Select button again to activate the Viewport.  Repeat these 
steps to remove the Viewport from the screen. 

To change the vantage point options and features, use the commands found in the 
View menu.  Ensure that the viewport you wish to modify is the active viewport, or the 
modifications will not take effect. 

Clicking on the ‘X’ in the viewport’s title tab removes it from the screen. 
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Variometer- 
A variometer is an instrument designed to indicate the rate of climb or descent of an 
aircraft.  The variometer is useful to pilots flying powered aircraft so they can ascertain 
that level flight is maintained.  This is useful during turning maneuvers.  Glider pilots 
typically make the most use of a variometer, to help determine the areas of rising or 
sinking air currents. 

 

To access the Variometer, click the Window menu title, followed by the Gadgets 
menu item.  Next, click the Variometer menu item. 

You may also bring up the Variometer by pressing the keyboard’s ‘5’ key. 

You may also load the Variometer using the InterLink Elite with the 
QuickSelect buttons.  Press the Menu/Select button.  Then press 
down six times on the Data Lever until the Variometer tab, 
pictured with a sailplane, is highlighted. Press the Menu/Select 
button again to activate the Viewport.  Repeat these steps to remove 
the Variometer from the screen. 

The variometer available in RealFlight also offers an audio indicator, much like the real 
instrument.  As the rate of climb increases, the pitch in the audio tone will increase, as 
well.  The opposite holds true, as the descent of the aircraft increases, the pitch in the 
audio tone decreases accordingly. 

If you wish to turn off the audio ques, click the button with the speaker symbol in the 
lower right corner on the variometer.  To turn the audio back on, click the button once 
again. 

The variometer in RealFlight G4 is split into two parts.  The left side of the variometer 
includes a status meter which indicates whether the aircraft is ascending, descending or 
maintaining level flight.  If the bar is in the green, the aircraft is rising.  If it is in the red, 

 



 

 252 

then the aircraft is descending.  If it remains stationary in the middle, the aircraft is 
maintaining its altitude.  The farther the bar moves from the center, the faster the 
change in altitude. On the right, there are three readouts that offer the following. 

• Rate – This indicates the rate of change in altitude. 

• ASL – This shows the altitude above sea level. 

• AGL – This indicates the altitude above ground level. 

Clicking the Variometer viewport will display the title bar and frame.  Clicking on the 
‘X’ in the title tab of the frame removes the frame from the screen. 

Console- 
The Console, and its related commands, will generally be used only by RealFlight’s 
power users or those with advanced knowledge of gaming systems, etc.  As such, we 
will simply scratch the surface of the Console in this manual.  For additional 
information and assistance, we encourage users to visit the RealFlight forums at:: 

http://www.knifeedge.com/forums/ 

To access the Console, press the ‘~’ key.  A complete list of commands is available by 
typing ‘help’ in the command line and pressing Enter. 

Chat- 
Chatting offers the ability to communicate with other RealFlight players during a 
multiplayer session.  Select this menu item to bring up the chat field at the bottom of 
the simulator screen.  To send a message, type your message in the field and press 
Enter on the keyboard. 

Alternatively, press the Enter key first to bring up the Chat field at the bottom of the 
screen.  Next, using the keyboard, type the message you wish to send.  Press the Enter 
key again on the keyboard to send the message. 

Please note:  all messages are viewable by all participants.  RealFlight G4 does not offer 
private chat. 

Any messages received from other participants will appear at the bottom of the screen. 

Edit NavGuides…- 
This menu item allows you to modify the data displayed in the NavGuides box. 

To access the Edit NavGuides feature, click the View menu title, followed by the 
Gadgets menu item.  Next, click the Edit NavGuides… menu item. 
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Modifying the NavGuides- 
To add any of the options from the left column to the NavGuides display, 
click in the box next to the respective item. 

The pane below the list of the Edit NavGuides dialog box contains a 
description of the respective item. 

The Reset To Basic button returns all NavGuides to their default values and 
options.  If you wish to choose all items in the NavGuides list, click the Select 
All button.  All NavGuides items will then be shown in the on-screen display.  
To remove all items from the list, click the Select None button. 

The NavGuides available are listed in the following table: 

Option Description 

Aircraft: Altitude (AGL) Check this item to display the current altitude of the 
aircraft above ground level. 
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Aircraft: Altitude (ASL) Check this item to display the current altitude of the 
aircraft above sea level. 

Aircraft: Altitude (ATL) Check this item to display the current altitude of the 
aircraft compared to the terrain below.  This option does 
not account for water. 

Aircraft: Altitude (AWL) Check this item to display the current altitude of the 
aircraft above the body of water at the airport. 

Aircraft: G Force Check this item to display the gravitational load of the 
aircraft is experiencing as felt by the pilot. 

Aircraft: G Force Total Check this item to display the gravitational load of the 
aircraft is experiencing in any direction. 

Aircraft: Ground Speed Check this item to display the current ground speed of 
the aircraft. 

Aircraft: Heading of Aircraft Check this item to display the current heading of the 
aircraft.  This heading is displayed in degrees, as they 
would appear on a compass.  “0” degrees is North, “90” 
degrees is East, “180” degrees is South and “270” 
degrees is West. 

Aircraft: X Position of Aircraft Check this item to display the current X position of the 
aircraft. 

Aircraft: Y Position of Aircraft Check this item to display the current Y position of the 
aircraft. 

Airspeed: Speed of Aircraft Check this item to display the current airspeed of the 
aircraft. 

Engine: Battery Remaining Check this item to display the remaining capacity in the 
battery pack. 

Engine: Current Draw Check this item to display the amount of current that the 
motor is draining from the battery pack. 

Engine: Fuel Remaining Check this item to display the amount of fuel remaining. 

Engine: Motor Efficiency Check this item to display the efficiency of the electric 
motor. 

Engine: Power In Check this item to display the amount of power being 
transferred to the electric motor. 

Engine: Power Out Check this item to display the amount of power being 
generated by the engine. 

Engine: RPM Check this item to display the RPM’s of the engine.  
Note: this measurement does not take into account any 
gear reduction which might be utilized. 

Engine: Voltage Check this item to determine the voltage across the 
electric motor. 

Helicopter: Main Rotor RPM Check this item to display the current main rotor RPM of 
the helicopter. 

Helicopter: Tail Rotor RPM Check this item to display the tail rotor RPM of the 
helicopter. 

Pilot: Distance to Aircraft Check this item to display the current distance from the 
pilot to the aircraft. 

Pilot: Field Of View Check this item to display the field of view angle for the 
main window. 



 

 255 

Pilot: Height (AGL) Check this item to display the height of the pilot above 
the surface below, water or ground. 

Pilot: Height (ASL) Check this item to display the height of the pilot above 
sea level. 

Pilot: Height (ATL) Check this item to display the height of the pilot above 
the terrain, not including any body of water. 

Pilot: Height (AWL) Check this item to display the height of the pilot above 
the body of water at the airport. 

Pilot: Look Direction Check this item to display the compass direction in 
which the pilot is looking. 

Pilot: Zoom Magnification Check this item to display the amount of zoom being 
utilized; 1 is equivalent to normal eyesight. 

System: Graphics Frame Rate Check this item to display the number of times the 
screen updates per second. 

System: Physics Frame Rate Check this item to display the number of times the 
physics system updates per second. 

Wind Direction Check this item to display the direction that the wind is 
blowing. 

Wind Speed Check this item to display the velocity of the wind at the 
current time. 

Wind Updraft Check this item to display the velocity of the wind in the 
upward direction. 

 

Color- 
This setting adjusts the Color for the selected item.  To select an alternate 
Color, click on the color swatch.  This will open the color palette dialog and 
you may choose an alternate color for the item. 

Show only when value is between- 
Click on the box to activate the option for Show only when value is 
between.  If the aircraft parameter falls within the specified range, the selected 
item will appear in the NavGuides.  If the parameter is not within the specified 
range, the item will not be shown. 

To adjust the range, click on the respective value box and input the value via 
your keyboard. 

Change color when value is between- 
Click on the box to activate the option for Change color when value is 
between.  If the aircraft parameter falls within the desired range, the selected 
item will appear in the NavGuides in the alternate color.  If the parameter is 
outside of the specified range, the item will be shown in the primary color. 

To adjust the range, click on the respective value box and input the value via 
your keyboard. 
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Radio Mode (gadget only)- 
This option allows you to change the Mode in which the on-screen radio is displayed.  
For example, if you prefer to fly with the throttle and rudder on the left stick, and 
ailerons and elevator on the right stick, then you fly Mode 2.  Some modelers prefer 
Mode 1.  In this mode, the left stick controls the rudder and elevator; the right stick 
controls the throttle and ailerons. 

 

Whichever mode you fly, you will want the on-screen radio to match.  Select Radio 
Mode (gadget only) to show the list of available radio modes.  Click the mode that is 
appropriate for you. 

 

Arrange 
 
This menu item allows you to organize the on-screen viewports.  This is especially 
helpful when there are multiple windows open that overlap one another. 
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Click on the Window menu followed by the Arrange menu item to activate this 
option. 

 

 

Close All 
 
This menu item closes all open Windows with the exception of the main Window.  It 
offers the user an easy method to clean up the screen without having to close each 
window separately. 
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To access the Close All menu item, click on the Window menu followed by the Close 
All menu item. 

 

Viewport List 
 
As you add more viewports to the screen, note that they appear on a list in the 
Window menu title.  If you wish to change the active view to one of these viewports, 
simply click on the viewport name in the list. 
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To determine the active window, simply search for the yellow outline that surrounds 
the active window.  In the example above, the active window is the Viewport. 

To change the active window, click on, or in, the window that you wish to become 
active.
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Help Menu 
When all else fails, ask for help. 

his menu provides you with miscellaneous assistance and guidance with a 
variety of simulator-related issues. 

To access the Help files, click on the Help menu title. 

 

The menu items available under the Help menu are: 

• Contents… 
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• Keyboard Commands… 

• About… 

• License… 

• Websites 

 

Contents 
 
This menu item accesses RealFlight G4’s manual which you are reading now. 

 

To access the Contents… files, click on the Help menu title. 
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Keyboard Commands 
 
RealFlight allows you to access menu and other commands from your computer’s 
keyboard.  A key that directly invokes a command is called a “quick key” or “hot key”. 

For example, pressing the [+] (plus) key on the keyboard’s number pad incrementally 
zooms your view towards the aircraft.  This is exactly the same result that arises if you 
select Zoom In from G4’s View menu item.  Consequently, we say that the [+] (plus) is 
a hot key for the Zoom In command. 

 

To access the Keyboard Commands, click the Help menu title, followed by the 
Keyboard Commands menu item. 

Alternatively, you may also bring up the Keyboard Commands by pressing the 
keyboard’s ‘H’ key. 

The following overlay will appear: 
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The Keyboard Commands screen contains all of the information pertaining to the hot 
keys.  To view the entire list, drag the scroll bar on the right side of the Keyboard 
Commands screen down.  Alternatively, this list is also contained in the inside rear 
cover of the Installation Guide which accompanied this software. 

If you do not wish to view this information, double-click on the title bar of the display 
box.  This will hide the information.  To view it once again, simply double-click the 
title bar. 

Clicking on the ‘X’ in the title tab of the frame will remove it from the screen. 

 

About 
 
The About… menu item contains miscellaneous information pertaining to your 
software.  The About… menu contains your RealFlight serial number, InterLink Elite 
serial number and the version number of the software that you are currently operating. 
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Also seen in the About screen are the credits and names of the people that have 
worked together to bring you the world’s most realistic R/C simulator, RealFlight 
Generation 4. 

Clicking on the ‘X’ in the title tab of the frame or clicking anywhere on the main 
simulator screen will remove the About window. 

 

License 
 
This menu item contains the End Users License Agreement (EULA) for the RealFlight 
R/C Flight Simulator.  Please read it carefully. 
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Clicking on the ‘X’ in the title tab of the frame will remove it from the screen. 

 

Websites 
 
This menu item contains links to the RealFlight related websites.  The options include: 
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Great Planes- 
Publishers of RealFlight G4.  Visit this site for information pertaining to the many 
other Great Planes products available. 

Knife Edge Software- 
Developers of RealFlight G4.  Visit the Knife Edge forums to share experiences and 
technical support with other RealFlight owners.  The Knife Edge forums also play host 
to a wide variety of free, downloadable aircraft, trim schemes, flying sites and more. 

RealFlight- 
Visit the RealFlight website for more information about the RealFlight family of 
products, search the knowledge base for technical support, or for information on how 
to contact our support staff if you have questions. 
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Basics of Flying 
Understanding the fundamentals of  radio control flying. 

efore taking control of a transmitter, it helps to understand the basics of flight, 
and the functionality of the gimbals, sticks and switches to properly control 
the aircraft.  This chapter reviews the basics of flying an airplane or a 
helicopter to help get you started down the right path. 

 

Airplane Basics 
 
Before you fly the plane, make sure all switches are in their off or low rates, positions.  
The switches may be assigned to different items depending on how you have 
configured your controller and which aircraft you are flying.  If you are using your own 
transmitter to control RealFlight, please consult your transmitter owner’s manual for 
more information. 

The InterLink Elite features digital trim tabs which are more precise and offer trim 
memory within the simulation.  Trim tabs are the small slider controls on the controller 
(two per controller stick).  They “trim” the aircraft so that it flies straight and level.  For 
example, if an airplane has a tendency to veer slightly downward, you may need to add 
a slight “up” nudge to the elevator.  You can do this by sliding the elevator trim, a click 
or two at a time, towards the bottom of the controller. 

Crashing- 
Takeoffs are optional, but landings are mandatory.  For any type of aircraft or flying, 
successfully landing an aircraft is a crucial skill to master. 

The key to a perfect landing is undivided concentration.  Pay close attention to the 
altitude, orientation, and speed of the aircraft as it approaches the runway.  Should you 
happen to crash, use each crash as a learning experience to perfect your approach and 
the landing. 
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RealFlight has several tools to help you stay on top of things during approach and 
landing.  See the “Landings” section below for some ideas. 

Out at the field a crash might result in one or more of the following: 

• Bruise your ego 

• End flying for the day 

• Cost you money 

• Cost you time to rebuild 

• Cause injury to yourself or a bystander 

• Even win you a nice “best crash trophy!” 
 
Of course, when you crash on the simulator, there is really no harm done.  None, that 
is, except the bad habits you may acquire.  We suggest that you take the crashes 
seriously and learn from each one.  By doing so, you will be a better pilot out at the 
field. 

Airplane Flight- 
RealFlight G4 accurately simulates how R/C aircraft really fly.  This allows you to 
practice R/C flight without worrying about expensive crashes.  Additionally, RealFlight 
G4 is ideal for practicing new maneuvers and experimenting with various parameter 
adjustments. 

It is important to remember, however, that a simulator will only help you learn to fly if 
you let it.  Otherwise, it is just a game.  Learning to fly R/C aircraft requires a 
commitment.  One does not just grab the sticks and start dazzling the crowds.  A 
methodical, patient approach will help you get the most out of this simulator. 

This section is not designed to teach you how to fly.  However, it will help you enhance 
your experience with the simulator and obtain the most from your experiences. 

Takeoffs- 
When you are taking off, start with the throttle in low position and slowly 
increase throttle by pushing the throttle stick away from you towards the top 
of the transmitter until you are at about half speed.  Stay in the middle of the 
runway (you can steer the plane using the rudder).  When you have built up 
enough speed, gradually pull back on the elevator stick to climb off the 
runway.  If the plane is tracking well, apply the rest of the power more quickly, 
climb out, and gain altitude. 

Be careful not to veer off the runway.  In a real plane, chances are that you 
would crash (or get stopped on the grass).  Usually this means bent landing 
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gear and a broken prop.  If your plane has retracts, they could even be torn out 
of the wing. 

For the best practice, it’s recommended that you utilized the Takeoff Trainer 
available with RealFlight G4.  For more information, see the Takeoff Trainer 
section on page 202. 

Landings- 
It is very important to land on the runway, rather than veering off, or touching 
down before you reach the runway.  Either of the latter usually produces a 
moderately expensive crash.  If you “cartwheel” (wing tip hits the ground first), 
the wing can break, resulting in lengthy down time while you repair your 
airplane. 

Start by aligning your plane parallel with the runway.  Fly the approach 
normally, using your throttle to control the rate of descent.  Try to land at the 
slowest speed possible.  If your plane has flaps, use them to kill speed (but be 
careful; with flaps down your plane will try to pitch up and climb).  If your 
plane has retractable landing gear, lower them.  As you touch down, remember 
to keep your nose up! 

RealFlight has several tools to help you practice landings.  

• Before you try to land yourself, you may want to get a lesson from a pro.  
To do so, click the Training menu followed by the Virtual Flight 
Instruction… menu item.  Choose Jason Shulman as the instructor.  
From the list of options, select the Landing maneuver. 

• Gain experience through the Landing Trainer.  It offers guidance and 
helps set you up for the perfect landing.  See the Landing Trainer on page 
207 for more information. 

• During your approach, use the NavGuides to keep track of your speed, 
altitude, and distance above ground. 

 

Aerobatics- 
When you practice aerobatics, the three important steps are: 

• Start the plane straight and level, in a controlled situation 

• Perform the maneuver 

• Return to a straight, controlled situation 
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Anyone can give it full throttle, jam the sticks in all directions and watch the 
plane tumble and roll.  However, this is not what you will do out in the field.  
Do this and you will not have control of the airplane! 

The key to properly performing the maneuver is in the setup.  Doing so will 
allow you to cleanly finish and your experience will be more rewarding as well 
as more realistic. 

Concentrate on making the maneuvers “clean and crisp.”  If you are doing a 
roll, try to keep the plane on a straight line as you roll.  If you are doing a loop, 
try to make a perfectly round circle. 

If you want to practice aerobatics using RealFlight G4, try the Virtual Flight 
Instruction feature (accessible via the Training menu).  The Virtual Flight 
Instruction feature provides a series of personal lessons taught by pros. 

Throttle Management- 
Avoid the temptation of giving the plane full throttle and keeping it there for 
hours at a time.  This teaches you bad habits and makes even a good flier look 
like a rookie out at the field. 

Many of the maneuvers require proper throttle management in order to make 
a maneuver look good.  Loops, stalls, torque rolls, touch-and-goes are just a 
few examples.  Try doing various maneuvers at differing speeds.  Try 
performing a slow roll at medium throttle and keeping a perfectly straight line.  
This difficult maneuver will earn you more praise at the field than doing a full 
speed, full stick roll. 

Rudder Management- 
Most airplanes can (more or less) be effectively flown with just the elevator and 
ailerons.  Good pilots will tell you that the proper use of the rudder is just as 
important, however.  Many aerobatic maneuvers require excellent rudder 
usage. 

Rudder control is especially important when landing in a crosswind.  Pilots that 
cannot use the rudder usually land in the tall grass (embarrassing!).  Pilots that 
do use the rudder can land on the numbers almost every time. 

 

Helicopter Basics 
 
A model helicopter is a very complicated machine, which operates on the same 
aerodynamic principles as its full-scale counterpart.  These principles are quite 
complicated to explain and understand.  However, it is not necessary to understand all 
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the underlying aerodynamics in order to successfully fly a model helicopter (or a 
computer simulation). 

The following will help you to better understand the basics of helicopter flight, and the 
relationship between control stick movements and the actions of the machine. Refer to 
these instructions often as you become more proficient. 

Please note:  the inputs below are shown using a Mode 2 transmitter. 

Collective (Left Stick – Vertical Movement)- 
The spinning main rotor blades, which act like rotating wings, lift the helicopter into 
the air.  Changing the pitch (angle of attack) and speed of the blades, using the 
“collective” and throttle causes the helicopter to rise and descend vertically.  Adjusting 
“collective” increases and decreases the blade pitch.  The “throttle” control increases 
and decreases engine RPM.  On a model helicopter, the collective and throttle controls 
are mixed electronically, and controlled by the throttle stick on the transmitter or 
controller. 

 



 

 274 

 
 

Rudder (Left Stick – Horizontal Movement)- 
To turn the nose of the helicopter left or right, change the tail rotor pitch (by using the 
“rudder” control).  Changes in collective stick movement will require changes in the 
amount of rudder input to maintain the desired heading. 
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Cyclic Stick (Right Stick)- 
The cyclic stick replaces the “aileron” and “elevator” controls found on a fixed-wing 
aircraft.  “Cyclic” is the term given to the control of the main rotor that allows the 
helicopter to fly forward, backward, left and right.  Forward cyclic stick movement 
causes the helicopter to pitch forward, left cyclic causes the helicopter to tilt sideways 
to the left, on so on.  You move the helicopter forward or sideways using a coordinated 
movement of both the cyclic and collective control sticks.  Moving the cyclic stick to 
the right, while simultaneously increasing collective, will cause the helicopter to move 
sideways to the right.  “Rudder” control is used to maintain the heading. 
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Idle-Up- 
A switch on the controller actuates a special function, known as “idle-up.”   Idle-up 
offers an alternate throttle and pitch curve, different from the curves used for hovering.  
Idle-up is usually used for aerobatics, when the pilot wants engine power added when 
pitch is subtracted.  For example, inverted hovering requires positive throttle and 
negative pitch.  As such, pulling the collective stick back provides positive throttle 
AND increased pitch simultaneously. 

Throttle Hold- 
Another special function is known as the “throttle hold”.  When activated, this switch 
sets your throttle to idle but allows the collective to function normally.  This allows you 
to practice autorotations without shutting the engine off. 

Gyro- 
Any sudden change to the torque of the main rotor, such as a quick change in RPM or 
a wind gust, can cause the helicopter to turn unintentionally to an unwanted direction. 
An electronic device known as a gyroscope (gyro) is used to “monitor” and correct for 
this by giving commands to the rudder control to help stabilize the machine. 

Gyros come in a variety of types, each with different features.  A normal gyro will not 
return the helicopter to its former heading; it will simply dampen the unwanted sudden 
movement.  We recommend you start by using the heading hold gyro instead; it will 
maintain course and keep the nose of the helicopter pointed in the desired direction 
regardless of outside forces. 
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Helicopter Flight 
 
Hovering- 
The machine hovers by adjusting the collective/throttle control to maintain altitude, 
the rudder to maintain heading, and minute adjustments to the cyclic controls to 
maintain location.  Hovering is the most important aspect of helicopter flight to 
master, since every other movement of the machine begins and ends with a hover. 

Forward Flight- 
The helicopter moves forward by changing cyclic (moving the cyclic control forward).  
This causes the rotor head, and thus the helicopter to tilt forward, resulting in a 
forward thrust. As the cyclic increases, the collective must also be increased to maintain 
the desired flight path.  As forward speed increases, the collective can be reduced 
slightly. 

Backward Flight- 
Backward flight is accomplished by moving the cyclic control aft, which causes the 
rotor head, and thus the helicopter to tilt backward.  As the cyclic is moved aft, the 
collective must also be increased to maintain desired flight path.  As backward speed 
increases, the collective can be reduced slightly. 

Sideways Flight- 
Moving the cyclic control left will cause the rotor head, and thus the helicopter to tilt 
left.  Add collective and left rudder to cause the helicopter to “slide” sideways to the 
left.  As speed increases, it will require progressively more rudder to maintain heading. 

To move right, simply follow the same procedure, but reverse the cyclic and rudder 
movements (move cyclic right, apply right rudder). 

Turning- 
From forward flight- 
Moving the cyclic control left, while applying a small amount of aft cyclic and 
feeding in left “rudder”, will cause the helicopter to make a coordinated turn to 
the left.  Right movement of the cyclic and rudder sticks will cause the heli to 
turn to the right. 

From a hover- 
Use the rudder to rotate the nose of the helicopter in the direction you want. 

Learning to fly a model helicopter is more difficult and challenging than any 
other genre of radio control modeling, but is also the most rewarding as you 
master the techniques required for sustained hover and forward flight.  
Computer simulation of model helicopter flight is an excellent tool for learning 
the basics and dramatically reducing the learning curve when you move on to 
the actual model itself. 
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RealFlight G4 Launcher 
The RealFlight G4 Launcher is the gateway to simulator fun! 

his item allows you to run the simulation, register and update the software, and 
much, much more. 

To run RealFlight or to access the additional options, click the RealFlight G4 
Launcher located on your desktop. 
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Run RealFlight 
 
To start running RealFlight, press the RealFlight G4 Launcher located on your 
desktop.  Next, click the Run RealFlight button.  The simulation will begin loading 
the terrain, airport objects, textures, etc.  Your simulation experience will begin as soon 
as the loading process completes. 

 

Additional Options 
 
Click on the Additional Options button to access a variety of useful information 
pertaining to RealFlight G4. 
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Restore Defaults- 
Use this button to restore RealFlight G4’s default settings.  Doing so will NOT remove 
custom aircraft, flying sites, etc.  Rather, it is designed to simply restore the factory 
default values and settings for the simulation. 

Registration/Updates- 
Use this button to register and update the software. 
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Online Registration- 
This button allows you to register your copy of RealFlight G4.  The 
registration information entitles you to complimentary technical support and 
free online updates. 

Please enter in all of the required information to complete the registration.  If 
you forget your password, contact Great Planes Support.  To do so, email 
them at rfsupport@greatplanes.com or telephone them at 217-398-8970 
(option #1).  They will confirm your identity, and reset your password. 

Hardware Information- 
RealFlight G4 offers the option of automatically sending us 
information pertaining to your system hardware and settings when you 
register.  If you leave the Send Hardware Information box checked 
when you register, RealFlight G4 will send us this information. 
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This hardware information will assist us in diagnosing any problems 
you may encounter later, should you need to contact Technical 
Support Consequently, we suggest that you leave this box checked 
when registering. 

This feature is optional.  If you uncheck the box, RealFlight G4 will 
not send us any information about your system.  Alternatively, you can 
view exactly what information RealFlight will send us before you 
decide.  To view the information, click the Technical Support 
button.  When the Technical Support page appears, click Assemble 
System Information. 

Update to Latest Version- 
After registering (you only need to register once), you may update to the latest 
version of the software.  This will download all necessary files and correctly 
install the upgrade. 

Click this button to Update to Latest Version.  

Please note:  your PC must be connected to the Internet in order to check for 
updates. 

Check for Updates Before Starting RealFlight- 
If you check this box, every time you run the RealFlight G4 software it will 
check to determine whether or not there is a more recent version of RealFlight 
G4 available to you.  If a new version exists, RealFlight G4 will ask if you wish 
to download and install the newer build. 

Please note:  your PC must be connected to the Internet in order to check for 
updates. 

Update to Specific Version- 
If you are experiencing difficulties with a version you have installed, this will 
allow you to retrieve a previous version of the software.  If the previous 
version fixes your problem, please contact our technical support team at 
rfsupport@greatplanes.com and let them know about the difficulty 
encountered. 

Clear Download Cache- 
Occasionally, files may become corrupt during a download.  If you are having 
difficulties with the online updates, remove all cached files using this option.  
Next, choose Update to Specific Version and then select the Completely 
Refresh option. 
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Uninstalling RealFlight- 
Click the Uninstall RealFlight button to uninstall the software.  The following dialog 
will appear: 

 

We suggest that you use this method, not the “Add/Remove Programs” feature in 
Windows, to uninstall RealFlight G4.  The RealFlight G4 launcher will remove all 
necessary RealFlight G4 files. 

Uninstall Program- 
Choose this option to uninstall only the RealFlight G4 program itself. 

Uninstall Data Files- 
Choose this option to uninstall any user files such as customized airports, 
customized aircraft, color schemes, songs etc.  Be careful with this option!  You 
could lose a lot of your work by inadvertently uninstalling these files. 

Remove Serial Numbers- 
Choose this option to remove the serial numbers from your system.  You have 
two options available if you check this box. 

• For this product only 

• For all RealFlight products, including Expansion Packs, older RealFlight 
editions, and Add-Ons 

 
Remove All Cached Files From The Online Update- 
Choose this to option to remove all cached download files from your system.  
If you uninstall these files, future downloads may take a little longer. 
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View Web Site- 
Click the View Web Site to visit the RealFlight web site.  A browser window will open 
for you and you will be automatically directed to the site.  

Please note:  your PC must be connected to the internet in order to view the RealFlight 
web site. 

Read Help File 
Press the Read Help File button to bring up the manual, this document that you are 
reading now, file for RealFlight G4. 

Technical Support- 
Press the Technical Support button to bring up technical support information 
pertaining to your system.  If you encounter any difficulties with RealFlight, this 
information can help you to resolve the situation on your own, or may assist Great 
Planes’ Support Staff to diagnose the problem. 

 

System Information 
This displays a list of the critical system information.  Before you email 
technical support, or report a bug with the software, please be sure to cut and 
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paste this information into your email.  This will greatly assist them in 
diagnosing the difficulty. 

Reinstall DirectX 
Choose this option to reinstall DirectX.  Occasionally this will fix corrupted 
installations. 

Enter Technical Support Code 
Choose this option to enter a technical support code.  If you do encounter 
problems running RealFlight, our Technical Support team may supply you 
with a code to input here.  Entering this code will help them diagnose or 
resolve your difficulty. 

 

Email Technical Support 
This gives you the email address rfsupport@greatplanes.com to which you can 
email your difficulties.  If you do email us, please be sure to attach the 
Assemble System Information output to your email. 

You will receive an auto-reply message back confirming that Great Planes 
Support Staff received your email.  If you do not receive the auto-reply 
message, please double-check that you sent your email to the correct email 
address. 

Assemble System Information 
Choose this option to collect critical information about your system, and about 
your RealFlight settings.  You may find this information useful if you try to 
troubleshoot problems on your own.  Moreover, if needed you can cut and 
paste this information into an email to Great Planes Support Staff.   
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View Web Technical Support- 
Choosing this option will open a browser window, and take you to a web site 
that contains the most up-to-date technical support information for RealFlight 
G4. 

View Tasks- 
This shows you a list of all tasks that are running on your computer.  Some 
tasks can interfere with RealFlight G4 and may need to be closed. 

Include Serial Numbers- 
Check this box if you plan to assemble all system information to send to Great 
Planes Support Staff.  If you are sending this information to anyone else, don’t 
check this box.  The serial numbers are unique to you, and should only be 
shared with Great Planes Support Staff. 
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DX Diagnostics- 
This brings up Microsoft’s DXDIAG utility.  Using this utility can further help 
diagnose your system. 

Important:  if you send us information about your system to help us diagnose a 
problem, please do not use DXDIAG to generate that information.  Instead, 
please use the “Assemble System Information”.  The “Assemble System 
Information” output file contains more information than the DXDIAG 
output. 

MSInfo- 
This option will run MSInfo.  This will give you even more information about 
your system.  This program is not always installed on a particular computer, 
but normally comes with programs such as Microsoft Office®. 

Display Properties- 
This brings up the display properties for your monitor.  You can use this page 
to change the resolution of your desktop. 

Explorer- 
This button launches Windows Explorer.  This Microsoft Windows utility can 
help you locate, move and back up your files. 

Launch Device Manager- 
This button launches the Device Manager.  This Microsoft Windows utility 
will help you determine driver dates, as well as installing and updating video 
and sound card drivers. 
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If You Experience 
Difficulties 
Tips and tricks for solving the more common problems. 

he RealFlight G4 simulator is on the cutting edge of technology, and therefore 
operates using advanced hardware.  Consequently, there is always the remote 
possibility you may experience a few slight difficulties.  Should the need arise, 
we provide extensive resources to help. 

Besides providing the best R/C simulator, we sincerely feel that we provide the best, 
most extensive product support for any R/C simulator.  Since cards, drivers, and 
operating systems are always changing, we work hard to keep our support team up-to-
date on the latest information available to ensure that you have the most enjoyable 
experience possible. 

This section begins with a summary of the various sources of RealFlight G4 
information including support and problem solving assistance.  Then, we will show 
you some simple but powerful steps that can resolve or prevent most RealFlight G4 
difficulties.  Finally, if these steps fail to solve your difficulty, we will explain the most 
effective ways to acquire additional assistance. 

 

How to Get Help and Information 
 
As a RealFlight G4 user, you have access to an incredible amount of information about 
this product.  Much of this information can help you resolve difficulties, or correctly 
access and use program features.  Here is where you can find it: 

• The manual.  Most common RealFlight difficulties can be resolved by following 
the instructions in later sections of this chapter.  However, there is also additional 
information throughout other chapters that may be of assistance. 
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• Visit our product Knowledge Base at http://www.gpsoftware.com.  This is a great 
resource and is an indexed, searchable collection of articles that describe solutions 
to almost every known situation with RealFlight, RealRace, and all of our other 
software products.  In fact, this is the same information database used by our 
product support technicians.  

• Visit the Knife Edge Software Message Boards at 
http://www.knifeedge.com/forums/.  This is a place where owners of RealFlight, 
RealRace, and other Knife Edge products post questions, comments and 
responses.  Sometimes our product support technicians and product developers 
from Knife Edge post replies and announcements as well.  You may find a thread 
that discusses the same difficulties that you are experiencing.  

• Contact our Technical Support department by email at: 
rfsupport@greatplanes.com.  Alternatively, our staff is also available via telephone 
or postal mail at: 

 
RealFlight Technical Support 
3002 North Apollo Drive 
Suite #1 
Champaign, IL 61822 
Voice phone: (217) 398-8970(Option 1) 
FAX: (217) 398-7721 

The product support teams are specially trained, and have many resources to help 
you resolve problems with RealFlight G4. 
 

 

Before You Do Anything Else 
 
If you are experiencing difficulties with RealFlight G4, you should always try the steps 
below first.  These steps really do cure most problems our users experience.  Even if 
you are not having a problem, these same steps often assist in the operation of both 
RealFlight and your computer. 

Here are the steps you should take (instructions for each step follow): 

• Update your video and sound card drivers (see instructions below). 

• Update to the latest version of RealFlight G4. 

• If the problem persists, run the DirectX test programs. 

• If these steps do not work, proceed to the next section. 
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Update Your Drivers- 
Before you do anything else, you should make sure you have updated your video and 
sound drivers.  A large number of difficulties encountered by RealFlight users can be 
cured by updating drivers. 

A driver is a software program that controls your video or sound card.  Each card 
manufacturer provides drivers for its own cards.  To work correctly, RealFlight relies 
on your video and sound card drivers. 

It is very important to use the latest available driver for your card.  Card manufacturers 
frequently release updated drivers to fix problems that occur when the driver is used 
with programs such as RealFlight G4.  The driver that came with your new computer, 
on your Windows CD-ROM, or on a CD-ROM included with the new card you 
bought, may not be the latest version. 

If you do not know how to update drivers, you can find instructions in our Knowledge 
Base article Q01-1038, How to Update Drivers, at http://www.gpsoftware.com/kb/q01-
1038.htm.  This page will take you through the process step-by-step, and has links to 
driver download sites for most manufacturers. 

Update to the Latest Version of RealFlight G4- 
As we regularly release program updates, the difficulty that you are seeing may already 
be fixed in an update.  Even if you just bought RealFlight, you should update to the 
latest version.  It’s free and only requires a few minutes of your time. 

Run the DirectX Test Programs- 
If you have updated your drivers and RealFlight to the latest versions, and your 
problem persists, you should try to run the DirectX samples that come with RealFlight. 

The DirectX samples (DirectDraw, Direct3D, Sound, etc.) are test programs written by 
Microsoft.  These samples ship with DirectX, and are designed to check whether your 
DirectX installation, video/sound cards and drivers, etc., are working correctly.  They 
should work on any DirectX 9 compliant driver. 

These samples are found in the Technical Support area of the software.  Click the 
Technical Support button followed by the DX Diagnostics button.  Next, click either 
the Sound or the Music tabs, then the Test DirectX Music/Sound buttons.  Once 
these tests have been completed, press the Display tab to access the Test DirectDraw 
and TestDirect3D buttons. 

The most important tests are DirectDraw and Direct3D, both of which test your video 
card and driver.  If you are having any graphics difficulty in RealFlight G4 (including 
RealFlight G4 “freezing” your system so that you have to reboot), look for the same 
problem in these tests.  If the problem occurs only after you have run RealFlight G4 
for a long time, make sure to run the tests for a comparable length of time. 
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If your RealFlight G4 problem also occurs in Billboard, the problem lies with your 
video driver, not RealFlight G4.  To resolve the problem, try finding updated drivers 
for your card (see above).  If the problem still occurs with the latest drivers, you will 
need to report this problem to the card manufacturer.  Be sure to tell them that you 
tested the card by using Billboard.  Please note:  in rare cases, a newer video driver may 
have more problems than a previous version.  After exhausting all other options, you 
might try obtaining an older driver from the manufacturer to eliminate this possible 
cause as well. 

 

If You Need Additional Assistance 
 
If you have updated drivers and updated RealFlight G4, your system successfully runs 
the DirectX sample programs, and you are still having problems.  What next? 

As a first step, we suggest checking our Knowledge Base at 
http://www.gpsoftware.com.  This is an easy to use, searchable, browsable database of 
known problems and solutions for RealFlight, RealRace, and our other software 
products.  This is the same database that our Product Support technicians use when 
helping customers.  We constantly update the knowledge base to address new 
problems as we discover them.  In many cases, you will be able to find an article that 
gives clear, concise instructions for resolving your difficulty. 

You may also want to check the Knife Edge Message Boards at 
http://www.knifeedge.com/forums/.  This is a place where owners of RealFlight, 
RealRace, and other Knife Edge products post questions, comments and responses 
about problems.  You may find a discussion thread about the problem you are 
experiencing. 

You can also contact Technical Support at Great Planes via email at: 
rfsupport@greatplanes.com. 

IMPORTANT.  If you do contact Technical Support, you can help us enormously by 
providing detailed information about your computer system.  Since your problem may 
only occur on a particular video or sound card, particular driver version, etc., we may 
need this information to help us diagnose your problem.  To compile your system 
information, use the RealFlight G4 Launcher.  Click the Additional Options 
button.  Next, click the Technical Support button, followed by the Assemble 
System Information button.  This will create a file called “c:\launcheroutput.txt”, 
which contains your system information.  Attach this file to an email and send it to us 
at rfsupport@greatplanes.com. 
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Examples of Common Problems and Solutions 
 
If You Don’t See Your Problem in This Chapter- 
This chapter contains a few examples of common difficulties and concerns that 
RealFlight users have experienced. 

Remember that we can never provide a complete list of difficulties and solutions in a 
program manual.  That’s because RealFlight--and the computers, cards and drivers it 
uses--are constantly evolving.  As such, we maintain a detailed Knowledge Base at 
http://www.gpsoftware.com.  By keeping our Knowledge Base online, we can provide 
you with the latest information about resolving any difficulties that might arise.  If you 
don’t see your difficulty described in this chapter, please check the Knowledge Base. 

In this chapter, we’ve simply tried to pick a very short list of the most asked about 
issues. 

My computer “freezes” when I run RealFlight- 
Sometimes, you may also notice sound skipping or repeating, or a computer reboot 
while flying.  To resolve this type of problem, you must update the drivers for your 
video and sound cards.  This is very important.  Card manufacturers regularly update 
their drivers to fix this type of problem.  Even the driver that came with your new 
computer may not be the most recent. 

Sometimes a card manufacturer will offer a choice between a “recommended” driver, 
and another driver (variously called “special purpose”, “alternate”, or “beta” driver).  If 
RealFlight G4 “freezes” with the “recommended” driver, try using the alternate driver 
instead. 

If you are sure that you are using the latest drivers, and have followed all the other 
steps in the previous section (update RealFlight G4, test DirectX) and are still having 
difficulty with your computer locking up while running RealFlight, please contact Great 
Planes Technical Support. 

Improving RealFlight G4 Performance- 
During installation, RealFlight G4 analyzes your computer’s hardware specifications.  
RealFlight G4 then tries to optimize its configuration to best take advantage of that 
hardware, and achieve the best possible performance. 

However, if the performance is less than you desire, you can adjust some of RealFlight 
G4’s settings to improve the simulation speed and frame rate: 

• Ensure that the drivers for the video and sound cards are up-to-date. 

• Turn off all other programs, especially virus checkers and network applications 
(such as Instant Messengers) while running RealFlight G4.  Use CTRL-ALT-
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DELETE and check the Task Manager to verify that nothing else is running in 
the background. 

• Reduce the texture and water quality.  This can have a profound effect on cards 
that do not have a high texture memory.  See the Settings section starting on page 
76 for more information. 

• Eliminate the items shown in the simulation.  To do so, access the View menu 
title, then access the Show menu item.  Click an item type to remove it from the 
simulation.  It may be necessary to eliminate several items before performance 
meets your expectations. 

• Reduce the number of open Gadgets and Viewports.  Click the ‘X’ on each Gadget 
or Viewport that you wish to close. 

• Reduce the number of recordings currently in use. 
 
Other Common Problems- 
Here are some other things you may want watch for. 

• Check the CD-ROM for scratches or blemishes.  Even minor scratches or 
fingerprints can cause random problems that appear to be program bugs. 

• Make sure your hard drive has at least 500 MB of space available.  To check this: 
1. Double click on the My Computer icon on your desktop 
2. Right click on your main hard drive (usually drive “C:\”) 
3. When the popup menu appears, select Properties 
4. In the dialog that appears, view the amount of space available on the drive 
 
If you need additional space, try emptying the Recycle Bin. 

• Verify that all other programs are closed prior to starting RealFlight G4.  RealFlight 
works best when it is the only program running. 

• If all else fails, try rebooting your computer.  Occasionally, Windows (particularly 
98 and ME) may become unstable after prolonged and continuous use.  A simple 
reboot may clear up any difficulties.
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Glossary 
 

180-Degree Turn 
R/C Term 

This basic flight practice starts with a takeoff, and 
then demonstrates 180 degree turns on a flight path 
parallel to the runway. 

360-Degree Turn 
R/C Term 

In this practice, you will learn to fly the aircraft in a 
complete circle (360-degree turn).  This maneuver is 
a great way to learn control inputs for turns while 
keeping the same radius and altitude. 

3D Acceleration 
Computer Term 

3D operations require a huge number of 
calculations.  Modern computers offload many of 
these calculations to the video card, rather than 
performing the calculations directly on your 
computer's CPU.  This speeds up the simulation 
and allows for faster frame rates, thereby increasing 
the realism of the simulation. 

ATV 
R/C Term 

Amount of servo travel. For instance, 50% ATV 
would mean the servo's maximum travel is 50% of 
its physical limit. 

AccuModel 
RealFlight Term 

RealFlight G4’s AccuModel aircraft editor offers the 
most powerful, most flexible aircraft editor ever 
released in an R/C simulator. 

Active View 
RealFlight Term 

The active view is the view that is affected by the 
commands in the View menu.  Only one view at a 
time is active.  You can make a view active by 
clicking on it with the mouse.  When you want to 
control a view’s properties, you must first make it 
the active view. 

Advanced Flight Recorder 
(AFR) 
RealFlight Term 

This feature allows the pilot to not only view 
prerecorded maneuvers, but also allows them to 
record their own.  During the playback of 
maneuvers, the pilot has the ability to select from a 
number of different options such as fast forwarding, 
rewinding, looping, speeding up and slowing down 
the recordings.  These recordings may also be sent 
to others via the Internet.  The pilot can also 
activate an on-screen transmitter to watch the stick 
inputs for each pre-recorded maneuver. 
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Adverse Yaw 
R/C Term 

The tendency of an airplane to yaw in the opposite 
direction of the roll. For instance, when right aileron 
is applied, the airplane yaws to the left, thus 
opposing the turn. Adverse yaw is common in 
trainer type airplanes having flat bottom wings. It is 
most noticeable at slow speeds and high angles of 
attack, such as during takeoffs and when stretching 
a landing approach. Caused by the unequal drag of 
the upward and downward deflection of the 
ailerons, this undesirable trait can be minimized by 
setting up the ailerons with Differential Throw or 
by coordinating the turns, using the aileron and 
rudder controls simultaneously. 

Aileron 
R/C Term 

Hinged control surfaces located on the trailing edge 
of the wing, one on each side, used to provide 
control of the airplane about the roll axis.  The 
control direction is often confusing to first time 
modelers.  For a right roll or turn, the right hand 
aileron moves upward and the left hand aileron 
moves downward.  The movements are reversed 
for a left roll or turn. 

Airfoil 
R/C Term 

A surface (such as a wing or propeller blade) with a 
shape and orientation such that it provides or 
controls stability, direction, lift, or propulsion. 

Airframe 
RealFlight Term 

A term used to describe the general components of 
an aircraft when using RealFlight G4’s AccuModel 
aircraft editor.  For example, selecting the airframe 
will call up the fuselage, wing(s) and tail of an 
airplane. 

Angle of Attack 
R/C Term 

The angle that the wing penetrates the air. As the 
angle of attack increases so does lift and drag, up to 
a point. 

Arm 
R/C Term 

In this context, the arm is the distance from the 
point of the application of a force to the axis of 
rotation.  If you press down on the tip of a wing, for 
example, the arm is the distance from the point 
where you are pressing to the root of the wing. 

Auto-Play 
Computer Term 

A Windows feature that automatically detects when 
a CD-ROM is inserted and runs the specified 
program on the CD-ROM. 
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Autorotation 
R/C Term 

A maneuver in which the pilot attempts to bring the 
helicopter in for a landing without power from the 
engine.  The momentum of the spinning rotor 
blades is enough to slow the helicopter prior to 
landing. 

Autorotation Event 
RealFlight Term 

An event where players attempt to autorotate onto a 
target (similar to Spot Landing).  Each player takes a 
turn.  Players collect different point amounts based 
on landing location.  The Autorotation Event works 
for helicopters only.  The Deadstick Event is for 
airplanes. 

Avalanche 
R/C Term 

The Avalanche is a loop with a snap roll at the top 
of the loop.  This snap roll must be centered at the 
top of the loop. 

Bloom Effect 
RealFlight Term 

The effect creates a feathering of light around 
brighter objects, giving it a more realistic look.  This 
is more noticeable at brightly lit airports around 
aircraft that are lighter in color. 

Channel Mapping 
RealFlight Term 

This term describes the ability of RealFlight G4 to 
alter the mapping or input of the servos to 
accurately reflect the actual controls from an R/C 
controller. 

Chat 
RealFlight Term 

This is a real-time communication between two G4 
users which is conducted via the PC.  G4’s 
multiplayer feature enables a public chat if so 
desired. 

Child/Children Item(s) 
RealFlight Term 

In many of RealFlight G4’s selection windows, 
items are displayed in a hierarchy format.  An item 
that belongs to a higher group, or parent, is 
considered the child item.  

Chord 
R/C Term 

The chord of a wing or surface is the width of the 
surface.  A wider chord offers increased lift.  
However, a wider chord also generates more drag 
when the aircraft rolls. 

CG 
R/C Term 

CG is the abbreviation for the phrase Center Of 
Gravity.  This is the point at which the aircraft 
balances fore to aft and side-to-side.  The location 
of this point is crucial to how the aircraft reacts in 
the air.  For airplanes, a tail-heavy plane will be very 
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snappy, but generally unstable and susceptible to 
frequent stalls.  Conversely, a nose-heavy plane will 
tend to track better and be less sensitive to control 
inputs, but will generally drop its nose when the 
throttle is reduced to idle.  This makes the plane 
more difficult to land, since it takes more effort to 
hold the nose up.  A nose heavy airplane will have 
to come in faster to land safely. 

Collective 
R/C Term 

A mechanism on a helicopter that changes the pitch 
of the main blades, thereby allowing the helicopter 
to ascend or descend accordingly. This is the 
control that adjusts the pitch of the rotor blades. 

Collision Detection 
RealFlight Term 

RealFlight G4 sports the most advanced collision 
detection modeling ever used in an R/C model 
simulation.  It blankets the entire aircraft, ensuring 
accurate modeling of the aircraft when it collides 
with objects and items within the simulation. 

Coning 
R/C Term 

When a helicopter hovers, the blades form a slight 
"cone" when viewed from the side. The Coning 
effect is caused by the balance between lift and 
centrifugal forces on the blades. 

Control Surface 
R/C Term 

Generally defined as the portion of the airfoil that 
moves.  Examples include ailerons, elevators, 
rudders, flaps, and spoilers. 

Controller 
RealFlight Term 

A device used to control an aircraft in RealFlight.  
G4 ships with the Great Planes’ USB InterLink 
Elite Controller by Futaba.  This device can be used 
as a standalone controller, or as an interface to use 
your own R/C transmitter.  Previous versions of 
RealFlight shipped with either a Futaba game port 
controller or a Transmitter Adapter Interface.  For 
information on the latter two controllers, please see 
the manuals that came on the program CD with 
those versions of RealFlight. 

Cuban Eight 
R/C Term 

This maneuver requires that the pilot perform a half 
roll on each of the descending forty-five degree 
down lines, allowing the pilot to fly a horizontal 
figure eight without performing an outside loop. 

Cyclic 
R/C Term 

Refers to the changing of a main rotor blade's pitch 
as the rotor head rotates. Pitch is added while the 
blade is pointing in one direction (e.g. while the 
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blade is over the canopy), and removed while the 
blade is pointing the opposite direction (e.g. while 
the blade is over the tail boom). This causes the 
helicopter to pitch and roll. 

Data Lever 
RealFlight Term 

RealFlight G4’s InterLink Elite has the ability to 
make on-screen selections, or quickly look at the 
windsock or ground.  This can be done with the 
Data Lever, located at the bottom right-hand corner 
of the InterLink Elite controller. 

Deadstick 
R/C Term 

A term used to describe unpowered flight (glide) 
when the engine ceases operation. 

Deadstick Landing Event 
RealFlight Term 

See Autorotation Event.  The Deadstick Landing 
Event is specific to airplanes. 

Dihedral 
R/C Term 

The V-shaped bend in a wing.  Increasing the 
dihedral usually enhances the aerodynamic stability 
of an airplane, and causes the rudder to control 
both the roll and yaw axis.  This is why some 
trainers and sailplanes require only three channels of 
radio control (i.e., they have no ailerons). 

Direct Control Interface 
RealFlight Term 

This is a method for using your own radio to 
completely control the aircraft.  This usually means 
you have a separate radio program on your radio for 
each aircraft that you want to fly in RealFlight G4 
with this method.  All mixing and radio functions 
are performed on your radio and RealFlight simply 
passes the values directly to the aircraft servos.  This 
is in contrast to the Joystick Emulation Interface. 

Direct3D Technology 
Computer Term 

A Microsoft DirectX technology used to render the 
3D image when you have a graphics accelerator 
card.  It works best on faster computers. 

DirectX 
Computer Term 

A technology created by Microsoft that controls 
graphics and sound operations. 

Dithering 
R/C Term 

A method of removing and/or simulating colors 
that may not be available to the graphics processing 
unit. 

Down Thrust 
R/C Term 

This is the downward angle of the engine in 
relationship to the centerline of the airplane.  Down 
Thrust helps overcome the normal climbing 
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tendency of flat bottom wings. 

Driver 
Computer Term 

A software program that controls a card (e.g., video 
or sound card) in your computer.  Card 
manufacturers usually provide drivers as well.  Card 
manufacturers frequently update their drivers to fix 
bugs or to make their cards compatible with new 
software and hardware.  You can often find an 
updated driver for your video or sound card by 
visiting the card manufacturers web site and 
following links to “Drivers,” “Support,” 
“Downloads”, or “Upgrades.” 

Edit NavGuides 
RealFlight Term 

A NavGuide is a gadget that displays continuously 
updated information about your aircraft.  The Edit 
NavGuides dialog is used to customize the 
NavGuides gadgets. 

Elevator (Maneuver) 
R/C Term 

The Elevator is a maneuver in which the aircraft is 
made to stall completely with a large amount of 
elevator throw.  The aircraft will descend almost 
vertically much like an elevator. To perform the 
Elevator, make sure that you have sufficient altitude, 
dive the aircraft vertically towards the ground and 
pull full up on the elevator stick. 

Elevator (Control Surface) 
R/C Term 

Hinged control surface located at the trailing edge 
of the horizontal stabilizer, which provides control 
of the airplane about the pitch axis and causes the 
airplane to climb or dive.  The correct direction of 
control is to pull the transmitter Elevator control 
stick back, toward the bottom of the transmitter, to 
move the Elevator upward, which causes the 
airplane to climb.  Move the Elevator in the other 
direction to dive. 

Endpoint Adjustment 
R/C Term 

This radio feature adjusts the length of servo travel 
in one direction (a single channel will have 
adjustments for two endpoints). If, for example, 
your aircraft rolls faster one way than the other, 
endpoint adjustments can correct the problem. 

Event 
RealFlight Term 

An organized flying contest with a set of rules.  
RealFlight G4 currently supports five types of 
Events:  Limbo, Spot Landing, Pylon Racing, 
Autorotation/Deadstick and Freestyle.  You can 
participate in Events by yourself or with other 
RealFlight users over the internet.  Use the Event 
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menu to start an Event. 

Exponential 
R/C Term 

A feature commonly found on computer radios that 
desensitizes the servo when the sticks are close to 
the neutral position.  The further the stick position 
from center, the faster the control response. 

Figure 8 
R/C Term 

This is an excellent maneuver to learn perspective 
and orientation of the aircraft from all angles.  Use 
the ailerons and elevator to turn the aircraft left and 
right.  Use the elevator to ensure that the aircraft 
maintains a constant altitude, forming an ‘8’ in the 
sky. 

Flap 
R/C Term 

For Airplanes:  hinged control surface located at the 
trailing edge of the wing inboard of the ailerons.  
The Flaps are lowered to produce more 
aerodynamic lift from the wing, allowing a slower 
takeoff and landing speed.  Flaps are often found on 
scale models, but usually not on basic trainers. 

For Helicopters:  Flapping is an up-and-down 
motion of the main rotor blade's tip.  With a "dual-
damped" head, (as used in the Kyosho Concept 
helicopters, for example) both blades are able to 
Flap independently.  With "solid axle" heads (as 
used in the Hirobo Shuttle helicopters, among 
others), moving one blade up causes the other to 
move down. 

Flapping Head 
R/C Term 

This describes a type of rotor head in which the two 
blades are not connected directly. Each blade is 
independent of the other, usually resulting in a 
helicopter with smoother performance. 

Flare 
R/C Term 

The point during the landing approach in which the 
pilot increases the amount of up elevator to smooth 
the touchdown of the airplane. 

FlexiField 
RealFlight Term 

FlexiField is the most advanced flying site editor 
ever unveiled.  It presents the modeler with the 
ability to adjust the flying site in virtually any 
manner desired.  The user can add trees, selecting 
the type, size and color; add, move, size and orient 
buildings, walls and other scenery objects; position 
and orient the runway; even choose the amount and 
type of lighting at the flying site. 
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Flight Failures 
RealFlight Term 

RealFlight G4 authentically recreates common 
difficulties that may be experienced at your local 
flying site.  Practicing with flight failures enabled is a 
good way to practice for emergencies. 

Flight Playback Gadget 
RealFlight Term 

A gadget that lets you control playback of flight 
recordings using mouse actions. 

Float Fly 
R/C Term 

The ability to takeoff and land a radio controlled 
aircraft from water. 

Flybar Paddles 
R/C Term 

These are the short blades on the end of the flybar. 
Available in a variety of weights and airfoils, these 
paddles assist the main blades in producing lift, etc. 

Four-Point Roll 
R/C Term 

These maneuvers are very similar to a slow roll with 
the exception of a hesitation at either ¼ of the roll 
or at 1/8 of the roll.  It is important to remember to 
use rudder and elevator to keep the aircraft flying in 
a straight line. 

Frame Rate 
Computer Term 

Frame Rate is the number of times per second that 
RealFlight creates a different picture to display on 
your monitor.  Frame rate is determined by the 
speed of your CPU and graphics card, and how 
many RealFlight options you turn on.  This is not 
the same as refresh rate, which is the number of 
times per second that your monitor retraces an 
image on its screen. 

Freestyle Event 
RealFlight Term 

An event where players decide on the rules.  
RealFlight G4 sees that each player gets a turn; it is 
the players’ responsibility to judge the competition.  
Use this event when you have devised a group 
activity that requires every player to take a turn. 

Fuselage 
R/C Term 

Generally speaking, this is the main part of the 
airplane that holds the wings and engine.  The 
fuselage is often thought of as the “body” of the 
airplane.  This term is also used to refer to a “body” 
that might be used on helicopters. 

Futaba 
R/C Term 

Maker of high quality R/C products, including the 
USB InterLink Elite controller shipped with 
RealFlight G4. 

Gadget 
RealFlight Term 

An on-screen display that shows you continuously 
updated information about your aircraft, or lets you 
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control RealFlight features using mouse clicks. 

Global Wind 
RealFlight Term 

This term describes the overall wind conditions in 
the simulation. 

Governor 
R/C Term 

A device used to help maintain a constant RPM 
(head speed).  Generally used in helicopters rather 
than airplanes. 

Grouping 
RealFlight Term 

A collection of scenery objects or foliage objects in 
your airport.  Every object in the airfield must 
belong to one Group.  You can place all of your 
airport's scenery objects in a single Group, or create 
multiple Groups to place objects in categories with 
related objects.  For example, you could have a 
Group for Trees and another group for Buildings 
within a particular airport. 

Gyro 
R/C Term 

A device, most commonly used in helicopters, that 
aids in controlling the yawing action of the 
helicopter by automatically adjusting the deflection 
of the tail rotor blades. 

HAL Device 
Computer Term 

A hardware-accelerated 3D video card driver.  
“HAL” is an abbreviation for the phrase “Hardware 
Abstraction Layer” that uses software drivers to 
communicate between RealFlight’s software and the 
hardware of the PC. 

Harrier 
Computer Term 

A Harrier is a slow forward progression of the 
aircraft with the nose held high.  Use the elevator to 
stall the forward progress of the aircraft.  Add in 
more up elevator until the nose approaches 45 
degrees.  The throttle should be used to control the 
forward progress of the aircraft, without climbing. 

Host 
RealFlight Term 

In RealFlight G4, every multiplayer session requires 
one player to serve as Host.  The Host starts the 
session, and then the other players join.  Other 
players can leave the session whenever they want, 
but only the Host can terminate the entire session.  
The Host must start any multiplayer event (Limbo, 
Spot Landing, Pylon Racing, Autorotation, 
Freestyle). 
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Hot Pluggable/Hot 
Swappable 
Computer Term 

A device is said to be Hot Pluggable or Hot 
Swappable when you can safely connect or 
disconnect it without turning off your computer or 
rebooting. 

Hub 
R/C Term 

The centralized mechanical device used to attach 
the main rotor blades and paddles. 

Humpty-Bump 
R/C Term 

This aerobatic maneuver consists of two vertical 
lines connected by a half circle flown across the top. 

IP Address 
Computer Term 

Whenever your computer is connected to the 
internet, it has an IP address.  This number is a 
string of digits and periods, and looks something 
like “123.45.6.78”.  The IP address is like an internet 
“zip code” that tells other computers where to look 
for your computer.  Depending on your internet 
connection, your IP address may always be the 
same, or may change each time you connect to the 
internet.  For other RealFlight G4 users to join your 
Multiplayer session, they must obtain your IP 
address.  You can either provide it to them directly, 
or post it through the RealFlight list server. 

Immelman Turn 
R/C Term 

The aircraft will enter a half loop from straight and 
level flight followed immediately by a half roll to 
straight and level flight. 

Interface Mode 
RealFlight Term 

With RealFlight G4 set to Interface Mode, you are 
using the InterLink Elite Controller as an interface 
to your own R/C radio.  In Interface Mode, your 
own radio controls RealFlight G4.  Conversely, in 
Joystick Mode the InterLink Elite Controller (used 
as a mockup of a R/C transmitter) controls the 
RealFlight G4 aircraft. 

InterLink Elite Controller 
RealFlight Term 

Great Planes’ USB InterLink Elite Controller by 
Futaba is a USB device shipped with RealFlight G4.  
The InterLink Elite Controller can be used as a 
standalone “mockup” R/C controller, as an 
interface for using your own R/C transmitter to 
control RealFlight, or both simultaneously! 

Joystick 
Computer Term 

A device that connects to your computer to provide 
control input for the simulated aircraft.  The 
InterLink Elite controller that comes with 
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RealFlight G4 is considered a Joystick. 

Joystick Emulation Interface 
RealFlight Term 

A term used to describe using your own radio to 
emulate the Interlink Joystick.  This allows you to 
use your own radio to fly any of the stock aircraft in 
RealFlight G4.  Actual radio functions such as 
mixing and ATVs are performed in the RealFlight 
software, not on your radio.  This is in contrast to 
the Direct Control Interface. 

Joystick Mode 
RealFlight Term 

With RealFlight G4 set to this mode, RealFlight G4 
is controlled by the InterLink Elite controller used 
as a mockup of a R/C transmitter. 

Launcher 
RealFlight Term 

The RealFlight G4 Launcher is useful for many 
aspects of the G4 program, including loading the 
simulator, compiling system information for 
technical support, or uninstalling RealFlight. 

LAN 
Computer Term 

Local Area Network. This is usually a network 
where the computers are connected with high speed 
network cards. 

Lead Lag 
R/C Term 

A helicopter term describing the hinge point where 
the blade attaches to the hub. This allows the blade 
to move forward and backward at certain times 
during the blades rotation. 

Leading Edge 
R/C Term 

The very front edge of the wing or stabilizer. This is 
the edge that hits the air first. 

Limbo 
R/C Term 

An event (flying competition) in which pilots take 
turns flying their aircraft under a Limbo bar.  The 
pilot that clears the lowest bar height wins. 

List Server 
RealFlight Term 

RealFlight G4’s Multiplayer function lets you 
publicly “post” your session, so that any RealFlight 
G4 user, anywhere in the world, can find out about 
your session and join you (assuming you have not 
reached the enrollment limit of your session).  The 
place where you post your session is called a List 
Server.  Use of the List Server is optional.  You can 
preserve privacy by not posting your session, and 
privately communicating your IP address to your 
selected multiplayer partners. 

Please note that the free, public list server for use by 
RealFlight owners may be modified or discontinued 
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without notice at any time. 

Low Rates 
R/C Term 

A switch on the radio that reduces the servo 
movement to much smaller extremes, thus making 
the model respond more slowly to a given control 
input. 

Mode 
R/C Term 

Also known as Flight Mode or Stick Mode, this 
refers to the transmitter's gimbal stick assignments 
(locations) which determine the flight mode of your 
controller. There are two main modes of control, 
Mode 1- mostly used in Europe and Mode 2 which 
is the predominant method of controlling aircraft 
commonly used in the United States. 

Most Recently Used (MRU) 
Computer Term 

MRU refers to the list of documents which were 
last accessed.  For RealFlight G4, MRU’s appear for 
airports, aircraft and recordings. 

MultiMode 
RealFlight Term 

A G4 feature that allows two users to fly 
simultaneously on the same PC. 

Multiplayer 
Computer Term 

A RealFlight G4 feature that uses Microsoft's 
DirectX technology to connect with other 
RealFlight G4 users over a network. 

Multiplayer Session 
RealFlight Term 

A network connection between RealFlight G4 users 
that allows each user to fly in the same "virtual 
world," and allows all participants to see and interact 
with each other's aircraft. 

NavGuides 
RealFlight Term 

A gadget that displays continuously updated 
information about your aircraft and the virtual 
world. 

Parent Item 
RealFlight Term 

In many of RealFlight G4’s selection windows, 
items are displayed in a hierarchy format.  An item 
that has additional item within it is considered the 
parent item. 

PhotoField 
RealFlight Term 

A technology that creates a flying field by using a 
panoramic photograph as a background for a flat 
terrain. 

Pirouette 
R/C Term 

The yawing action of a helicopter that looks much 
like an ice skater spinning in a circle.  One Pirouette 
is equal to one 360-degree rotation. 
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Pitch Axis 
R/C Term 

The airplane axis is controlled by the elevator.  Pitch 
is illustrated by holding the airplane at each wingtip.  
Raising or lowering the nose is the pitch movement.  
This is how the climb or dive is controlled. 

Plumb String 
R/C Term 

When you measure your aircraft for RealFlight, 
some measurements require that you have a 
reference line running straight up and down.  To 
make such a line, we tie a weight to the free end of a 
string, and let the weight dangle.  Because the string 
is then “plumb” (oriented straight up and down), it 
is called a Plumb String.  A Plumb String is 
particularly useful in measuring an aircraft’s center 
of gravity. 

Point Rolls 
R/C Term 

These maneuvers are very similar to a roll with the 
exception of a hesitation at either 1/4 or 1/8 of the 
roll. 

Private Session 
RealFlight Term 

A multiplayer session that is not published on our 
list server.  For a private session, the host must 
distribute his/her IP address to each participant, 
who must manually enter this information to join. 

Propeller 
R/C Term 

Props are generally designated by two numbers (for 
instance, “10 – 6”).  The first number is the length 
(10" in the example) of the prop.  The second 
number is the pitch or angle of the blades.  In this 
example, the “6” represents the distance the 
propeller will move forward in one revolution. 

Public Session 
RealFlight Term 

A multiplayer session that is published on a list 
server. 

Pylon Racing 
R/C Term 

An event (flying competition) in which pilots take 
turns flying their aircraft around a closed course.  
Pylons mark the course perimeter.  The pilot that 
finishes the course first wins. 

QuickSelect 
RealFlight Term 

RealFlight G4 InterLink Elite allows you to make 
changes to the simulator with the controller using 
the buttons at the bottom.  Manipulating these 
buttons through the on-screen QuickSelect tabs 
offer the ability to change aircraft, flying sites, and 
more. 
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RAM 
Computer Term 

Random Access Memory. 

ReadySelect 
RealFlight Term 

This is the name given to RealFlight G4’s rotating 
preview box.  This allows a rapid view of the aircraft 
from all angles. 

RealPhysics 3D 
RealFlight Term 

This is RealFlight’s exclusive physics modeling 
technology.  RealPhysics 3D authentically replicates 
the actual physics of model aircraft by performing 
hundreds of thousands of floating point calculations 
each second while delivering sizzling real time 
performance. 

Refresh Rate 
Computer Term 

The number of times per second that your monitor 
retraces an image on its screen.  This is different 
from the Frame Rate. 

Resolution 
Computer Term 

When used in the context of screen Resolution, this 
term describes the picture quality of the screen.  
Lower Resolutions will produce an image that is not 
as sharp as higher Resolutions. 

Roll Axis 
R/C Term 

The airplane axis controlled by the ailerons.  Roll is 
illustrated by holding the airplane by the nose and 
tail.  Dropping either wingtip is the roll movement.  
Roll is used to bank or turn the airplane.  In most 
airplanes, the ailerons control roll.  However, when 
the main wing has dihedral, the plane can be banked 
using the rudder only.  Consequently, many planes 
with wing dihedral do not have ailerons, and the 
rudder controls both roll and yaw.  This is one 
reason why most trainer aircraft have a large 
amount of dihedral -- a plane with large dihedral can 
be controlled using fewer input channels. 

Rolloff Factor 
RealFlight Term 

This phrase describes how rapidly the volume of a 
sound increases or decreases as the source draws 
closer or moves farther away. 

Root 
RealFlight Term 

In many of RealFlight G4’s selection windows, 
items are displayed in a hierarchy format.  The 
upper most item in this hierarchy is considered the 
Root item. 

Rudder 
R/C Term 

Hinged control surface located at the trailing edge 
of the vertical stabilizer, which provides control of 
the airplane about the Yaw axis (causing the airplane 
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to Yaw left or right).  Left Rudder movement 
causes the airplane to Yaw left, and right Rudder 
movement causes it to Yaw right. 

Servo 
R/C Term 

An electromechanical device that moves the control 
surfaces or throttle of an airplane according to 
commands from a receiver.  This device does the 
physical work of moving parts around inside the 
aircraft. 

Session 
RealFlight Term 

See "Multiplayer Session." 

Software Radio 
RealFlight Term 

This term describes RealFlight G4’s ability to 
accurately mimic a computer transmitter (complete 
with mixing, etc.) in the simulation. 

Sound Card 
Computer Term 

A card inside your computer that controls audio 
(what you hear over your computer speakers).  
Most sound cards plug into your computer’s 
motherboard.  You can upgrade your sound card 
(or the software driver that controls it) without 
getting a new computer. 

Specular Highlights 
Computer Term 

A graphics rendering technique that makes surfaces 
(e.g., MonoKote™) appear reflective, or “shiny”, in 
direct light (e.g., sunlight). 

Split S 
R/C Term 

The Split S is another step in learning to combine 
loops and rolls and is a great maneuver to decrease 
your altitude.  A half roll precedes a half loop, 
making the maneuver a mirror image of the 
Immelman.  The Split S provides course reversal 
and an easy increase in speed. 

Spot Landing 
R/C Term 

An event (flying competition) in which pilots take 
turns trying to touch their aircraft down within a 
small marked landing area.  Each pilot receives a 
score based on touch down location.  The pilot with 
the highest score wins the event. 

Stall 
R/C Term 

When an airplane’s angle of attack is too great to 
generate lift (regardless of airspeed), the plane will 
dive and rapidly lose altitude.  This is known as a 
stall.  Every airfoil has an angle of attack at which it 
generates maximum lift.  The airfoil will stall beyond 
this angle. 



 

 310 

Swash Plate 
R/C Term 

The mechanism in a helicopter rotor that turns non-
rotating control movements into rotating control 
movements. 

Thermal System 
R/C Term 

This phrase describes the wind flow and effects for 
the thermals in RealFlight G4. 

Throttle Hold 
R/C Term 

This is used to keep the throttle at a set position, yet 
allows input to the collective of the helicopter. 
Generally this function is used to practice 
autorotation. 

Tip Stall 
R/C Term 

This is when the airplane reaches its stall speed and 
one wing drops. 

Torque Roll 
R/C Term 

The Torque Roll occurs when the nose of the 
airplane is pointed vertically and the airplane hovers 
in place.  The aircraft will rotate left around its roll 
axis. 

Touch and Go 
R/C Term 

Landing and taking off without a pause. Often 
confused with a good bounce. 

Trailing Edge 
R/C Term 

The rearmost edge of the wing or stabilizer. 

Trainer 
R/C Term 

A model designed to be inherently stable and fly at 
low speeds, to give first-time modelers time to think 
and react as they learn to fly. 

Training Aids 
RealFlight Term 

RealFlight G4 offers a variety of features to learn 
new maneuvers.  These consist of training aids that 
take you through, step-by-step, basic flight lessons, 
such as Takeoffs and Landings for airplanes, and 
Hovering practice for helicopters.  Pre-recorded 
lessons are also available from professional pilots. 

TruFlo Wind Dynamics 
RealFlight Term 

RealFlight G4’s TruFlo Wind Dynamics is the most 
accurate wind model ever released in an R/C 
simulator.  It combines five different wind models 
to recreate the ever-changing wind fields found at a 
real flying site. 

Turbulence System 
RealFlight Term 

This is the ability of RealFlight to induce turbulent, 
rough air, as would be experienced at the flying site. 

USB 
Computer Term 

USB, or Universal Serial Bus, is a connection 
protocol for computer peripheral devices (like Great 
Planes’ USB InterLink Elite Controller by Futaba).  
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USB technology allows you to connect multiple 
devices to your computer, and supports high data 
transfer rates and is hot swappable.  USB devices 
have a special connector that only fits into a USB 
port.  Most modern personal computers have USB 
ports, which are usually clearly labeled.  Some 
computers have one or more USB ports on the 
front of the computer housing, although the USB 
ports are usually on the back of the computer. 

Variometer 
R/C Term 

An instrument designed to indicate the rate of climb 
or descent of an aircraft. 

Video Card 
Computer Term 

A card inside your computer that produces the 
images on your video monitor.  Most modern 3D 
video cards have accelerated 3D operations—that 
is, they perform numerical calculations for rendering 
a 3D scene, to free up your computer’s CPU to 
perform other tasks.  The video card plugs into your 
computer’s motherboard.  You can upgrade your 
video card (or the software driver that controls it) 
without replacing your computer. 

Viewport 
RealFlight Term 

A picture-in-picture display set within the RealFlight 
G4 main display.  The Viewport is independently 
adjustable and serves as its own unique “window on 
the world”. 

Virtual Flight Instruction 
RealFlight Term 

This RealFlight G4 feature lets you choose from a 
variety of prerecorded maneuver training lessons.  
The maneuver is then demonstrated on screen, 
along with the instructor’s voice and control stick 
movements.  You can index, pause and even loop 
the maneuver playback for training purposes. 

VirtualRevolution 
RealFlight Term 

This is the exclusive sound technology used by 
RealFlight G4.  As with the original RealFlight 
programs, the sounds are Doppler-correct.  If the 
user’s sound card supports it, surround sound is 
also available. 

Washout 
R/C Term 

An intentional twist in the wing, which causes the 
wing tips to have a lower angle of attack than the 
wing root.  In other words, the trailing edge is 
higher than the leading edge at the wing tips.  
Washout helps to prevent tip stalls. 
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Waterfall 
R/C Term 

The Waterfall is a maneuver where the plane pivots 
360 degrees in the pitch axis with as little forward 
motion and altitude deviation as possible.  As the 
name suggests, this maneuver resembles a waterfall 
during flight. 

Wing Loading 
R/C Term 

The amount of weight per square foot that has to 
be overcome to provide lift.  It is normally 
expressed in ounces per square foot.  This 
specification can be easily calculated as follows:  first 
determine the area of the wing in square inches.  
Then simply divide by 144 to obtain square feet.  
Divide the total weight (in ounces) of the airplane 
by the wing area (in square feet). 

This information is valuable when deciding on 
which airplane to build next.  Planes with high wing 
loading must fly faster to stay in the air.  These are 
generally "performance" airplanes.  Conversely, a 
plane with lower wing loading does not need as 
much air flowing around the wing to keep it flying.  
Gliders and trainer airplanes fall into this category 
because in this case, slow, efficient flight is highly 
desirable. 

Yaw Axis 
R/C Term 

The airplane axis controlled by the rudder.  Yaw is 
illustrated by hanging the airplane level by a wire 
located at the center of gravity.  Left or right 
movement of the nose is the Yaw movement. 
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License 
REGISTERED VERSION: RealFlight(r) R/C Simulator 

LIMITED USE SOFTWARE LICENSE AGREEMENT 

        This Limited Use Software License Agreement (the "Agreement") is a legal agreement 
between you, the end-user, and Knife  Edge Software ("KES").  By continuing the installation of 
this game program, by loading or running the game, or by placing or copying the game program 
onto your computer hard drive, you are agreeing to be bound by the terms of this Agreement.  If 
you do not agree to the terms of this Agreement, promptly return the game program and the 
accompanying items (including all written materials), along with your receipt to the place from 
where you obtained them for a full refund.  

KES SOFTWARE LICENSE 

        1.      Grant of License.  KES grants to you the limited right to use one (1) copy of the 
enclosed or foregoing game program (the "Software") on a single computer.  You have no 
ownership or proprietary rights in or to the Software or the written materials accompanying the 
Software.  For purposes of this section, "use" means loading the Software into RAM, as well as 
installation on a hard disk or other storage device.  The Software shall be either returned to KES 
or destroyed when no longer used in accordance with this Agreement, or when the right to use 
the Software is terminated.  You agree that the Software will not be shipped, transferred or 
exported into any country in violation of the U.S. Export Administration Act (or any other law 
governing such matters) and that you will not utilize, in any other manner, the Software in 
violation of any applicable law.  

        2.      Commercial Use is Prohibited.  Except as provided in paragraph 5. Herein below in 
regard to the Software, under no circumstances shall you, the end-user, be permitted, allowed or 
authorized to commercially exploit the Software, any data comprising the Software.  Neither you 
nor anyone at your direction shall do any of the following acts (any such acts shall be deemed void 
and a breach of this Agreement) with regard to the Software, or any portion thereof, such as a 
screen display or a screenshot:  

a. Rent the Software; 

b. Sell the Software; 

c. Lease or lend the Software; 

d. Offer the Software on a pay-per-play basis; 

e. Distribute, by electronic means or otherwise, the Software for money or any other 
consideration; or 

f. In any other manner and through any medium whatsoever commercially exploit the Software or 
use the Software for any commercial purpose.  
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        3.      Additional Prohibited Uses.  Neither you nor anyone at your direction shall take the 
following action in regard to the Software, or any portion thereof, such as a screen display or a 
screenshot:  

a. Modify, disassemble, reverse engineer or decompile Software;  

b. Translate the Software; 

c. Reproduce the Software; 

d. Publicly display the Software;  

e. Prepare derivative works based upon the Software except Permitted Derivative Works); or 

f. Distribute, by electronic means or otherwise, the Software.  

        4.     Use of Other Material is Prohibited.  Use, in any manner, of the trademarks, such as 
RealFlight R/C Simulator (tm) logo, or symbols, art work, images, screen displays or screenshots, 
sound effects, music, and other such material contained within, generated by or relating to the 
Software is prohibited. 

        5.      To Receive Permission to Commercially Exploit.  If you desire to commercially exploit 
the Software, you may request a copy of and execute the Commercial Exploitation License 
Agreement for RealFlight R/C  Simulator (the "License") and forward the original License to 
KES Software at the address noted therein.  Please note that KES may refuse your request and 
not sign the License in KES's sole discretion.  

        6.      Restrictions Apply to Third Parties.  The prohibitions and restrictions described herein 
apply to anyone in possession of the Software and/or Permitted Derivative Works.  

        7.      Copyright.  The Software and all copyrights related thereto (including all characters and 
other images generated by the Software or depicted in the Software) is owned by KES and is 
protected by United States copyright laws and international treaty provisions. You must treat the 
Software like any other copyrighted material. You may not otherwise reproduce, copy or disclose 
to others, in whole or in any part, the Software.  You may not copy the written materials 
accompanying the Software.  The same restrictions and prohibitions regarding your use of the 
Software as provided in this Agreement apply to your use of the written materials accompanying 
the Software.  The written materials are owned by KES and are protected by United States 
copyright laws and international treaties.  You agree to use your best efforts to see that any user of 
the Software licensed hereunder complies with this Agreement. 

 

        8.      Limited Warranty.  KES warrants that if properly installed and operated on a computer 
for which it is designed, the Software will perform substantially in accordance with the 
accompanying written materials for a period of ninety (90) days from the date of purchase of the 
Software.  KES's entire liability and your exclusive remedy shall be, at KES's option, either (a) 
return of the price paid or (b) repair or replacement of the Software that does not meet KES's 
Limited Warranty.  To make a warranty claim, return the Software to Hobby Services at 3002 
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North Apollo Drive, Suite #1, Champaign, IL 61822 accompanied by proof of  purchase, your 
name, your address, and a statement of defect, or return the Software with the above information 
to KES.  This Limited Warranty is void if failure of the Software has resulted in whole or in part 
from accident, abuse, misapplication or violation of this Agreement.  Any replacement Software 
will be warranted for the remainder of the original warranty period or thirty (30) days from your 
receipt of the replacement software, whichever is longer.  This warranty allocates risks of product 
failure between Licensee and KES.  KES's product pricing reflects this allocation of risk and the 
limitations of liability contained in this warranty.  

        9.      NO OTHER WARRANTIES.  KES DISCLAIMS ALL OTHER WARRANTIES, 
BOTH EXPRESS IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANYING 
WRITTEN MATERIALS.  THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS.  YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION 
TO JURISDICTION.  KES DOES NOT WARRANT THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED, ERROR FREE OR MEET LICENSEE'S 
SPECIFIC REQUIREMENTS.  THE WARRANTY SET FORTH ABOVE IS IN LIEU OF 
ALL OTHER EXPRESS WARRANTIES WHETHER ORAL OR WRITTEN.  THE 
AGENTS, EMPLOYEES, DISTRIBUTORS, AND DEALERS OF KES ARE NOT 
AUTHORIZED TO MAKE MODIFICATIONS TO THIS WARRANTY, OR 
ADDITIONAL WARRANTIES ON BEHALF OF KES.  ADDITIONAL STATEMENTS 
SUCH AS DEALER ADVERTISING OR PRESENTATIONS, WHETHER ORAL OR 
WRITTEN, DO NOT CONSTITUTE WARRANTIES BY KES AND SHOULD NOT BE 
RELIED UPON. 

        10.     Exclusive Remedies.  You agree that your exclusive remedy against KES, its affiliates, 
contractors, suppliers, and agents for loss or damage caused by any defect or failure in the 
Software regardless of the form of action, whether in contract, tort, including negligence, strict 
liability or otherwise, shall be the return of the purchase price paid or replacement of the 
Software.  This Agreement shall be construed in accordance with and governed by the laws of the 
State of Oregon. Copyright and other proprietary matters will be governed by United States laws 
and international treaties.  IN ANY CASE, KES SHALL NOT BE LIABLE FOR LOSS OF 
DATA, LOSS OF PROFITS, LOST SAVINGS, SPECIAL, INCIDENTAL, 
CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR DAMAGES ARISING FROM 
BREACH OF WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, OR OTHER 
LEGAL THEORY EVEN IF KES OR ITS AGENT HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. 
Some jurisdictions do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitation or exclusion may not apply to you.  

        11.     General Provisions.  Neither this Agreement nor any part or portion hereof shall be 
assigned, sublicensed or otherwise transferred by you.  Should any provision of this Agreement be 
held to be void, invalid, unenforceable or illegal by a court, the validity and enforceability of the 
other provisions shall not be affected thereby.  If any provision is determined to be 
unenforceable, you agree to a modification of such provision to provide for enforcement of the 
provision's intent, to the extent permitted by applicable law.  Failure of a party to enforce any 
provision of this Agreement shall not constitute or be construed as a waiver of such provision or 
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of the right to enforce such provision.  If you fail to comply with any terms of this Agreement, 
YOUR LICENSE IS AUTOMATICALLY TERMINATED.  

        YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT 
YOU UNDERSTAND THIS AGREEMENT, AND UNDERSTAND THAT BY 
CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR 
RUNNING THE SOFTWARE, OR BY PLACING OR COPYING THE SOFTWARE 
ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO BE BOUND BY THIS 
AGREEMENT'S TERMS AND CONDITIONS.  YOU FURTHER AGREE THAT, 
EXCEPT FOR WRITTEN SEPARATE AGREEMENTS BETWEEN KES AND YOU, 
THIS AGREEMENT IS A COMPLETE AND EXCLUSIVE STATEMENT OF THE 
RIGHTS AND LIABILITIES OF THE PARTIES. THIS AGREEMENT SUPERSEDES 
ALL PRIOR ORAL AGREEMENTS, PROPOSALS OR UNDERSTANDINGS, AND ANY 
OTHER COMMUNICATIONS BETWEEN KES AND YOU RELATING TO THE 
SUBJECT MATTER OF THIS AGREEMENT. 
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